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SharePoint Designer is Microsoft’s premier offering for Web designers, information workers, and
business users to be able to interactively design collaborative SharePoint-based Web applications.
It has its roots in FrontPage technologies and is considered the product of choice for users who
want to work specifically on SharePoint Web applications.

This book tries to align its content to the development life cycle of a Web site or application. From
the initial decisions about the server technologies to be used for Web site development to the
actual Web application design and implementation and finally to the Web site maintenance and
housekeeping, all facets of SharePoint Designer are covered in simple and easy-to-follow chapters.

This book strives to introduce readers to most of the server-side aspects of SharePoint Designer.
Because SharePoint Designer relies on a number of server technologies, such as Internet Information
Services (IIS), FrontPage Server Extensions (FPSE), and SharePoint, a substantial portion of this
book is devoted to helping develop understanding on how these technologies work individually and
in relation to SharePoint Designer. Before the book starts to explore the SharePoint Designer func-
tionality, it offers insight into the server products that SharePoint Designer can interact with.
Throughout the book, you find notes and tips about features provided by the server technologies
that SharePoint Designer either relies on or interacts with. Overall, one of the intentions of this book
is to simplify understanding of SharePoint Designer’s interaction with the server technologies to
help troubleshoot common issues with remote authoring and publishing.

After a deep dive into SharePoint Designer’s remote authoring internals, readers are exposed to the
SharePoint Designer tools and features that they can exploit to design Web pages on SharePoint
and non-SharePoint Web sites. Easy-to-follow exercises help you understand the power of
SharePoint Designer in laying out Web pages, using ASP.NET controls and FrontPage Web compo-
nents, and working with data and SharePoint-specific features, such as data forms and workflows.

Finally, the later parts of this book focus on SharePoint Designer’s ability to help administer
SharePoint and non-SharePoint Web applications. I also discuss in detail how to use SharePoint
Designer to export and import sites, publish Web applications, and perform site analysis.

As a personal note to readers, it’s recommended that you go through the exercises in this book by
actively using SharePoint Designer. These exercises are designed to introduce you to the
SharePoint Designer user interface. Also, it’s a good idea to read through the text in SharePoint
Designer dialog boxes. A lot of useful information and hints are written right on them.

Ultimately, I hope you find that this book encourages your Web design capabilities and gives you
confidence to design creative, interactive, and successful Web pages and Web sites.

XIX
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he Internet has long been one of the favorite mechanisms of expres-

sion because of the wide reach, connection, and exposure it offers.

It’s one of the basic means of communication in the 21st century and
has drawn people closer in unique ways. Having a presence on the Internet
is a pivotal requirement for any organization, irrespective of its size, nature,
or range of operations. Web sites on the Internet provide the canvas that
organizations can use to explain their missions and goals, advertise their
products, perform business transactions, and communicate with their cus-
tomers and partners.

It’s apparent that the Internet as a medium offers tremendous prospects and
opportunities. To exploit this medium, Web site designers have a range of
Internet technologies to choose from. From simple markup languages (such
as HTML) to complex application development technologies (such as ASP.
NET), there are a variety of platforms on which you can base your Web site
application. To achieve the most from these technologies without having to
re-create a lot of work, many Web site development tools and products are
available to you. Microsoft’s key offerings for these tools and products have
been FrontPage and Visual Studio. While Visual Studio is targeted to Web
developers and complex Web application development, FrontPage is
designed to provide a simpler no-code-based software development tool that
helps Web site designers focus on designing Web sites rather than have to
deal with the complex code that goes behind Web site development and still
be able to create complex Web sites.

FrontPage offers Web site designers a number of components and What You
See Is What You Get (WYSIWYG) features that help in building important
sections of Web sites. It provides wizard-based interfaces that aid in develop-
ing Web pages without having to write a lot of code behind the Web pages
and creating key Web site features, such as site navigation, data collection
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forms, dynamic effects, and graphics and animation. Along with that, it offers a number of Web
site management features that provide for ease in managing Web sites as well as importing, export-
ing, and publishing content to Web servers.

With the advent of SharePoint technologies, FrontPage has been replaced primarily because of the
need to address the requirements of Web site designers in the SharePoint and non-SharePoint
environments. FrontPage 2003 is the last version of FrontPage, and FrontPage is now available as
two separate products: Expression Web (for non-SharePoint development) and SharePoint
Designer (for SharePoint development). While SharePoint Designer falls into the Microsoft Office
suite (although it’s not part of any Office 2007 suite and is sold separately), Expression Web is part
of the new Expression Studio suite of products, which includes Expression Blend, a program once
called Interactive Designer.

In this chapter, I introduce you to SharePoint Designer and help familiarize you with some basics
for developing Web pages and Web sites using SharePoint Designer. Although I try to keep this
chapter simple, if you run across a term, feature, or component that sounds confusing, don’t be
concerned because 1 cover these elements in more depth throughout this book.

Introducing SharePoint Designer

SharePoint is one of the fastest-growing Microsoft products and offers a platform for developing
enterprise-level Web applications that focus on the sharing and collaboration of content and docu-
ments. In its most basic of definitions, SharePoint provides the infrastructure for creating and
maintaining Web sites that can be used for a variety of Internet-based operations besides sharing
Office or non-Office content and collaboration. You can later customize these Web sites that
SharePoint creates to suit your business needs, format, or branding.

SharePoint Designer is Microsoft’s premier product for Web site designers who are tasked with
customizing and branding SharePoint Web sites. Although SharePoint Designer in its current
release can be used for non-SharePoint Web site development, its full capability is exposed when
you work with SharePoint Web sites. However, before I discuss SharePoint Designer and its fea-
tures, I want to briefly mention its predecessor, FrontPage, and the origins of SharePoint Designer.

Exploring the legacy of FrontPage technologies

Microsoft acquired FrontPage quite a few years ago from a company called Vermeer Technologies
Incorporated (VTI, an acronym you encounter a lot when exploring the internals of SharePoint
Designer later in this chapter). FrontPage’s Web site authoring and management techniques were
really ahead of their time and allowed Web site developers to easily create Web sites on local com-
puters and then push them to Web servers or even work directly on the Web site residing on the
Web server. The underlying authoring techniques of FrontPage were exploited by a lot of other
Microsoft products, such as Visual InterDev, Office, and Visual Studio.
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The concept was simple: The FrontPage program installed on the client computer provided the
client-side component that could be used for creating Web pages and designing Web sites. The Web
server was set up with a server-side component — namely, FrontPage Server Extensions (FPSE) —
that would communicate with the client-side component for providing the basic infrastructure for
three operations:

B Moving content from the client machine to the Web server
B Authoring or modifying content directly on the Web server
B Enabling certain Web components that provide functionality for Web sites
These authoring technologies that FrontPage introduced are still very much alive and used by

SharePoint Designer, Expression Web, and Office 2007 products when working with SharePoint
and non-SharePoint sites.

= For more on these authoring mechanisms and protocols, see Chapter 3.

FrontPage could be used to create Web pages and design Web sites by using a set of Web compo-
nents and features offered with the product. These features included components such as hit coun-
ters, shared borders, link bars based on the navigation structure, and many more. The list of these
components grew with each new version of FrontPage.

On the server side, FPSE provided the basis for the first SharePoint implementation offered with
Office XP/2002. This release of SharePoint was called SharePoint Team Services (STS) and
stemmed from a less-used ASP-based Office 2000 document management feature called Office
Server Extensions (OSE). STS allowed developers to create Web sites by using Web site templates
that were provided with the product. These Web sites provided basic collaboration and document
management features, including document libraries and lists.

FrontPage XP/2002 became the client-side tool for customizing and modifying Web pages inside STS
sites. FrontPage 2002 also provided for the interface that could be used to create new document
libraries and lists (SharePoint content) as well as new SharePoint Web pages and Web sites, publish-
ing STS sites from one Web server to another. All these SharePoint features were enabled in
FrontPage 2002 only when an STS site was open in it and were not available for non-SharePoint sites.

This client-server relationship was thus established as the basis for the next versions of FrontPage
and SharePoint. FrontPage 2003 was offered as the client-side designing tool for working with
Windows SharePoint Services 2.0 (WSS v2). It could be used to develop SharePoint content and
exploit the features offered by WSS v2 sites.

Following this relationship, SharePoint Designer was introduced as the designing tool for the current
version of SharePoint, WSS v3, and Microsoft Office SharePoint Server (MOSS). Although SharePoint
Designer is backward-compatible to a certain extent with the previous versions of SharePoint, its
complete set of features are exposed only when using it with WSS v3 and MOSS sites.
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Comparing SharePoint Designer with FrontPage 2003

As discussed earlier, SharePoint Designer is the designing tool for the current release of SharePoint.
SharePoint Designer inherits many of its features from FrontPage 2003. Besides these features and
enhancements, SharePoint Designer makes available a set of new technologies and features, such as
workflows, page layouts, etc., that SharePoint v3 exposes.

While I highlight key improvements in SharePoint Designer as compared to FrontPage 2003
throughout this book, Table 1.1 compares some of the major features and components available in
FrontPage 2003 and SharePoint Designer.

TABLE 1.1

Comparing SharePoint Designer with FrontPage 2003

Features FrontPage 2003 SharePoint Designer
Task panes Introduced in FrontPage 2003 for working  Extensively uses dockable task panes to man-
with various features, such as layers, age features, such as CSS, Tag Properties,
behaviors, layouts, etc. Data Sources, Reports, etc. Property grids
provide a Visual Studio-like interface for
working with tag and control properties.
Cascading Interface available to create new styles Brand-new intuitive CSS application and
Style Sheets and implement style sheets on Web pages ~ management interface using toolbars and
(CSS) task panes that can be used to create and

Master pages

Not available

manage styles. CSS layout templates also
available.

Ability to create, attach, and detach master
pages and content regions. Reporting for
master pages is also available

ASP.NET 2.0 Not available Available with .NET Framework 2.0 installed

controls on the machine

Database Used to create Web pages for interfacing Deprecated and replaced by ASP.NET 2.0

wizards with databases data controls

SharePoint Can be used to create and manage con- Can be used to create content for and man-

content tent with WSS v2 sites. Limited backward- ~ age WSS v2 and WSS v3 sites

compatibility also available for STS sites

Workflows Not available in WSS v2 Workflow Designer available for creating and
deploying declarative workflows for WSS v3
sites

Data views Available for showing data from data- Available for showing data from databases,

bases, SharePoint sources, XML files, etc.

SharePoint sources, XML files, etc. Extends
the FrontPage 2003 capabilities by allowing
for creation of forms that can be used to
insert and update data besides showing it



Becoming Familiar with SharePoint Designer _

Features FrontPage 2003 SharePoint Designer
Web A number of FPSE- and WSS v2-based Inherits these Web components from
components components available, such as hit FrontPage 2003

counters, confirmation fields, etc.
Dynamic Web  Ability to create, attach, and detach Inherits this feature from FrontPage 2003
templates dynamic Web templates and manage

editable regions
Data forms Not available. List forms can be modified ~ Can be used to create advanced data forms

Reporting for
Web sites

Code and
design features

Data sources

Re-ghosting
SharePoint
pages

to a certain extent by using Collaborative
Application Markup Language (CAML)
features.

Site and usage reporting available depend-
ing on the server setup

IntelliSense and auto code completion
available for HTML and client-side scripts

SharePoint data sources available through
the Data Source Library task pane

Not available

for SharePoint list and document libraries,
databases, etc., using the new and advanced
Data Form Web Part

Advanced CSS error and usage reporting,
accessibility, and compatibility reporting
available using task panes

Visual and formatting marks for HTML tags
and ASP.NET 2.0 controls in the Design
view. IntelliSense for HTML, JavaScript, and
ASP.NET 2.0

SharePoint and non-SharePoint data sources
available through the Data Source Library
task pane. Aggregate data sources available
for linking data sources together

User interface available to selectively
re-ghost SharePoint Web pages

Some of the differences shown throughout this book are apparent; SharePoint Designer is the
newer version and exploits many features that the new SharePoint 3.0 itself has to offer.
Workflows, for example, is a new technology that SharePoint 3.0 exposes to SharePoint Designer
for creating advanced logic-based processes that could help in implementing common business
actions and purposes. The ability to use ASP.NET 2.0 controls through a wizard-based approach is
also new for SharePoint Designer, which now offers a simpler Visual Studio/Visual InterDev-like
interface to work with ASP.NET 2.0 control properties. Some features, such as the Database
Results Wizard and shared borders, are deprecated and have been replaced in favor of newer and
better technologies. Throughout this book, I talk about these differences while also discussing the
new features.

Although SharePoint Designer offers its full capabilities for SharePoint sites, you could be a Web
site designer concentrating totally on non-SharePoint Web sites. In that case, the SharePoint fea-

tures of SharePoint Designer might just be useless to you until you start developing for SharePoint,
and you might want to invest in a trimmed-down version of SharePoint Designer, such as the cur-
rent release of Expression Web, which is a subset of SharePoint Designer.
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Choosing between Expression Web
and SharePoint Designer

This choice is quite simple: If you as a Web site designer need to concentrate primarily on
SharePoint sites, the obvious choice is SharePoint Designer. However, if you don’t develop content
for SharePoint sites, you can invest in Expression Web. Expression Web offers almost all the non-
SharePoint features of SharePoint Designer, such as ASP.NET 2.0 controls, master pages, and CSS,
but has the limitation that it can’t open SharePoint sites. It lacks all the SharePoint capabilities that
SharePoint Designer offers. So, if a non-SharePoint Web server hosts your Web site and you have
no plans to develop SharePoint content, Expression Web can provide you with all the tools you
need for your Web site development. The non-SharePoint interface for the current release of
Expression Web and SharePoint Designer is essentially similar and thus you can also use this book
as a reference for Expression Web.

Understanding SharePoint Designer Basics

In this section, I discuss some basic concepts and terminology about Web site designing from the
SharePoint Designer perspective, helping you feel more comfortable as you read the rest of this
book. Most of the concepts surrounding SharePoint Designer are based on FrontPage technology,
so if you're already familiar with FrontPage 2003, this might just emphasize your knowledge about
SharePoint Designer.

Meeting the requirements

Although the basic SharePoint Designer setup is fairly simple and doesn’t require much user inter-
action, you might want to have these prerequisites set up on your computer before you install
SharePoint Designer so that all its features are readily available to you:

B NET Framework 2.0

B NET Framework 3.0

You can download these from the Microsoft Web site at www.microsoft.com/downloads.

Having these tools downloaded to your computer prior to installing SharePoint Designer ensures
that you can properly use the elaborate ASP.NET 2.0 features of SharePoint Designer. But you can
also download them after installing SharePoint Designer.

Prior to installing SharePoint Designer, you also need to ensure that your machine meets these
basic system requirements:

B Processor: 700 megahertz (MHz) processor or higher
B Memory: 512 megabyte (MB) RAM or higher
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W Hard drive: 1.5 gigabyte (GB); a portion of this disk space is freed after installation if you
remove the original download package from the hard drive.

B Drive: CD-ROM or DVD drive
W Display: 1024 X 768 or higher resolution monitor

B Operating system: Microsoft Windows XP with Service Pack (SP) 2, Windows Server
2003 with SP1, or later operating system

If you work with SharePoint Designer on SharePoint sites, then you need to have a Web server set
up for WSS or MOSS.

The setup process for SharePoint Designer is fairly simple and is similar to the Office 2007 setup
process. The Setup Wizard allows you to choose to either set up the basic installation by using the
Install Now button or customize the setup using the Customize button. The Customize button, as
shown in Figure 1.1, allows you to change the installation directory for SharePoint Designer and
pick features that you want to install during setup.

FIGURE 1.1

Customization options during setup for SharePoint Designer

il Microsoft Office SharePoint Designer 2007 |

Language Installation Options | File Location | User Information |

Customize how Microsoft Office programs run

&= | Microsoft Office OneNote

& ~ | Microsoft Office SharePoint Designer
& v | Office Shared Features

& = | Office Tools

Microsoft Office productivity programs plus additional content and tools.  Total space required on drive: 773 MB
Space available on drive: 135126 MB

@

Install Mow
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After you install SharePoint Designer on your computer, choose Start=> Control Panel &> Add or
Remove Programs to change (add or remove features), repair, or remove SharePoint Designer. On
Windows Vista machines, this is accessible by choosing Start=> Control Panel = Programs and
Features. The first time you open SharePoint Designer, you're asked whether you want to make
SharePoint Designer your default program for Web site development. If you choose to use
SharePoint Designer as the default program, it’s set up so that Web content (HTML or ASP.NET
pages, style sheets, etc.) on your computer opens with SharePoint Designer.

B Setup administrators might want to skip the introductory messages that are shown
the first time SharePoint Designer opens and allow their users to directly start
using SharePoint Designer rather than having to make these choices. You can learn more about
turning off these messages at http: //support.microsoft.com/kb/929767.

The SharePoint Designer setup can also be configured using Office policy templates, which allow
administrators to control the features available within SharePoint Designer to their users.

B The Microsoft support article at the following Web site provides information about
% how administrators can use Microsoft Office templates with Microsoft Office 2007
programs (including SharePoint Designer): http: //support .microsoft.com/kb/924617.

After your SharePoint Designer setup is complete, you might also want to install the SharePoint
Designer Service Pack (SP) 1 from the Microsoft Web site at www.microsoft.com/downloads.

Understanding the structure
of Web pages and Web sites

The structure of Web pages in general is pretty flexible and spans to the imagination of a Web site
designer. As a designer, you have the power to decide how you want to lay out your Web pages.
SharePoint Designer provides you with templates that you can use for starting up.

e o e a = For more on working with basic Web page components, see Chapter 5.

10

From the SharePoint Designer perspective, it's important to understand that a Web page essentially
has a Design view and a Code view. The Code view shows the code (HTML, JavaScript, ASP.NET
code, etc.) of the Web page and allows direct modification by using features such as IntelliSense
and auto code completion. When you click the Design view tab of a Web page, SharePoint
Designer renders the code associated with the Web page into a WYSIWYG format that assists in
designing and previewing the page layout. Some files, such as style sheets, don’t need a Design
view, so only a Code view is displayed for them.

SharePoint Designer’s complex rendering logic also renders ASP.NET 2.0 controls, the master page
application, and the style sheet application on Web pages. While rendering Web pages for the
Design view, SharePoint Designer also stores the properties and attributes of the tags and controls
present in the code of the Web page. These properties are then presented in the various task panes
for modification.
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B All task panes are accessible under the Task Panes menu.
| For more on property grids and task panes, see Chapters 4 and 6.

I now take you through the steps for creating a simple Web site and then adding some content to
that Web site.

One important thing to understand while using SharePoint Designer to create Web pages is that
Web pages by nature reside inside Web sites. Although you can save your Web pages wherever
you want on your computer, it's always best that you create a folder for your Web site and store all
Web pages and other content inside that folder. Such a folder is called the root folder of your Web
site. Creating a root folder assists you in better management of Web pages and other content that
you create during the course of building a Web site:

1. Create a root folder for your Web site at the location of your choice on your com-
puter. This ensures that you remember the location where your Web pages and content
are stored. Ensure that your root folder is empty.

2. Open SharePoint Designer and then choose File= New. The New dialog box opens.
This dialog box is new to SharePoint Designer and provides a consolidated interface to
create new Web content (pages, JavaScript file, style sheets, etc.).

| For more on the New dialog box, see Chapter 4.

3. Click the Web Site tab. This tab allows you to choose from a list of Web site templates
available in SharePoint Designer. For this exercise, use the One Page Web Site template.

4. Click Browse, which is next to the Specify the location of the Web site dropdown
menu. Using the New Web Site Location dialog box, specify the location of the root
folder that you created in step 1.

5. Click OK. SharePoint Designer opens your Web site at the root folder and automatically
places a default.htm file (because you selected the One Page Web Site template)
inside the root folder. The folder is now listed in the Folder List task pane (which can be
toggled on or off by pressing Alt+F1), which is displayed in the left corner of the
SharePoint Designer window by default.

After following these steps, the icon for your root folder inside Windows Explorer changes to a
folder icon with a globe on it, indicating that it’s a Web site (a disk-based Web site). SharePoint
Designer Web sites are basically one of two types:

B Disk-based: The content of this Web site resides inside a folder on your local computer.
You work on the disk-based Web site locally and then publish the content you create
locally to a Web server—based location that might reside either on your local computer (if
your computer is a Web server itself) or a remote Web server computer (a site-hosting
service provider, for example). The folder icon with a globe on it (an £pdbw. ico file
stored in the _vti_pvt folder) indicates this type of Web site.

11
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B Server-based: The content of this Web site is located on a remote Web server and is
accessible to the SharePoint Designer client for modification by using a remote-authoring
mechanism, such as FPSE, SharePoint, FTP, or WebDAV. SharePoint Designer now
allows for remote authoring (also called live editing) of server-based FTP and WebDAV
sites. SharePoint sites also fall into this category of Web sites.

When you open the root folder of your Web site, SharePoint Designer has created a number of
other files and folders inside the root folder.

. R Many of these files and folders are hidden by default, so you have to enable the
A

WSS viewing of hidden folders in Windows Explorer by choosing Tools=> Folder Options=>
View. Click the Show hidden files and folders radio button in the Advanced Settings list.

The two folders that result from the previous steps are the _vti_cnf and the _vti_pvt folders.
The reason for having these folders is that they provide the underlying infrastructure files for many
features that SharePoint Designer exposes. For example, in the _vti_pvt folder is a file called
structure.cnf. This file stores the navigation structure of the Web site, which can be created
by using the Navigation pane in SharePoint Designer. So, essentially, if someone deletes this file or
folder using Windows Explorer, the navigation structure of your Web site is lost, and any Web
components based on the navigation structure are useless.

F For more on the Navigation pane, see Chapter 14.

—d

B The folders that have the prefix _vti_ aren’t displayed in SharePoint Designer. So,
45 if you want to hide the contents of a folder from being edited using the SharePoint
Designer interface, you can do so by adding the _vti_ prefix to it.

The other important thing to understand about these folders is that they’re used for the FPSE-based
features of SharePoint Designer. Also, a number of other folders — such as _derived, _overlay,
and _themes — are created in the root folder when you use FPSE features. If you delete these fold-
ers, any FPSE-based components that depend on these folders and the files inside them stop working.

Exploring Hidden Metadata and Raw Webs

Files and folders inside the root folder of a SharePoint Designer Web site are collectively called the
hidden metadata of the Web site. The metadata inside the root folder keeps track of whether the
Web site is a disk-based Web site or a server-based Web site. It also stores information about the
list of subsites that the root site might contain. The metadata is a vital resource for performing a
number of site management operations, such as hyperlink recalculation and creating the navigation
structure.

If you decide to move away from using the FPSE features of SharePoint Designer, you might not
need this metadata and can configure SharePoint Designer to not create the hidden metadata. A
SharePoint Designer Web site that doesn’t have metadata in it is called a raw Web. To convert your
Web site to a raw Web, follow these steps:
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1. In SharePoint Designer, open the Web site you created earlier in this chapter by
choosing File= Open Site. The Open Site dialog box opens, with the Web Sites pane
selected in the left Navigation pane. The Web Sites pane shows the list of Web sites that
you've created.

Choose your Web site and then click Open.
Choose Site Site Settings. The Site Setting dialog box opens.

Deselect the Manage the Web site using hidden metadata files check box. As indi-
cated in the explanation text next to this check box, SharePoint Designer adds hidden
metadata files to your root folder to enable and maintain certain features.

5. Click OK. A dialog box asks you for confirmation. The warning message indicates that if
you elect to not use hidden metadata, you lose the navigation of your Web site and many
FrontPage Web components stop being updated.

6. Click Yes if you want to continue.

After you deselect this option, the root folder of your Web site no longer has any _vt1i folders in it.
This means that SharePoint Designer now has no ability to track FrontPage Web components and fea-
tures. These features are thus disabled from the SharePoint Designer user interface when this option is
deselected. For example, if you choose Insert=>Web Component and then open the Insert Web
Component dialog box, most of the features are disabled when you deselect the hidden metadata
usage check box. Also, the Recalculate Hyperlinks menu option is no longer available in the Site menu.

| For more on Recalculate Hyperlinks, see Chapter 23.

If you later need to use the SharePoint Designer features that rely on the hidden metadata files, you
can click the Manage the Web site using hidden metadata files check box again. SharePoint
Designer then adds new hidden metadata to your Web site and starts using it for maintaining
cross-page dependencies and other FrontPage Web components.

| Any metadata that’s removed by deselecting the hidden metadata check box is
% completely lost and isn’t recoverable. When you click the check box again, new
metadata is created, and you have to rebuild the components.

The ability to remove hidden metadata has long been asked for by Web site developers who don’t
use FrontPage-based components and want to see cleaner Web site content directories. Because
SharePoint Designer now offers the capability to use ASP.NET 2.0 controls and features exten-
sively, most of the FrontPage legacy functionality can be obtained by newer, advanced ASP.NET
2.0 controls. Raw Webs provide these advantages for Web site developers:

B Developers now have a mechanism to ensure that they don’t inadvertently use any
FrontPage legacy features.

B Because SharePoint Designer now offers the capability of live editing using FTP and
WebDAV, developers can choose not to use FPSE as a remote-authoring mechanism.

B They don’t have to manage the hidden metadata when moving Web content from one
location to another.

13
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Creating basic Web pages

Continuing with efforts to understand the basics involved in Web content development, I take you
through some steps that you generally follow in SharePoint Designer when creating Web pages. 1
want you to become familiar with the SharePoint Designer terminology in this chapter so that you
don’t feel uncomfortable when you delve into more complicated Web site designing concepts.

14

Follow these steps to create simple Web pages using various templates that SharePoint Designer offers:

1.

10.

11.

12.

In SharePoint Designer, open the disk-based Web site you created earlier in this
chapter. Ensure that the Manage the Web site using hidden metadata files check box is
selected.

Choose File=> New to open the New dialog box.

Click HTML under the Page tab to create a blank HTML Web page and then click
OK. The Design view of the newly created HTML page is shown.

Choose Filew Save or press Ctrl+S to save the page. The Save As dialog box opens,
with your currently opened Web site listed in the Save dropdown menu.

Using the File name text field, type a name for your Web page and then click Save.
HTML pages have the extension .htm or .html. You can save the Web page by using
either extension.

Choose Filew> New to open the New dialog box. You can now create a new CSS from
the existing templates in SharePoint Designer.

¥ For more on Cascading Style Sheets (CSS), see Chapter 12.

Click Style Sheets and then click the Downtown style sheet template. A new CSS
based on the Downtown template opens. This template appears in the Code view.

Press Ctrl+S to open the Save As dialog box and then save the style sheet with the
name of your choice. Style sheets have the extension .css, so make sure that you keep
this extension when saving a style sheet. Because you're saving these files into the Web
site’s root folder, the newly created Web page and the style sheet are listed in the Folder
List task pane.

Using the Folder List task pane, double-click the Web page you created in the previ-
ous steps to open it in SharePoint Designer.

Choose Format=> CSS Stylesw> Attach Style Sheet to open the Attach Style Sheet
dialog box. You use this dialog box to attach to the Web page the style sheet you previ-
ously created.

Click Browse next to the URL text field to open the Select Style Sheet dialog box,
click the style sheet file you created in the previous steps, and then click Open.
Ensure that the Current Page radio button is selected so that the style sheet applies only
to the current page.

Click OK to apply the style sheet to the Web page.
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The look and feel of the Web page changes after the application of the style sheet. The Web page
now has a new background, and if you type some text on the Web page, the color of the text is
white. The SharePoint Designer Design view renders the Web page in the Design view by combin-
ing the formatting implemented in the style sheet attached to it.

The New dialog box that you worked with in the previous exercise is the interface that consolidates
the creation of all Web content within SharePoint Designer. This is different from FrontPage 2003
and the previous versions where page and Web content creation were scattered around in different
task panes. Having a single interface for creating all SharePoint and non-SharePoint content is
advantageous because it eliminates the need to search around the user interface for developing
content.

The New dialog box can be used to create HTML and ASPX Web pages, JavaScript files, CSS, mas-
ter pages and dynamic Web templates (DWTs), XML, and TXT files. Also, it offers the Web Site
tab, which can be used to create Web sites (SharePoint and non-SharePoint) based on templates.

I If you open a SharePoint site in SharePoint Designer, the New dialog box

- also shows a tab called SharePoint Content. This tab can be used to create
SharePoint-based content, such as lists, document libraries, workflows, and page layouts. Also,
for SharePoint sites, the Web Site tab lists a number of templates that you can choose from for
your new SharePoint sites.

Apart from using the New dialog box, you can also use the Folder List task pane to create new
Web pages and content. If you right-click in the empty area inside the Folder List task pane, a
popup menu appears that has the New menu option that allows for the creation of Web pages and
CSS. You can use this menu to create new folders and subsites.

Follow these steps to use the existing frame templates that SharePoint Designer provides to create a
set of Web pages:

I For more on frames, see Chapter 5.

1. In SharePoint Designer, open your Web site and then choose File > New to open
the New dialog box.

2. In the Page tab, click Frames Pages and then click the Header, Footer and Contents
template. As indicated in the description text, the template creates header and footer
frames for navigation.

3. Click OK. This creates a frameset page, as shown in Figure 1.2, that's displayed in the
Design view in SharePoint Designer.

4. Save this page inside the root folder of your Web site.

Click the New Page button on all the four frames inside the frameset page. This cre-
ates new pages that fill up the frames present in the frameset page. Remember the order
in which you clicked the New Page buttons. This is required to name the pages in the
next step to keep track of which page is displayed in which frame.

15
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A frameset page in the SharePoint Designer Design view

|4 Web Site || Untitled_6.htm
[ 0

St ifial Page.

X

Set |nitial Page...
Set Initial Page...

St ifial Page.

|[Boesian] B 5plc @ Na Frames Elcade

6. Press Ctrl+S, and you’re asked to save all the HTML pages inside the frames one
after the other in the order they were created. Because there are four frames, you have
four new Web pages in the root after you save the frames pages. You can name the page
for the left frame as Left . htm, the top frame as Top . htm, etc.

Your frameset page is now ready for the content that you want to put on the frames pages. For
example, you could use the top frame page for a banner picture, and the left frame could be used
to create hyperlinks that switch pages in the Contents frame of the frameset.

Right now, I want to divert your attention to the newly created pages from the previous exercise.
The Folder List task pane lists these newly created Web pages in the root folder of your Web site.
1f you right-click on a Web page in the Folder List task pane, a popup menu opens with these
options:

Open: Opens the Web page in the SharePoint Designer Design view (or Code view)
Open With: Allows you to choose the program that you want to open the Web page in

Open in New Window: Opens the Web page in a new instance of SharePoint Designer

Set as Default Master Page: If you've selected a master page, you can use this option to
set the selected master page as the default master page for the Web site. If you don't have
a master page selected, this option is grayed out.

F For more on master pages, see Chapter 13.
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B New From Existing Page: Creates a new page based on the selected page

Preview in Browser: Opens the Web page in the default browser for previewing

Cut, Copy and Paste menu options: Allows for moving Web pages from one folder
location to another inside the Web site

Set as Home Page: Sets the Web page as the default home page for the Web site
Rename: Allows you to rename the Web page

Delete: Deletes the Web page after requesting confirmation from the user

Publish Selected Files: Opens the publishing page that can be used to publish the Web
page to a new location. Web page publishing is discussed later in this chapter.

Don’t Publish: Marks the Web page so that it's not included when a publishing opera-
tion is performed on the Web site

B Properties: Opens the Properties dialog box, which can be used to view general properties
of the Web page and choose categories (if hidden metadata is allowed) for the Web page

Options in this popup menu might change depending on the type of selection you make in the
Folder List task pane and the type of Web site that you have open in SharePoint Designer. For
example, if you have document checking enabled on a Web site (discussed later in this chapter),
the Check Out menu option becomes available.

Right-click on the Web page after opening it in the Design view and then choose Page Properties
from the popup menu. This opens the Page Properties dialog box, as shown in Figure 1.3, which
can be used to set up a number of properties for the Web page. These properties include the title,
background sound, background picture, etc.

The Page Properties dialog box has the following tabs that allow for setting a number of properties
for a Web page. Most of these settings provide a user interface for applying HTML tags and attri-
butes or style elements that define the look and feel of the Web page:

B General: Allows the user to set the <Title> tag, the <Base> tag, keywords, and
description meta tags for the Web page. It also allows you to set the default target frame
and background sound for a Web page.

B Formatting: Provides the interface to set the background picture or configure the back-
ground picture as a watermark on a Web page. This also allows for setting the back-
ground color, text color, and colors for hyperlinks.

B Advanced: Used to set margins for a Web page. This is done by applying the margin
styles to the <Body> tag of the Web page.
B Custom: Allows for creating HTML meta tags, such as Refresh, Keywords, and

Description, that define the behavior of the Web page or provide directions to the
Web browser

B Language: Provides the interface to set the Content-Type and Content-Language meta
tags for the Web page. These meta tags define the page’s language and HTML encoding.

B Workgroup: Allows the Web site designer to create categories of Web pages and assign
Web pages to those categories. These categories can then be used to create a categorized
table of contents. This feature requires the hidden metadata to be enabled.
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FIGURE 1.3

The Page Properties dialog box
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Follow these steps to use the Page Properties dialog box to set some properties for the Web page
that define the way the Web page looks and behaves:

1.

Choose File=> New to open the New dialog box and then create a new HTML Web
page. The new page opens in the Design view.

Right-click on the Web page and then choose Page Properties from the popup menu.
The Page Properties dialog box opens.

In the General tab, type the title for the Web page in the Title text field.

Click the Formatting tab, and in the Colors section, choose a background color for
the Web page by using the Background dropdown menu.

Click the Custom tab. In the next steps, you use this tab to create a new system variable
(an HTML meta tag) that refreshes the page every 5 seconds when viewed in a browser.

Click the Add button next to the System variables list.

In the Name text field, type Refresh, and in the Value text field, type 5 (for a refresh
every 5 seconds).

Click OK. Your choices have been saved for this HTML page.

Save the Web page. You can now browse to the page by either right-clicking on it in the
Folder List task pane and then choosing Preview in Browser from the popup menu or
pressing F12.
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The title you set for the Web page shows in the title bar of the Web browser. The background color
of the Web page changes to the one you set. Also, the browser reloads the Web page every 5 seconds
because of the Refresh meta tag that you created in the previous steps. The SharePoint Designer
interface allows you to set the basic properties for a Web page without having much understanding of
the code involved in the back end. Obviously, SharePoint Designer offers many other ways to manage
these properties for Web pages, and I discuss those options throughout the rest of this book.

Working with simple Web sites

A Web site is basically a collection of resources that help realize the goals of an organization on the
Internet. The resources for Web content are Web pages, pictures, supporting files (style sheets,
JavaScript files, etc.) and programs ( .exe, .d11, etc.) that contain logic and perform business
operations. A Web site is accessible on the Internet through a Web server. The role of the Web
server is to be a host for Web site content and process Web page requests made by Web browsers.
A single Web server can host a large number of Web sites.

Now that you know how to create a simple Web site and add Web pages and style sheets to it, it’s
time to learn how to open and delete Web sites, create subsites, and establish general settings for
Web sites inside SharePoint Designer.

Creating subsites within a Web site by using SharePoint Designer essentially involves the same
steps you would follow to create a new Web site. That is, choosing File = New > Web Site allows
you to pick the template you want to use for the subsite. However, just before you click OK, you
need to click the Add to current web site check box. It’s important to note that subsites inherit the
server configuration of the parent Web site. This means that subsites inside SharePoint sites are
always SharePoint subsites. Similarly, subsites inside FPSE parent sites are always FPSE subsites.

To open a Web site in SharePoint Designer, simply choose File= Open Site. The Open Site dialog
box opens, with a number of panes that allow you to look for the Web site that you want to open.
The Web Sites pane in the left Navigation pane shows the list of all Web sites that you've created
or opened on the machine that has SharePoint Designer installed.

The Current Site pane, as the name suggests, is only available if you already have a site open in
SharePoint Designer before you open the Open Site dialog box. It shows the list of folders and files for
the Web site that’s currently open and can be used to open subsites within the site. The My SharePoint
Sites pane lists the SharePoint sites that you created or opened by using SharePoint Designer.

If you've previously opened the Web site in SharePoint Designer, try to see if you can find it in the
recently opened list of Web sites by choosing File &> Recent Sites.

SharePoint Designer also maintains a list of recently opened sites and Web pages in
x the Windows registry at C: \My Computer \HKEY CURRENT_ USER\Software\
Microsoft\Office\12.0\SharePoint Designer. SharePoint Designer uses this registry
hive for saving user settings, including recently opened sites and Web pages, the default save
location for Web sites, and the state of various SharePoint Designer user interface components.
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1f the Web site that you want to open doesn’t already exist in the aforementioned lists, you can
simply type the complete URL of the Web site in the Site Name text field. SharePoint Designer tries
to establish a connection to the remote Web server and, if it finds the Web server hosting the Web
site and can successfully authenticate to it, then opens the Web site for remote authoring.

For more on remote authoring, see Chapter 3.

While choosing File=> Open Site takes you to the Open Site dialog box, which allows you to open
Web sites, choosing Files> Open brings you to the Open File dialog box, which is used to open files
and documents inside Web sites. If your page or document resides inside a Web site, SharePoint
Designer opens the Web site itself. You can choose File= Close Site to close the Web site.

SharePoint Designer supports live editing and remote authoring for a number of Web server types.
You can work directly on a Web site in SharePoint Designer if the Web server hosting the Web site
supports one of these remote-authoring technologies:

FTP

WebDAV

FPSE

SharePoint

Depending on the remote-authoring technology that your Web server supports, some of the features
of SharePoint Designer are disabled. SharePoint Designer offers its full capability for SharePoint
sites. The SharePoint Designer features that rely on SharePoint aren’t available for FPSE sites.
Similarly, the features and components that rely on FPSE aren’t available on FTP or WebDAV sites.

After you open a Web site in SharePoint Designer, you can use the Site Settings dialog box to
determine the type of Web server that hosts the Web site. As with many other dialog boxes in
SharePoint Designer, many of the options in this dialog box might be disabled depending on the
Web site that you open. To open the Site Settings dialog box, as shown in Figure 1.4, choose
Site= Site Settings.

Within the Site Settings dialog box are several tabs:

B General: This tab is used to display the version information about the Web server and
version information about the FPSE or SharePoint installed on the Web server. You can
use this tab to disable the use of hidden metadata for non-SharePoint and non-FPSE sites.
Also, you can enable lightweight document check-in and check-out using this tab.

B Preview: You can use this tab to specify if you want to use the Microsoft ASP.NET
Development Server to preview ASP.NET Web pages on your machine. SharePoint
Designer installs the Microsoft ASP.NET Development Server during its setup. This
option is useful if you don’t have a Web server machine (ASP.NET pages need a Web
server for processing) and would like to see a browser-based preview of the ASP.NET
pages you create with SharePoint Designer.
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[ For more on ASP.NET, see Chapter 10.

B Parameters: Allows you to create FPSE-based parameters for your Web site. These
parameters can be used later by FrontPage components, such as substitution compo-
nents. This tab isn’t useful for Web sites that don’t allow hidden metadata.

B Advanced: Allows you to set the default validation script language for FrontPage valida-
tion components. Also, it provides a check box to show hidden files and folders (certain
metadata files) inside the Web site. Also, this tab isn’t useful for Web sites that have hid-
den metadata disabled.

B Language: Allows you to set the default page encoding for the Web site. For Web sites
with hidden metadata, this tab allows you to set the language of the server messages.

B Navigation: Allows you to customize the text labels on FrontPage link bar components.
This tab isn’t available for Web sites with disabled hidden metadata.

I For more on FrontPage components, see Chapter 9.

B Database: This tab is for backward-compatibility with Web sites that have Database
Results Wizard pages in them.

FIGURE 1.4

The Site Settings dialog box
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Maintaining Web Sites

After you create a Web site, you likely want to manage it properly so that you don’t lose the work
you've completed and don’t have to re-create anything. However, Web site maintenance isn’t just
about backing up and publishing content. You also have to decide which content to publish,
which Web pages to keep, and which version of files to delete.

SharePoint Designer offers a number of options for Web site maintenance. Depending on the type
of Web site that you're working on, you have a set of tools available in SharePoint Designer to per-
form housekeeping and Web site management.

Understanding basic site management
for non-SharePoint sites

The first operation that you need to perform when your Web site is ready is to publish it to a
remote Web server by using an Internet address (URL) that your hosting provider or Web site
administrator grants for your Web site. Publishing is the process of making the Web site content
available for viewing by others. SharePoint Designer allows you to publish content from one Web
server to another, from a disk-based location on the local computer to a Web server, or from a
Web server—based location to a folder on your local computer (called reverse publishing).

! For more on managing non-SharePoint sites, see Chapter 23.

Publishing

SharePoint Designer offers an easy-to-use, intuitive mechanism for publishing content from one
location to another. You can access the SharePoint Designer publishing interface by choosing
File=> Publish Site. The Remote Web Site Properties dialog box, as shown in Figure 1.5, opens in
the foreground, and the Remote Publishing pane opens in the background of the SharePoint
Designer environment.

The Web site that you have open in SharePoint Designer becomes the local Web site for publishing
and is displayed in the Local Web Site section of the Remote Publishing pane. You then use the
Remote Web Site Properties dialog box to specify the type of remote Web server, the location of
the remote Web site, and the settings for the publishing operation.

After the remote Web site is set up, you can either publish from local to remote, publish from
remote to local (reverse publishing), or synchronize the content of the two Web sites.
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FIGURE 1.5

The Remote Web Site Properties dialog box
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Import and export content

SharePoint Designer provides two mechanisms for importing and exporting content, which are
available by choosing File= Import or File= Export:

B Import Site Wizard: Use this wizard to import content from a variety of locations.
Choosing to use FPSE, WebDAV, or FTP as an import location in this wizard links you
back to the Remote Publishing pane for SharePoint Designer. However, the HTTP option
allows you to download Web pages and content from any HTTP location on the Internet.

B Personal Web Packages: This allows you to package a Web site into a compressed file
(. fwp) that can then be exported into another site. While exporting and importing con-
tents of a Web site, SharePoint Designer allows you to choose the content you want to
compress in the package for exporting and then choose content you want to import.
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Versioning

Depending on the nature of a Web site, the SharePoint Designer interface allows a designer to
check-out a document so that it becomes locked — preventing others from working on the Web
site — modify and update the document, and save and then check-in the document so that the
updated document is available for other users.

Versioning and document check-in and check-out features in SharePoint Designer mostly rely on
the Web server configuration and type. Although basic check-in and check-out are available for
disk-based (using hidden metadata), FTP, and WebDAV sites, the advanced versioning features are
provided by Web sites that use FPSE or SharePoint. For example, you can enable basic document
check-in and check-out (if you have hidden metadata allowed) by clicking the Use document
check-in and check-out check box in the General tab of the Site Settings dialog box.

Reporting

You use the Reports pane in SharePoint Designer to access many of the reports that it generates for
Web sites. Choose Site=> Reports to open the Reports pane. Besides site and usage reporting,
SharePoint Designer also offers these reporting features:

I For more on the Reports pane, see Chapter 25.

B CSS reports: You can have SharePoint Designer generate reports that show details about
unused styles, undefined classes, mismatched cases, and CSS usage while implementing
CSS. These reports help in consolidating the style sheets being used inside the Web site
more efficiently.

B Accessibility reports: Using the Accessibility Checker in SharePoint Designer, you can
find out if your Web pages are compatible with the accessibility Web standards. You can
use the report generated to correct issues and improve accessibility.

B Compatibility reports: You can use these reports to find out if your Web pages are com-
patible with the Web browser and CSS schema you're targeting your Web site for.

Authoring SharePoint sites

With SharePoint sites, although most site management operations are performed using the
SharePoint administration Web sites and tools, limited backup and restore and import and export
capabilities are offered by SharePoint Designer.

In the user interface, SharePoint Designer treats SharePoint sites almost like any other Web site.
So, you can perform most authoring and site management operations on SharePoint sites in man-
ners similar to non-SharePoint sites. However, SharePoint Designer provides a lot of new features
in collaboration with SharePoint that make the authoring and management experience a lot more
different and enriching.
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Here’s a brief introduction to some SharePoint-specific features of SharePoint Designer:

B SharePoint content: SharePoint Designer allows the creation of almost all SharePoint
content, including sites and subsites, page layouts and master pages, lists and document
libraries, and surveys. It also offers the Document Library View Page Wizard and List
View Page Wizard that assist in creating view pages for SharePoint document libraries
and lists.

B Workflows: SharePoint Designer has an advanced Workflow Designer that can be used
to create, compile, and deploy declarative workflows for SharePoint sites.

B Data forms: With SharePoint sites, SharePoint Designer enables a complete menu called
Data View that offers capabilities to work with data sources provide by SharePoint. It
offers the Data Form Web Part that can be used to create views and forms for SharePoint
data sources.

B Web parts and SharePoint controls: SharePoint Designer allows for inserting and modi-
fying properties of SharePoint Web parts and Web part zones. Also, it exposes a number
of SharePoint controls as well as page and content fields that can be used on SharePoint
Web pages.

B Contributor settings: These settings allow SharePoint administrators to enable or disable
certain features and menu options in SharePoint Designer based on the permissions that a
user has on a SharePoint Web site.

B Back up and restore Web sites: The publishing feature of SharePoint Designer isn’t use-
able with SharePoint sites. Instead, you can use SharePoint Designer to package, back up,
and restore SharePoint Web sites.

= For more on authoring and site management, see Chapters 5, 12, and 21.

Summary

In this chapter, you learned about the origins and birth of SharePoint Designer. You also learned
about how to use SharePoint Designer to create basic Web pages and manage settings for Web sites.
You learned how SharePoint Designer creates and manages hidden metadata for Web sites and
whether to use raw Webs. You were also exposed to the remote-authoring abilities of SharePoint
Designer as well as SharePoint and non-SharePoint authoring and site management features.
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n the previous chapter, you learned some basic concepts about creating

simple Web pages and Web sites by using SharePoint Designer. This

chapter focuses on server-related technologies because they form the
foundation and support for the Web content and Web sites that you design
in SharePoint Designer. Understanding these technologies is important, and
this information helps you decide how best to exploit the features of
SharePoint Designer, including which features to use and which ones to
avoid. It also helps you understand the internals of Web site administration
and management from the perspective of a Web server and helps you build
some concepts around Web server management so that you can troubleshoot
issues and problems when working with these technologies by using
SharePoint Designer.

Simply put, a Web server is a machine that hosts Web sites. When you use a
Web browser to visit a Web site, you're actually requesting some Web con-
tent from a Web server that hosts the Web site. It’s the job of a Web server
to serve requests for Web pages and other Web-based content in a timely,
scalable, and performance-optimized fashion. The Web server processes the
code associated with the Web pages and delivers the resulting output to a
Web browser for display.

Besides processing Web pages for display, Web servers also support a variety
of technologies that facilitate content management and publishing. Software
such as SharePoint Designer relies on the capabilities of Web server comput-
ers to provide their publishing features to Web site developers.

Although a number of Web server products are available for you to choose
from, I mostly concentrate on Microsoft’s Internet Information Services (IIS)
Web server. While SharePoint Designer can be used with Web sites hosted
by other Web server products, IIS provides the complete package for
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SharePoint Designer as a Web server. Apart from supporting development technologies such as
ASP.NET 2.0 (which is heavily exposed in SharePoint Designer), IIS supports all Web content
management and publishing technologies exploited by SharePoint Designer. These include FTP,
WebDAYV, FPSE, and SharePoint. As a matter of fact, SharePoint 3 can only be installed with IIS
6.0 and above as the Web server platform.

Exploring the Basics
of Internet Information Services

Internet Information Services (11S) is Microsoft’s premier Web server offering. As a product, it’s
available with almost all professional and enterprise versions of Microsoft’s Windows operating
system (OS). Table 2.1 lists the versions of IS available with the various Windows OS versions.

TABLE 2.1

Versions of 1IS Available with Different Windows Versions

Windows (OS) Version Available 1IS Version

Windows 2000 11S 5.0

Windows XP Professional Edition I1S 5.1

Windows Server 2003 Family (Windows 2003 Web, I1S 6.0 (which can also be run in 11S 5.0 isolation
Standard, Datacenter, and Enterprise editions) mode)

Windows Vista and Windows Server 2008 IS 7.0

Throughout this section, I discuss the concepts, settings, and configuration of 11S 6.0. Although at
the time of this writing IIS 7.0 was available for use as a Web server, it was not heavily deployed,
and most organizations were still developing strategies for possible upgrades and migration. I use
IIS 6.0 as the Web server platform for this book simply because of its wide acceptance, its success,
and its ability to host SharePoint environments. Also, while I discuss the most important concepts
for IIS 6.0 (which help you understand SharePoint Designer components and features better), a
detailed discussion of IIS 6.0 architecture and functionality is beyond the scope of this text.

The 1IS 6.0 release for the Windows 2003 server family of operating systems is by far the most reli-
able, scalable, and secure version of IIS. It provides unparallel reliability and uptime to Web appli-
cations (and Web sites) through its application isolation environment, which allows Web
applications to run in their own process space without interfering with each other. It includes a
number of security features that ensure the protection and integrity of Web content and data pre-
sented by your Web sites. Also, it offers support for the latest Web standards, including HTTP 1.1,
TCP/IP, FTP, SMTP, NNTP, and WebDAV.

28



Understanding Related Server Technologies _

Understanding basic concepts

The first question that might come to the mind of a Web site designer when discussing IIS is how
to configure Web sites for use with SharePoint Designer. However, hold on to this feeling while I
talk about some basic IIS concepts. I can assure you that once these concepts are clear, you should
feel more comfortable working with the IIS interface. Obviously, you would want to know what an
application pool is before you go ahead and create one.

Web site identification

As discussed later in this chapter, IIS can host multiple Web sites on a single Web server computer.
Although that sounds fairly simple, identifying these multiple Web sites on a single computer as
separate when viewed from the Internet involves some work on the part of site administrators.

To distinguish among multiple Web sites on a single computer and ensure that user requests for a
Web site can be served from the correct physical location, IIS provides the identification options
shown in Figure 2.1:

B Multiple IP addresses: An IP address identifies a computer on a given network. If your
Web server computer is configured for multiple IP addresses, you can set up Web sites
using these multiple addresses. However, this approach requires that you have one
unique, static IP address for each Web site hosted on the Web server. Because public
static IP addresses are difficult to obtain, this approach might not necessarily be your one
solution for identifying multiple Web sites on a single server. You can open a Web site
configured with an IP address in SharePoint Designer by using the site name http: //
serveripaddress — for example, http://192.164.52.16.

B Multiple ports: The standard port for Web-based HTTP operations is port 80. If a port is
not specified manually, it's assumed that port 80 should be used. However, there are a
number of TCP/IP ports that can be specified for Web site identification. For example, you
can have three Web sites use a single IP address but three different ports. The downside of
using this approach is that the Web site user needs to denote the IP address (or the name
of the server) followed by the port number to reach the Web site. To open a Web site
configured with a TCP port in SharePoint Designer, use the format http: //serverip
address: portnumber — for example, http://192.164.52.16:8000 — for the
site name.

B Multiple host headers names: This is the most recommended approach and is com-
monly followed by Internet-facing Web server machines. The host header is a friendly
name (such as www.wiley.com) that can be associated with a Web site. Each Web site
on the Web server can have a set of host headers associated with it that helps IIS identify
the Web site when user requests are made. If your Web site is configured with a host
header, you can open it in SharePoint Designer by using the site name format http://
hostheader — for example, http: //www.wiley.com.

This signature, or identification, of a Web site — which includes the combination of an IP address,
a port, and a host header — is called the Web site’s server binding and is stored in the IIS configu-
ration file (called the metabase file).
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These dialog boxes offer advanced Web site identification features.
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Later in this chapter, I take you through the steps for configuring multiple Web sites on a single
Web server machine. As a matter of fact, you use this approach to set up four separate Web sites
with FTP, WebDAV, FPSE, and SharePoint and then later use them to understand related
SharePoint Designer features.

Authentication and authorization

When you open a protected Web site in SharePoint Designer, you're prompted for a username and
password, which are used by the Web server to identify you and then determine the operations that
you can perform. The process of identifying a user before granting access to a resource is called
authentication. Authorization, on the other hand, is the process of determining the level of access an
authenticated user has. IIS offers these authentication mechanisms, as shown in Figure 2.2:

B Anonymous authentication: Allows IIS to determine the kind of access for users who
aren’t known, such as those who don't have a username or password that can be used for
authentication. If anonymous access is allowed, 11S uses the built-in TUSER_
Machinename account (set up during the IIS installation process) for authentication.
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B Windows integrated authentication: This is the most secure form of authentication
because users must use their Windows accounts to identify themselves with IIS 6.0. This
form of authentication is point to point; that is, the user credentials can’t be passed on
from one machine to another. For example, once the Web server identifies the user with
a username and password, it can’t double-hop, which is using the credentials to connect to
a different resource or computer on the network. Due to this, Windows integrated
authentication is not suitable for Internet use, where the request might have to hop from
one machine to another before reaching a Web server.

A type of integrated authentication called Kerberos authentication can be set up to
bypass this double-hop issue.

B Basic authentication: As the name suggests, this is the most basic form of authentica-
tion, where the username and password are sent as clear text and are easily susceptible to
security breaches and attacks. However, it’s the most simple to set up and maintain and is
the most common form of authentication used on the Internet. To increase protection,
basic authentication is always used on a Secured Socket Layer (SSL) encryption channel.

B Digest authentication: This offers functionality similar to basic authentication but
increases security by providing better encryption of the user credentials across the network.

B Passport authentication: This provides a .NET-based single sign-in service, where users
have to type their credentials only once and then gain access to all Web sites and related
resources.

FIGURE 2.2

Authentication mechanisms in IIS
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While authentication is mostly provided to Web sites and Web applications by 1IS 6.0, authoriza-
tion can be either done manually or, as in the case of FPSE and SharePoint, by using a custom
application. The most basic authorization involves adding (or removing) users and granting (or
denying) them access by using the Security tab inside the folder’s Properties dialog box in
Windows Explorer, as shown in Figure 2.3.

Application isolation and protection

In previous IIS versions, Web sites and Web applications were loosely packed; that is, Web appli-
cations could interfere with each other, and faulty code running in one Web application could
bring down other Web applications running along with it or, in worst cases, 11S itself. IIS 6.0 intro-
duced the concept of application isolation (worker process isolation mode) and allows Web site
developers and administrators to separate Web sites and applications into application pools.

Worker process isolation mode ensures the protection and separation of the IIS base processes
(such as inteinfo.exe) from the Web application processes. All Web sites and Web applica-
tions run inside separate worker processes (w3wp . exe) that can'’t interfere with the root function-
ality of 11S. So, if a Web application crashes or hangs because of faulty code, only the worker
process associated with the Web application is affected, and other processes can still run and serve
requests without problems.

FIGURE 2.3

The Security tab in the MyWebSite Properties dialog box
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You implement application protection by creating application pools and associating Web applica-
tions with application pools. (You can have an application pool that hosts one or more Web sites.)
All the Web sites associated with an application pool run in a single worker process (or in multiple
worker processes, in the case of Web gardening). If the application pool stops or becomes
unhealthy, only Web sites associated with that particular application pool are affected.

For example, you can define the properties of the MSSharePointAppPool application pool by using

the MSSharePointAppPool Properties dialog box, as shown in Figure 2.4. Using this dialog box,

you can set up the recycling, performance, and health settings of the application pool. You can also

define the credentials under which the worker process associated with the application pool run.

3 [ 11S 5.0 isolation mode is a mechanism offered by 1IS 6.0 to emulate IIS 5.0 behavior
= E - # and operational architecture. SharePoint doesn’t support IS 6.0 running in IS 5.0

isolation mode (provided in IIS 6.0 for backward-compatibility) and can only work with I1S 6.0
configured in the worker process isolation mode.

One more level of protection that’s available to you for Web sites is to control the execute permis-
sions for Web site content. These options are available under the Home Directory tab in the Web
Site Properties dialog box, as shown in Figure 2.5:

B None: No Scripts (ASP, ASP.NET, etc.) or executables (.exe, .d11, etc.) can be run.

B Scripts Only: Only scripts can be run.

B Scripts and Executables: Both scripts and executables can be run.

FIGURE 2.4

The Recycling settings options in the MSSharePointAppPool Properties dialog box
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You use the execute permissions to determine the level of code execution that can be performed on
a Web site. These options provide an added level of security for Web sites so that unwanted con-
tent can’t run on the Web sites without proper configuration.

Web Service extensions

One more level of protection that IIS 6.0 offers is that it provides an interface to easily allow or
prohibit any known or unknown Web Service extension. Web Service Extensions is a generic
name for all Common Graphical Interface (CGI) and Internet Server Application Programming
Interface (ISAPI) applications that can be installed and configured on IIS. Common ISAPI applica-
tions are ASP.NET, FPSE, and SharePoint. As shown in Figure 2.6, you can easily allow or prohibit
Web Service extensions by using the IIS 6.0 interface.

11S 6.0 follows the locked-down configuration so that all ISAPI extensions must be manually
enabled before using them. Extensions such as WebDAV are disabled at the server level by default,
and you have to manually enable them by using the Web Service Extensions interface before they

can be used.

FIGURE 2.5

The Default Web Site (Stopped) Properties dialog box
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FIGURE 2.6

The Web Service Extensions Properties dialog box
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Installing and configuring 1S

You can install IIS 6.0 on a Windows 2003 server using the following steps. While you're installing
11S 6.0, these steps also guide you to install the FTP service and FPSE 2002 on the machine:

e You might be requested to provide the Windows 2003 or Windows 2003 Service
WSS Pack (SP) 1 installation media during the installation of 1IS 6.0.

1. Choose Start=> Control Panel=> Add or Remove Programs and then click Add/
Remove Windows Components. The Windows Components Wizard opens. Use this
wizard to install IIS with the FTP service and FPSE 2002.

2. Choose Application Server from the list of components and then click Details. The
Application Server dialog box opens.

3. Along with the options selected by default, ensure that the ASP.NET check box is
selected.

4.

Click Internet Information Services (IIS) and then click Details. The Internet
Information Services (IIS) dialog box, as shown in Figure 2.7, opens.
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5. Select the File Transfer Protocol (FTP) service and FrontPage 2002 Server
Extensions check boxes, including the options selected by default, and then click
OK twice to return to the Windows Components Wizard.

6. Click Next to allow the wizard to install the requested components.

FIGURE 2.7

The Internet Information Services dialog box
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After the setup is complete, the new Internet Information Services (11S) Manager shortcut appears
inside Start= Administrative Tools. The IIS administrative interface, as shown in Figure 2.8, is
called the Internet Information Services (IIS) Manager and is a snap-in added to the Microsoft
Management Console (MMC). You can also access the IS Manager by typing inetmgr in the
Start= Run dialog box. The console provides the interface to change Web server settings for IS,
create and manage Web sites and virtual directories, set up application pools, and perform other
management operations for the Web server.

Although the IIS Manager can be used to connect to the IIS Web Service running on any computer
(right-click on Internet Information Services in the left pane and then choose Connect from the
popup menu), it connects to the IIS Web Service running on your local computer by default. So,
when you open the IIS Manager on your Web server, it displays the list of application pools and
Web sites hosted by the local Web server in a treeview under the machine name.
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The Internet Information Services (11S) Manager
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You can enable the Web Service Extensions that you want to use on the Web server by clicking on
the Web Service Extensions folder in the left pane of the IIS Manager. Right-clicking on the
extension opens a popup menu that allows you to enable/disable the extension.

The All Unknown CGI Extensions and All Unknown ISAPI Extensions are prohibited
i for increasing the security and excluding unknown extensions from being run

on the Web server. You shouldn’t unnecessarily allow them. Instead, selectively allow the
extensions you want to use.

The master properties that affect all new Web sites and application pools for the Web sites (and
application pools) can be set by right-clicking on the Web Sites (and Application Pools)
folder in the left pane of the IIS Manager and then choosing Properties from the popup menu.
When you create a new Web site (or an application pool), these properties are copied to form the
properties of the newly created Web site (or application pool).

Setting up Web sites
To create a new Web site by using the IIS Manager, follow these steps:
1. Right-click on the Web Sites folder and then choose New=> Web Site from the
popup menu. The Web Site Creation Wizard, as shown in Figure 2.9, opens.
2. Click Next to start the wizard.

3. Type a name for your Web site in the Description text field in the Web Site
Description window and then click Next.
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8.

FIGURE 2.9

The Web Site Creation Wizard dialog box
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In the IP Address and Port Settings window, specify the IP address, port, or host
header that you want to use to identify the Web site. For example, for this exercise,
set the IP address to All Unassigned, change the port to 8000, and leave the host header
blank. This makes the server binding so that the Web site is accessible by using the
address http://servername:8000.

Click Next.

In the Web Site Home Directory window, specify the folder that you want to set as
the root folder for the Web site. You can use the Browse button to either choose the
location or create a new folder at the location of your choice. Keep the Allow anonymous
access to this Web site check box selected if you want to allow anonymous access to Web
sites.

Using the Web Site Access Permissions window, you can set the execute permis-
sions for the Web site. For this exercise, click the Read and Run Scripts (such as ASP)
check boxes.

Click Next and then click Finish to complete the creation of your Web site.

If your Web site’s server binding already exists — that is, if another Web site uses the IP address,
port, and host header combination you specified for your Web site — you receive a message indi-
cating that a Web site already exists. Although the Web site is created in such a case, it can't be
started until the server binding is unique.
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By default, the new Web site inherits the master properties configured for new Web sites by using
the IIS Manager. If you use the default master properties for Web sites, the new Web site is config-
ured to use the DefaultAppPool application pool (created by default during initial IIS configura-
tion). To create a new application pool and associate your Web site with the new application pool,
follow these steps:

1.

6.

Right-click on the Application Pools folder in the left page in IIS Manager and
then choose New > Application Pool from the popup menu. The Add New
Application Pool dialog box, as shown in Figure 2.10, opens.

FIGURE 2.10

The Add New Application Pool dialog box
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Using the Application Pool ID text field, type a name for the application pool. Using
the application pool settings, you can choose whether to use the master application pool
settings or use settings of an existing application pool for new application pool creation.

Click OK. The new application pool appears in the list of application pools under the
Application Pools folder. Click the new application pool, and the right pane in the
1IS Manager is empty. This indicates that the application pool doesn’t yet have a Web site
associated with it.

Right-click on the Web site you just created in the previous steps and then choose
Properties from the popup menu. The Properties dialog box for the new Web site
opens.

Click the Home Directory tab. In the Application Settings, click the Application pool
dropdown menu and then click the newly created application pool.

Click Apply and then click OK.

The newly created Web site appears in the right pane of the IIS Manager when you click the newly
created application pool. This list always shows all the Web sites that use the application pool. If
you right-click on the application pool on the left pane in the IIS Manager, you can start, stop,
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or recycle the application pool. Recycling the application pool is a process where the application
pool is restarted without actually causing the associated Web applications to stop working. I1S
does this by creating a new worker process for the application pool before terminating the existing
one. After the new worker process is created, all user requests are redirected to the new worker
process, and the old one is then terminated. This configuration helps in increasing the uptime for
the Web sites while the application pools remain healthy and badly used resources recovered.

You can specify recycling settings for an application pool by right-clicking on it and then choosing
Properties from the popup menu. The Properties dialog box allows you to perform these operations:

B Recycling: Provides the settings for configuring the recycling of worker processes associ-
ated with the application pool

B Performance: Offers the settings to enable CPU monitoring and Web gardening

B Health: Allows you to configure settings for rapid-fail protection for application pools.
Rapid-fail protection facilitates that the application pool can be disabled after it fails for a
particular number of times.

B Identity: Allows you to set up the user account that the worker process associated with
the application pool runs under

If you need to change the properties of a Web site itself, you can do so by using the Web Site
Properties dialog box (which you can open by right-clicking on the Web site and then choosing
Properties from the popup menu). Using the Web Site Properties dialog box, you can change these
settings:

B Web Site: Offers an interface to change the Web site’s server binding and enable IIS log-
ging for the Web site

B Performance: Allows you to set bandwidth throttling and change the number of allowed
Web site connections

B ISAPI Filters: Shows (and allows addition/removal of) the ISAPI filters that are active for
the Web site

B Home Directory: Allows you to change the Web site root folder location, set general
application settings, change application pools association, and set execute permissions for
the Web site

B Documents: Allows you to set a list of default documents for a Web site. If it exists in the
site content location, the top document in this list becomes the home page of the Web site.

B Directory Security: Allows you to change the authentication mechanisms that the Web
site uses, configure restrictions, and set up SSL

B HTTP Headers: Lists the custom HTTP headers and provides settings for content expira-
tion, rating, and MIME types
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B Custom Errors: Lists the default error messages that IIS shows when an issue occurs
while accessing a Web site. You can use this tab to change the default Web pages associ-
ated with the various IIS error codes.

B ASP.NET: Allows you to set the version of ASP.NET to be used for the Web site

B Server Extensions 2002: If the Web server is configured with FPSE 2002, this tab pro-
vides the mechanism to open the administration Web pages for configuring FPSE settings
related to the Web site.

Although you just created a Web site by using the IIS Manager, the Web site still isn’t completely
ready for SharePoint Designer because this Web site doesn’t have a publishing or remote authoring
mechanism set up for it. You can’t yet open or publish this site in SharePoint Designer with an
Internet-based HTTP address.

The best you can do as far as pushing Web content into this Web site is to copy the Web pages
and files you created with SharePoint Designer from your local root folder to the root folder of this
Web site. However, this isn’t a recommended method, especially when you're using FPSE features,
and it’s not applicable for SharePoint sites.

Investigating the Nature
of FTP and WebDAV Sites

File Transfer Protocol (FTP) is one of the most commonly used mechanisms for transferring Web
content from a machine where it’s developed (for example, a SharePoint Designer client machine)
to a location on the Web server. In a common scenario, an administrator might create an FTP site
whose content location is the same as a normal HTTP site. An author would then publish the con-
tent by using FTP as a communication mechanism between the client software (such as SharePoint
Designer) and the Web server (such as I1S). Although using the FTP approach might have some
security issues, it’s a very simple and standard way to move content to the Web server.

You have to install the FTP service by using the Add/Remove Programs function prior to creating
FTP Web sites in 1IS. To set up an FTP site in 1IS, follow these steps:

1. Open the IIS Manager by choosing Start=> Administrative Tools. If you have the FTP
service installed, an FTP Sites folder appears in the left pane in the Microsoft
Management Console.

2. Right-click on the FTP Sites folder and then choose New= FTP Site from the
popup menu. The FTP Site Creation Wizard, as shown in Figure 2.11, opens.
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FIGURE 2.11

The FTP Site Creation Wizard
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Click Next and then type the description for your FTP site in the Description text
field.

Click Next.

On the next screen, specify the IP address and port for use by the FTP site. When you
installed the FTP service, a default FTP site was created for you and uses port 21. If you want
to create a new FTP site, you can either specify a different IP address or a different port.

Click Next.

In the FTP User Isolation window, click Isolate users and then click Next. FTP User
Isolation Settings provides you with a mechanism that can be used to isolate FTP directo-
ries based on users. The Isolate Users option ensures that users can’t view directories that
they don’t have permissions to see and are directly taken to their folders and files within
the FTP site.

Specify the root folder location of your FTP site and then click Next.

In the FTP Access Permissions screen, keep the Read check box selected and then
click Next. You can change these settings later by using the Home Directory tab in the
FTP Site Properties dialog box.

Click Next and then click Finish.

I The FTP site you created stops if the IP address and port (server binding) being used
by the site is already being used by another site. You must change these settings to

be unique before you can use the FTP site.
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You can now create directories within the root content location of this Web site for various users
and set up permissions using the Security tab in the Folder Properties dialog box so that users are
directed only to the folders where they have permissions. Once the FTP site is set up, you can use
the Current Sessions button in the FTP Site tab of the site properties to determine the users that
are connected to your FTP site.

While FTP is a simple way to transfer files to a Web server, it has a number of security and man-
agement issues. IIS also supports another Web standard for remote authoring called WebDAV.
WebDAV adds on to the HTTP protocol (the main Internet communication protocol) and provides
features that allow client programs to list files and directories on a Web server, add and delete files
from a Web server, check-in or check-out files, etc. So, once a Web site is configured for WebDAV,
you can access it in a Windows Explorer—like view in a client program, such as Internet Explorer,
Firefox, Opera, etc. By default, in IIS 6.0, WebDAV is prohibited. So, in order to enable it for use
on an HTTP site, you have to follow these steps:

1. Open the IIS Manager and then click the Web Service Extensions folder in the
left pane, as shown in Figure 2.12. By default, WebDAYV is prohibited.

FIGURE 2.12

The Web Service Extension folder and its contents
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2. Click WebDAYV and then click Allow.

3. In the left pane in the IIS Manager, right-click on the Web site (or a folder inside
the Web site) that you want to configure for use as a WebDAYV site and then choose
Properties from the popup menu.

4. Click the Home Directory tab and then click the Write and Directory Browsing
check boxes.
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This is all you need to do to enable WebDAV on an 11S Web site (or folder). Based on the permis-
sions that you set on the Web site folders, users should be able to access and modify the site con-
tents in a folder-like view in a Web browser or SharePoint Designer.

Working with FPSE-Based Web Sites

FrontPage Server Extensions (FPSE) is one of the oldest publishing and remote-authoring mecha-
nisms offered for Web sites developed using FrontPage and Visual Studio. The current Microsoft-
supported versions of FPSE are:

B FPSE 2000, available as an IIS 5.1 component with Windows XP
B FPSE 2002, available as an IIS 6.0 component with Windows 2003

There’s also a version of FPSE 2002 for IIS 7.0 on Windows Vista machines supported
by RTR (Ready-to-Run) that’s available for download at www.rtr.com.

;

In cases of both Windows XP and Windows 2003, FPSE can be installed from the Add/Remove
Windows Components section in the Add or Remove Programs dialog box. As discussed earlier,
you can elect to install FPSE binaries and files as components while installing IIS on the machine.

Understanding FPSE

FPSE is an ISAPI-based authoring and publishing mechanism that provides the backbone for Web-
based clients (such as FrontPage, Expression Web, and SharePoint Designer) to open content from
remote Web sites for authoring and publishing content from one location to another. Besides
remote authoring and publishing, FPSE also enables features such as version control, permissions
management, etc., and provides support for a variety of Web components (such as Web search,
form-based components, hit counters, etc.) available in FrontPage and inherited by Expression
Web and SharePoint Designer.

11S 6.0 supports the most updated and robust version of FPSE (FPSE 2002), which provides a
Web-based site management and administration console. After you choose and install FPSE 2002
as a component with 11S 6.0, a Web site called Microsoft SharePoint Administration is created for
you and is used to administer FPSE 2002 Web sites on the Web server.

Don’t be confused by the naming of Microsoft SharePoint Administration for this
= Web site. It’s so called because if SharePoint Team Services (STS) is installed on the
machine, this Web site provides an interface for the administration of STS Web sites along with
serving as an administration tool for FPSE 2002 Web sites.

If you open the properties of this Web site using the 11S Manager, the important thing to notice (in
the Home Directory tab) is that this Web site uses C: \Program Files\Common Files\
Microsoft Shared\Web Server Extensions\50\ISAPI\_VTI_ADM as the root folder. All
the FPSE 2002 binaries and support files are stored at C: \Program Files\Common Files\
Microsoft Shared\Web Server Extensions\50.
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Also, it has the execute permissions set to Scripts and Executables (allowing for the execution of
.d11 and . exe) and uses a new application pool called MSSharePointAppPool. This application
pool is also created when FPSE 2002 is installed on a machine.

Before you can use FPSE 2002 on your Web sites, you must ensure that it’s enabled as a Web
Service extension in 1IS. You can do this by using the Web Service Extensions pane in the I1S
Manager. If the status of FPSE 2002 shows as being prohibited, simply right-click on it and then
choose Allow from the popup menu to enable it for use.

Extending and configuring Web sites

To perform many of the FPSE 2002 configuration and management operations, you must be an
administrator on the Web server machine. You use the Microsoft SharePoint Administration Web
site for configuring Web sites in IIS with FPSE 2002. The main Web page of the Microsoft
SharePoint Administration Web site, as shown in Figure 2.13, shows the list of Web sites and indi-
cates whether they're configured with FPSE 2002.

FIGURE 2.13

The Microsoft SharePoint Administration home page
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far a virtual server, click the virtual server name. To specify configuration settings for a wirtual

server, click Administration. To Extend FrontPage Server Extensions 2002 to a virtual server,
click Extend. To upgrade to the latest version of FrontPage Server Extensions 2002, click

Upgrade.

Mame LRL Wersion

Default web Site http:/#SPDExplorer 5.0.2.6790 Administration
Office Server Web Services Extend
SharePoint - 8000 Extend
SharePoint - 48426 Extend

SPD Sites http: A#SPDExplorer:8009 5.0.2.6790 Administration
\SJ;arernt Central Administration Extend
SharePoint - 80 Extend
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The process of configuring FPSE 2002 on a Web site is called extending a Web site. To extend a
Web site with FPSE 2002, follow these steps:

1. Using the IIS Manager, create a new Web site. Ensure that the root folder for the Web
site is empty. While creating a root folder for an FPSE 2002-based Web site, keep in
mind that FPSE 2002 itself manages permissions for users and groups. It’s best that you
use the FPSE 2002 administration Web site to add or remove users and groups rather
than directly managing them by using Windows Explorer (via the Security tab). To start
with, when you create the root folder, ensure that the folder doesn’t inherit permissions
from its parent folder, and set Administrators and System accounts to have full control.

2. In the IIS Manager, right-click on the Web site and then choose All
Tasks ™ Configure Server Extensions 2002 from the popup menu. This takes you to
the Extend virtual server with the FPSE 2002 Web page inside the Microsoft SharePoint
Administration Web site. You can also reach this page by clicking the Extend link next to
the Web site on the home page of the Microsoft SharePoint Administration Web site.

= The Configure Server Extensions 2002 option isn’t enabled if you already have the
S Web site extended with FPSE 2002 or if the root folder of the Web site contains
hidden metadata.

3. Ensure that the Administrator user name is correct and then click Submit. This
begins the process of extending the Web site, and once complete, you return to the home
page of the Microsoft SharePoint Administration Web site. The URL and Version columns
are updated with the URL of the Web site and the version of FPSE 2002 on the Web site.
Also, the Extend link has now changed to Administration.

If you go to the root folder of the Web site (by right-clicking on it in the IIS Manager and then
choosing Open from the popup menu) after it has been extended with FPSE 2002, a number
of _vti folders now exist inside the Web site. These folders contain files that store the hidden
metadata necessary for operating FPSE 2002.

B These folders are important for the proper operation of FPSE 2002 on the Web site.
% Deleting any of these folders can result in the corruption of FPSE 2002.

Also, if you expand the Web site in the IIS Manager, the _vti_bin virtual directory appears, with
the root folder at C: \Program Files\Common Files\Microsoft Shared\Web Server
Extensions\50\ISAPI. This virtual directory contains the binary files that enable the remote
authoring and publishing features of FPSE 2002 on the Web site. It exists in every site or subsite
(also called subweb) that’s configured to be an FPSE 2002 Web site.

B A virtual directory is a virtual folder inside a Web site, the content of which doesn’t
S5 reside inside the root folder of the Web site. You use virtual directories to share
files and folders across multiple Web sites.

By default, the virtual directory uses the same application pool as the Microsoft SharePoint
Administration Web site (MSSharePointAppPool) and has the execute permissions set to Scripts
and Executables. If this virtual directory is missing or isn’t set up properly, FPSE 2002 authoring
and publishing features can’t work.
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Now that you have FPSE 2002 set up for your Web site, you can use SharePoint Designer to open
the Web site for live editing of Web pages and other files, use FPSE 2002-based Web components,
and publish content to and from the Web site. To open your FPSE 2002—based Web site in
SharePoint Designer, simply choose File=> Open Site and then type the URL of the Web site in

the site name text field. Your best bet for the Web site’s correct URL would be the URL indicated
in the URL column for the Web site in the home page of the Microsoft SharePoint Administration
Web site.

Managing and administrating sites

After you extend your Web site with FPSE 2002, you need to set some configuration settings to
provide functionality to Web components that you insert on pages by using SharePoint Designer.
Most of these configuration settings can be done using the Microsoft SharePoint Administration
Web site, although FPSE 2002 offers a command-line tool called owsadm. exe — mostly used
for performing bulk operations on a number of Web sites using batch files — to perform these
operations.

Change configuration settings

Some configuration settings for FPSE 2002 that you make using the Microsoft SharePoint
Administration Web site apply to all the Web sites that are extended with FPSE 2002 on the Web
server. These settings include the list of available rights and installation defaults for FPSE 2002 and
are available at the home page of the Microsoft SharePoint Administration Web site.

Besides these, several settings apply specifically to Web sites. You can access these by clicking on
the Administration link next to the Web site in the home page of the Microsoft SharePoint
Administration Web site. Using the Virtual Server Administration page, you can perform these
operations:

B Visit the Web site-specific administration pages: Using these administration pages,
you can add or remove users and roles, perform server health checks, and create
subwebs.

B Uninstall FPSE 2002: You can choose to either completely remove FPSE 2002 or just
remove the binaries from the Web site. As indicated in the description text, a full uninstall
removes all virtual directories, subweb information, hidden metadata files, and folders.

B Upgrade the virtual server with FPSE 2002: This allows you to perform an upgrade of
the hidden metadata of the Web site in case an update or service pack updates the FPSE
2002 binaries.

B Change the configuration settings: As shown in Figure 2.14, these settings allow you to
set up the SMTP mail server settings for use by the FrontPage form components, enable
or disable authoring, log authoring actions, etc.

B Configure user accounts limits: This allows you to set a limit to the number of users
that can be created via the FPSE 2002 user management console.

47



m Understanding the Technologies

FIGURE 2.14

The Change Configuration Settings Web page

FrontPage Server Extensions 2002
Change Configuration Settings

Use this page to configure general settings for your server

Enable Authoring

¥ Enable autharing
Specify whether to allow authoring on this server.

Mail Settings SMTP mail server:
Specify the SMTP mail server to uss for FrontPage Ssrver Extensions 2002 s-mail- B
based features, such as subscriptions and invitations, Personalize the from and

reply-to addresses, and select the mail encoding scheme and character setto use.  rron sddress:

|5@s com
Reply-to address:

Ia@s com

Mail encading:

Use default encading =

Character set:

use default character set =

Performance Tuning Tune for:

Use these settings to tune the perfarmance of your Web site. Select the size of the Custom -
web in the Tune for box. Default values are entered in the Tuning properties ) .
area. Modify these values as needed. Tuning properties

In-memary documnent cache:

[ documents

Adding users and roles

FPSE 2002 allows you to add or remove users and groups by using the Microsoft SharePoint
Administration Web site and manages the actual New Technology File System (NTFS) (folder and
file level) security and permissions for the users and groups itself.

It does so by managing roles for users and groups. A role is a list of rights and privileges that are
given to the members of the role. For example, the Administrator role has a list of rights that allow
its members to view, add, and change all server content and manage server settings and accounts.

Using the Manage Roles Web page, as shown in Figure 2.15, you can view the roles available by
default and add/remove roles.

FIGURE 2.15

The Manage Roles Web page

FrontPage Server Extensions 2002 - Site Administration for “http: /fspdexplorer:8009"
Manage Roles

Use this page ta add new roles, delsts roles, or change a role's description and rights. The fallowing rales ars available on this Web site. To
edit a role, dlick the rols name in the list.

#4dd a role | ¥ Delete selected role(s)

Rals Description
T Administrator View, add, and change all server content; manage server settings and accounts.
[T Advanced suthor  Miew, add, and change pages, documents, themes, and borders; recalculate hyperlinks,
T Author view, add, and change pages and documents.
T cContributor View pages and documents, view and contribute to discussions.
[T Browser View pages and docurnents,
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To access the Manage Roles administration Web page, click the link that’s the name of the Web site in
the Microsoft SharePoint Administration Web site home page. This takes you directly to the site-specific
administration pages, where you can use the Manage Roles link in the Users and Roles section.

After the roles are created, you can add users and groups to these roles by using the Manage Users
Web page accessible from the Users and Roles section.

When you add a user (or group) to a specific role by using the FPSE 2002
administration Web site, FPSE 2002 in the background creates a local security group
(W|th the prefix ows_) and adds the user (or group) to the local group. FPSE 2002 then adds

this local group with appropriate permissions to the NTFS Access Control Lists (ACL) of the Web
site folders.

FPSE 2002 stores the roles and permissions associated with the roles in files called roles.ini at
C:\Documents and Settings\All Users\Application Data\Microsoft\Web
Server Extensions\50. These files are used to reapply the security settings to FPSE 2002 Web
sites in operations such as checking a server’s health.

Checking a server’s health

The Check Server Health Web page, as shown in Figure 2.16, is a single operation that can be used
on FPSE 2002 Web sites to detect and repair problems with security; reapply security settings
stored in roles. ini files; and check, verify, and repair FPSE 2002 on subsites inside a Web site.
It can also be used to re-create any missing _vti_bin directories, provided that the hidden meta-
data for the Web site is intact.

It’s important to understand that the Check Server Health operation removes all

: % existing NTFS security on the Web site’s folders and files and reapplies the security
settings stored in the roles. ini files. So, if you've added any users (or groups) directly to the
NTFS security by using Windows Explorer (or other means), these permissions are lost.
Therefore, it’s recommended that you perform all security operations on FPSE 2002 Web sites by
using the Microsoft SharePoint Administration Web site so that they’re saved in the roles.ini
files for repair.

FIGURE 2.16

The Check Server Health Web page

FrontPage Server Extensions 2002 - Site Administration for "http://spdexplarer:20092"
Check Server Health
Use this page to detect and repair potential problems on your Web server.
Detect and Repair Select the actions to perform:
Choase which areas of server health to detect possible problems in,  FeaPPIY file security settings D3 Repair
and whether to repair any problems found Wity oo o eks W Dstsct [ Repair

Check roles configuration W Detect [~ Repair

Tighten security ¥ Detect [© Repair

Check anonymous access W Detect

0k Cancel
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Introducing WSS and MOSS Technologies

The current version of SharePoint (including WSS v3 and MOSS) is the third generation of office
document management, collaboration, and publishing products offered by Microsoft. As discussed
earlier, this lineage started with SharePoint Team Services (supported by FPSE 2002) offered with
Office XP and has now grown into a robust, scalable, and extendable platform for Web-based
application development for intranet, extranet, and Internet scenarios.

Out-of-the-box installation of SharePoint provides for a large number of features that can be con-
figured and used just as they are or exploited by application developers for custom implementation
and business logic architecture.

Comparing WSS and MOSS offerings

When choosing between WSS and MOSS, know that WSS is freely downloadable on Microsoft’s
Web site (www.microsoft.com/downloads). MOSS relies on the infrastructure that WSS pro-
vides for SharePoint sites, so that when you install MOSS, the setup program first installs WSS by
itself on the machine.

However, while WSS only provides you with basic collaboration features, MOSS offers a more
complete collaboration and publishing feature set and includes advanced functionality for enter-
prise-level implementation. These features include user profiles and personal sites; audience target-
ing; advanced search capabilities; and add-on services, such as Excel Services, Form Services, and
Business Data Catalogs.

Understanding basic SharePoint
site interface, layout, and settings

Although discussion about the detailed setup, configuration, and architecture of SharePoint (WSS
v3 and MOSS) is beyond the scope of this book, keep in mind the following about SharePoint
configuration:

B The SharePoint server farm consists of one or more Web Front End Web servers (WFEs),
one or more application servers (servers that provide indexing, search services, and offer
various SharePoint features, such as user profiles, My Sites, Excel Services, Form Services,
etc.), and one or more database servers.

B The SharePoint setup is a two-step process. First, you use the setup executable to install
the SharePoint binaries and supporting files. Then, you use the SharePoint Configuration
Wizard to set up the SharePoint farm settings, secure resources, and create the configura-
tion database and provisions for the SharePoint Central Administration Web site.

B Like the FPSE 2002 Microsoft SharePoint Administration Web site, the SharePoint
Central Administration Web site serves as the operations and application management
console for SharePoint. You can use this Web site to create Web applications, site collec-
tions, etc., and configure settings for all SharePoint features.
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B Unlike non-SharePoint sites, SharePoint stores most of the Web site content (including
content of Web pages, list and document library data, pictures, etc.) in the SQL Server
database. Only shared templates and supporting files are stored in the file system.

In this section, I take you through the steps to set up WSS v3 in a single-server farm environment
on a Windows 2003 server and create a Web application and a site collection. Later, I discuss the
interface of a SharePoint site to familiarize you with the key components that later help you in cus-
tomizing SharePoint Designer.

Setting up WSS v3 on a Web server

WSS v3 is available for download on the Microsoft Web site at www.microsoft.com/
downloads. The setup for WSS v3 includes the installation files for SQL Server 2005 Express
edition, which is used as the database back end for a single-server basic installation. You need to
be an administrator to successfully install and configure WSS v3 on a Web server. Along with that,
you need to ensure that IIS 6.0 is installed and running in the worker process isolation mode.

The one-click installation of WSS v3 is fairly simple and requires no specific user input except
clicking on the setup executable and then clicking the Basic installation radio button. Once the
setup is complete, the SharePoint Configuration Wizard automatically runs to provision the
SharePoint Central Administration Web site. You perform all the SharePoint server-level Web
application and operations management by using the Central Administration Web site, as shown in
Figure 2.17.

The setup also installs the SQL Server 2005 Express edition and uses it as the default database
server for WSS v3.

FIGURE 2.17

The SharePoint Central Administration Web site

Central Administr ation Welcome System Account = | My Ste | My Links = | @
}‘% Central Administration

Home  Operstions | Application Management

Central Administration = Application Management

Application Management

Server Farm
? Configuration ¢
Not Complete

This page cantains links to pages that help you configure settings for applications and companents that are installed an the server or server Farm,

SharePoint Web Application Management Office SharePoint Server Shared Services
See administrator tash st . A .
ez tocias & Creste or extend Wb application a Create or configure this Farm's shared services
8 Remove SharePoint from 115 Web site. 8 Grant or configure shared services between Farms.
Wiewr Al Site Content o Delete Weh application a Check services enabled in this Farm
Central o o
e tration Define managed paths Configure session state

perati & Web applcation outgoing s-mail settings
= Operations - -
. 8 Wb spplcation gensral ssttings Application Security
= Application

Management @ Cantent databases a Security for Weh Part pages

@ Maniage Web applcation Features

shared Services a Self-service site management

Administration @ Wb application list @ User permissions for Web application
= Sharedservicesl a Folicy for Web application
- e e 8 Authentication providsrs
& Recycle Bin

8 Create site callection

a Delete sie collection Search

8 Sike use confimation and deletian a Manage search service
8 Quota templates

8 Site callection quatas and locks Workflow Management

a Site collection administrators a Worklow sektings
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Create a SharePoint Web application

After you install and configure WSS v3, you can use the SharePoint Central administration Web
site to create a SharePoint Web application by using these steps:
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1.

2.

5.

Choose Start=> Administrative Tools=> SharePoint Central Administration to open
the SharePoint Central Administration Web site.

Click the Application Management tab. The Application management Web page opens,
allowing you to perform a number of operations related to Web application management.

Click Create or Extend Web Application. The Create or Extend Web Application dia-
log box opens.

Click Create New Web Application. The Create New Web Application Web page, as
shown in Figure 2.18, opens, allowing you to create a new IIS Web site for the

SharePoint Web application, create an application pool for the Web site, and define secu-
rity configurations for the Web site.

FIGURE 2.18

The Create New Web Application Web page

Central Administration > Application Management = Create or Extend Web Application > Create New Web application

Create New Web Application

Use this page to create a new Windows SharePoint Services 'Web application, Learn about creating or extending Web applications.

warning: this page is not encrypted for secure communication. User names, passwords, and any other information will be sent in clear text.

For more infarmation, contact your adrinistrator.
Ok Cancel

115 Web Site

€ Use an existing 115 web site
Choose between using an existing 115 web site or create a new one to serve the

Windows SharePaint Services application, |M|crusuft SharePoint Administration =
IF you select an existing II5 web site, that web site must exist on all servers in the Farm @& Create a new I15 weh site
and have the same description, or this action will not succeed. Description
IF wou opt o create a new 115 web site, it will be automatically created on all servers in |MyF|rstSharePUmtS|te
the Farm. If an IIS setting that vou wish to change is not shown here, vou can use this
option to create the basic site, then update it using the standard II5 tools, Part
|s000

Hast Header

Path

|C:\Instpub\wwwruut\wss\Vlrtua\Dlrsct

Security Configuration

Kerheros is the rerommended securiy configuration to Use with Tntegrated YWindows Authentication provider:
authertication. kKerberos requires the spplication pool account ko be Netwark Service
or special configuration by the domain administrator, WTLM authentication will work € Negatiate (Kerberas)

with any application pool account and the default domain configuration.

& NTLM

Type the name of the SharePoint Web application in the Description text field and
then use the Port, Host Header, and Path text fields to specify a TCP/IP port, host
header, and root folder for the Web application.

Use the default settings for the Security Configuration and the Load Balanced URL
section.
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7. In the Application Pool section, create a new application pool for the Web applica-
tion, type the name for the application pool in the Application Pool name text field,
and then use the username and password text fields to set the credentials that the
application pool will run as.

8. Keep the defaults for the Database Name and Authentication sections.
9. Click OK.

When the Web application setup is complete, the new Web site and application pool are now
listed in the IIS Manager. Also, the newly created SharePoint Web application is shown in the Web

Application List available in the Application Management tab of the SharePoint Central
Administration Web site.

Creating a site collection in the SharePoint Web application
After the SharePoint Web application is set up, you need to create a root site collection in the Web

application. Simply put, a site collection is a set of SharePoint Web sites, features, and permissions
that’s centrally managed at the site collection level. You can create a site collection using these steps:

1. In the Application Management tab in the SharePoint Central Administration Web
site, click Create Site Collection. The Create Site Collection page, as shown in Figure

2.19, opens, allowing you to set some general settings and choose a site template for use
for the root site collection SharePoint site.

FIGURE 2.19

The Create Site Collection Web page

Central Administration > Application Management > Create Site Collection

Create Site Collection

Use this page to create a new top-level Web site,

oK Cancel

Web Application ‘b Application: | https//spdexplorer/ ~
Select a Web application,

Title and Description Tile:

Type s ttle and description For your new site. The tite wil be dsplayed on

My SiteCollection
each page in the site, frar

Description:

=
I |

web site Address URL:

Speafy the URL name and URL path to create  new site, o choose ko create httos/ fspdespl i
& site ak & specific path. p://spdenplorer[/sites/ =l

Ta add a new URL Path go to the Define Managed Paths page,

2. Ensure that the Web Application dropdown menu shows the Web application in
which you want to create the site collection. If not, you can change the Web applica-
tion by using the Change Web Application option.

3. Type a title and description for the site collection.
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Using the Web Site Address section, specify the URL for the site collection. Click /

in the dropdown menu if you want to create the site collection at the root path of the
Web application.

Click the site template to use for the site collection by using the Select a template
list. For this exercise, choose the Team Site template.

Specify the site administrator’s username in the User Name text field in the Primary
Site Collection Administrator text field.

Use the defaults for the Quota Template section.
Click OK.

When your site collection is created, you can browse to the root site of the site collection by using
the URL specified in the previous steps.

To be able to intelligently modify and develop SharePoint sites with SharePoint Designer, you need
to understand some key components of a SharePoint Web page. The interface for a WSS v3 site
based on the Team Site template is shown in Figure 2.20.

FIGURE 2.20

A SharePoint site based on the Team Site template

Team Site:

il Team Site

Home

views All Sike Content
Documents

= Shared Documents
Lists

= Calendar

® Tasks
Discussions

= Team Discussion
Sites

People and Groups

5] Recycle Bin

tWelcnme System Account v | My Site | My Links + | (@)

This Site: Team Site - £

Site Actions -
Anno A
Get Started with Windows SharePoint Services! ! rew 6/15/2008 2:12 P [ 'U
by System Account I " 7
Microsoft Windows SharePaint Services helps you to be more effective by connecting peaple, infarmation, “w"“’;.' dows
and documents. For information on gstting started, see Help, 1 ¥ :
SharePoint Services
@ Add new announcement
Links -

Calendar R

There are currently n upcaming events. To add a new svent, click “Add new event” below.

& Add new event link" below.

There are currently no Favarite links to
display. Ta add a new link, dick"Add new

= Add new link

The layout of the default page of the SharePoint site based on the Team Site template consists of
some key elements:
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Toward the top-left corner of the Web page is a tab-based link bar (or navigation bar) that
has the links to the Web sites inside the site collection. While creating new Web sites inside
the site collection, you have the option to add the link for the Web site in this Top Link bar.
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B In the same horizontal pane, toward the right, is the Site Actions dropdown menu. This
menu allows you to navigate to Web pages to allow you to create new content and
change site settings. For sites using the Collaboration or Publishing templates (available
with MOSS), the list of menu options in the Site Actions dropdown changes.

W Just above the Site Actions menu is the search box Web part that includes a scopes
dropdown.

B On the left of the Web page is the Quick Launch bar that, among other selections, has the
links to the lists and document libraries. You have the option to add links to this bar
while creating lists, document libraries, and other SharePoint content.

B In the main content region of the Web page is a set of Web parts that provide views for
various lists (Announcement, Calendar, Links, etc.). An image Web part that shows the
Windows SharePoint Services logo is also there.

Choose Site Actions=> Edit Page to see the edit mode view of the Web page. This view allows you
to add or remove Web parts. Also, this Web page has two Web part zones: Left and Right. Based
on the template being used to create the site, the layout changes.

SharePoint 3.0 (WSS v3 and MOSS) follows the concept of context-based security
% trimming. Thus, all menus and interfaces that SharePoint sites expose are shown
only if you have the required permissions to see and use them.

To add a Web part to the Web page by using the browser interface, simply click Add Web Parts.
The Add Web Parts Web page dialog box opens, allowing you to choose from a list of Web parts
available from WSS v3. Again, this list changes if you have MOSS installed or if there are any cus-
tom Web parts installed on the WFE. Clicking on the Advanced Web Part gallery and options link
opens the Add Web Parts task pane in the right corner of the Web page. Here, you can search Web
part galleries, choose Web parts, and add them to the Web part zone of your choice.

You exit the edit mode view by clicking on the Exit Edit Mode link just below the Site Actions menu.

Working with SharePoint sites and site collections

Choose Site Actions= Site Settings to open the Site Settings page for the site collection, as shown
in Figure 2.21. You use this page to make general settings for the site collection:

B Users and Permissions: The settings in this section allow you to set up the permissions
for the site collection. You can use these settings to add or remove users and groups and
specily site collection administrators.

B Look and Feel: Most of the settings in this section are useful while working with
SharePoint Designer on the Web site. These settings allow you to change the site’s theme,
change settings for the Top Link bar and the Quick Launch bar, and save the SharePoint
site as a template. You use these settings in later chapters, along with SharePoint Designer
features, to change the look and feel of the site.
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B Galleries: This lists the various SharePoint content galleries, such as Master Pages,
Content Types, Site Columns, Web Parts, etc.

B Site Administration: The settings in this section allow you to view and set SharePoint
settings for alerts, Really Simple Syndication (RSS), and site usage reports. This section
also allows you to create new sites and workspaces.

B Site Collection Administration: As the name indicates, the settings in this section apply
at the site collection level and provide configuration settings for the SharePoint recycle
bin, audit log reports, site collection features, etc.

FIGURE 2.21

The Site Settings Web page

Callaboration Root > Site Settings

Site Settings

Site Information

Site URL: http:/fnin20030ne: 9001

Mobile Site URL: http:/fwin20030ne: 5001_layouts/mobiefdefault.aspx

wersion: 12.0.0.6315
Users and Permissions Lok and Feel Galleries Site Administration Site Collection Administration
a Pecple and groups 8 Master page o Site content types a Regional settings 8 Search settings

a Ste collection & Title, description, andicon @ Site colmns a Ste libraries and lists a Search scopes

adminstystors o Navigation o Site templates a Site usage reparts a Search keynords
@ Advanced perissions & Page layouts and site 8 List templates a User alerts a Recycle bin
templates a tiieb Parts a Rss a Site directory settings

8 telcome page

@ Workflows @ search vishbilty @ Site collection usage reports
o Tree view 8 Master pages and page a Sites and workspares a Site collertion features
8 Site theme layouts a Site Features a Site hierarchy
& Reset to site definition a Delets this site a Portal sive connection
@ Searchable colunins 8 Related Links scope o Site collection audit settings
settings

a dudit log reperts

= Site output cache a site collection policies

a
Content and structure a Site collection output cache
a
Content and structure 1095 o gy colection cache profles
8 Site collection object cache:

a Yariations

To create new sites inside the site collection, you can click Sites and Workspaces in the Site
Administration section of the Site Settings Web page. You can also follow these steps to create new
sites inside the site collection:

1. Choose Site Actions= Create. The Create Web page, as shown in Figure 2.22, opens,
providing a consolidated interface for creating SharePoint content of many types. You can
create custom lists, document libraries, and Web pages and sites.

2. Click Sites and Workspaces in the Web Pages section. The New SharePoint Site Web
page opens.
3. Type the Title and Description as well as the URL for the new Web site.

4. Click the site template for the SharePoint site by using the Select a Template list in
the Template Selection section.
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5. Using the Navigation and Navigation Inheritance sections, specify whether you
want to add the site to the Top Link bar and the Quick Launch bar.

6. Click Create.

You can also create SharePoint sites by using templates provided by SharePoint in SharePoint
Designer by choosing File = New. However, SharePoint Designer doesn’t allow you to create site
collections. After you create a SharePoint site or site collection, you can open the site in SharePoint
Designer for customization either by using SharePoint Designer’s File = Open Site dialog box or

simply by browsing to the Web site in Internet Explorer (IE 6.0 and later) and using the IE menu
option at File=> Edit with SharePoint Designer.

FIGURE 2.22

The Create Web page

SPDExplorer = Create

Create

sites and Workspaces

Create a site or workspace when you want a new place for collaboration,
communication, or content storage, For example, you might create a team site to worl
together on a new project, a blag site to post information and gather feedback, or a
wili site to record unstructured knowledge.

=i
it

Libraries Communications Tracking Custom Lists Web Pages
8 Announcements 8 Links 8 Custom List @ Basic Page
B Farm Library o Conkacts 8 Calendar B Custom List in Datashest a wWeh Part Page
Wi
B Wiki Page Library ® Discussion Board B Tasks = o Sites and Workspaces
o (] dsheet
® Picture Library ® Project Tasks fport Spresshes

B Issue Tracking

B Survey

Using SharePoint lists and libraries

You can also choose Site Actions=> Create to create SharePoint lists and libraries. A list in
SharePoint is a container that allows you to store data and records in a flexible manner. A record
inside a SharePoint list is called a list item. Lists provide the infrastructure to maintain list items in
the form of views that can be used to view the list items and forms that can be used to add, edit,
and delete list items. You can create new list views by using the SharePoint interface and then cus-
tomize the list forms by using SharePoint Designer.

=1 For more on creating custom list forms, see Chapter 17.
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FIGURE 2.23

Document libraries (form libraries, picture libraries, slides libraries, etc.) are special lists that can
be used to store content (documents, pictures, and forms) and provide features for management of
such content. They also provide special views that show the content they store in a more compre-
hensible manner.

Every SharePoint list (or library) has a set of actions and settings available for it. These actions are
accessible by using the Actions menu in the list (or library) views. Figure 2.23 shows the Actions
menu for the My Pictures library.

The actions available might change depending on the list (or library) you're working with. Libraries
also have an Upload menu that can be used to upload one or more items. The Settings menu
allows you to access the settings for the list (or library) so you can set permissions and manage
advanced settings, including versioning, RSS, and workflows. You can also use the Settings menu
to create new columns and views for the list (or library).

SharePoint 3.0 supports item-level permissions, which can be set by using the
Actions menu, which you access by clicking on the item inside a list view.

The My Pictures library Actions menu
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Using SharePoint Web parts

A SharePoint Web part is a Web user control that can be used to perform specific operations on
SharePoint sites. SharePoint out of the box offers a number of Web parts that are available in the
site’s Web Parts Gallery. SharePoint application developers can use the SharePoint object model to
create new Web parts and deploy them for use in SharePoint, thus providing custom Web parts to
the site’s users.

You can add Web parts to a SharePoint Web page in its edit mode by using the Add Web Parts
interface. Also, you can use the edit mode to delete, close Web parts, and set up Web part connec-
tions. SharePoint Designer offers the interface to add Web parts and Web part zones to Web pages.
It also allows you to change properties for Web parts.

CROSS-R

| For more on Web part modifications, see Chapter 11.

Summary

In this chapter, I discussed a number of technologies and software that form the server-side piece
to the SharePoint Designer authoring framework. You learned about the basic 1IS user interface
and settings for Web, FTP, and WebDAV sites. You also set up and configured FPSE and
SharePoint sites on IIS Web sites. Understanding these technologies should help you when I dis-
cuss remote authoring and publishing to such sites in SharePoint Designer.
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hile the process of opening Web sites, live editing of Web pages,

or publishing Web content in SharePoint Designer looks simple

and straightforward on the surface, these procedures are quite
complex, and a lot of client-server communication technologies are
employed to accomplish even the most basic of operations. It’s important as
a Web site designer that you have some understanding of these underlying
client-server communication protocols and technologies so that you can
diagnose and troubleshoot problems associated with content authoring in
SharePoint Designer. In this chapter, I introduce you to some of the key
underlying communication protocols that SharePoint Designer uses for its
site authoring and management operations. I also explain how some of the
Windows (OS) components are used by SharePoint Designer to allow for its
remote authoring and publishing features. Finally, I discuss some remote-
authoring protocols and technologies that provide the foundation for
SharePoint Designer capabilities of working with FPSE and SharePoint sites.

Throughout this chapter, you capture the client-server communication
between SharePoint Designer and the Web server hosting the Web site con-
tent to develop understanding on the background processes and mecha-
nisms used. Before I begin, I want to familiarize you with the Fiddler tool,
which I use for capturing client-server communication.

Fiddler is a proxy-based HTTP debugging tool that allows you to capture
HTTP (or HTTPS for HTTP over a secure socket) traffic originating from and
finishing at a machine where Fiddler is installed and run. It provides an intu-
itive user interface that can be used to easily capture and understand HTTP-
based communication.

The latest release of Fiddler at the time of this writing is Fiddler 2 and is available
for download at www . £iddler2 . com. The setup requirements, installation
steps, and basic operations guide for Fiddler are also available at this Web site.
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To better understand how to use Fiddler, the following steps help capture the client-server traffic
that occurs when you open a WSS v3 team site in Internet Explorer. To reduce the captured traffic,
ensure that all Web browsers and other Web-based applications installed on your computer are
closed before you begin these steps. Also, ensure you have downloaded and installed Fiddler 2
before doing the following:
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1.

Open the Fiddler tool by choosing Start=> All Programs = Fiddler. If no Web-based
programs already run on your machine, the left Web Sessions pane in Fiddler just shows
a request to the Fiddler Web site (indicated in red).

Choose Edit= Remove = All Sessions to clear the Web Sessions pane.

While keeping Fiddler running, open Internet Explorer (or any other Web browser,
such as Firefox, Opera, etc.) and then browse to a WSS v3 Web site based on the
Team Site template.

T For more on Web site templates, see Chapters 2 and 4.

After the default page of the Web site displays in the browser, switch back to the
Fiddler tool. The Web Sessions pane in Fiddler is now filled with rows of HTTP sessions.

Choose File= Capture Traffic (or press F12) to direct Fiddler to stop capturing
HTTP traffic. A Web session in Fiddler is basically composed of two components: an
HTTP request from the client machine for a resource (such as a Web page, style sheet,
picture, JavaScript, etc.) and the HTTP response from the server machine for the request.
As shown in Figure 3.1, the Result column in the Web Sessions pane shows the HTTP
response code for the request, the Host column shows the Web site URL, and the URL
column shows the relative URL of the resource being requested.

In the list of captured Web sessions, find the one where the Result column shows
200 and the URL column shows /default.aspx. The result 200 here implies a suc-
cessful Web server response. This Web session corresponds to the request for the default
Web page of the WSS v3 site you opened in IE in the previous step and the response
from the SharePoint Web server for it.

Double-click the Web session to activate the Session Inspector tab on the right pane
of Fiddler. You use the Session Inspector tab to see the actual text of the HTTP request
and the HTTP response associated with the Web session. The top window in the Session
Inspector shows the HTTP request, and the bottom window shows the HTTP response.

On the menu inside the Session Inspector window, click the Raw button to view the
raw HTTP request and the response associated with the Web session. The top win-
dow of the Session Inspector shows the request to GET (an HTTP verb) the default.
aspx page by using the HTTP 1.1 Web protocol. The request also includes a number of
HTTP headers (User-Agent, Authorization, Set-Cookie, etc.) that the Web
server uses to identify the Web browser, retrieve the user credentials for authentication,
and perform other operations.
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FIGURE 3.1

A Fiddler capture while opening the default page of a SharePoint site
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The bottom window shows the HTTP response from the Web server. In the previous exercise, the
server responded with an HTTP 200 OK response (indicating that the request was properly
authenticated and processed), some HTTP response headers, and the complete HTML code of the
default.aspx Web page (obtained by the server-side processing of the ASP.NET code of the
Web page) that’s actually interpreted and displayed by a Web browser.

While the previous steps should help in understanding how to use the Fiddler tool to capture
HTTP traffic, I use this tool later in this chapter to help you understand the internals of SharePoint
authoring in SharePoint Designer.

Understanding the Basics
of Remote Authoring

In this section, you learn some of the basic components that form the foundation of the remote-
authoring features of SharePoint Designer. It’s important to understand that remote authoring (or
live editing) is not a SharePoint Designer—only feature. SharePoint Designer is mostly an intelligent
consumer of the remote-authoring technologies provided by the client computer on which it’s
installed and the Web server computer where the remote Web site resides.
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FIGURE 3.2

Client: the SharePoint Designer machine

From a user’s perspective, SharePoint Designer is all you need on the client machine to be able to
edit (or publish to) remote Web sites and SharePoint Web applications. However, SharePoint
Designer relies on a number of other services offered by the operating system to successfully per-
form its operations. These services cumulatively become the client side of the remote-authoring
features of SharePoint Designer.

Internet Explorer

SharePoint Designer relies on IE (WinINet .d11) for its HTTP settings, proxy server configura-
tion, and authentication support. If you open SharePoint Designer, choose Tools®> Application
Options, and then click the General tab, you find the Proxy Settings button. This button actually
opens the Internet Properties dialog box, as shown in Figure 3.2, in the Connections tab and
allows you to set settings for the proxy server to be used.

Also, SharePoint Designer respects the IE security zone settings for security and user authentication
as well as advanced settings for HTTP 1.1 and passive FTP.

The Internet Properties dialog box
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Web Client service

The Web Client service offered by the Windows XP, Windows Server 2003, and Windows Vista
operating systems allows Web-based HTTP addresses (for example, http: //webservername)
to be accessed as Uniform Naming Convention (UNC) paths (\ \webservername\folder
name). This feature provides a mechanism to map network drives to Web-based addresses.

Web Folders

Web Folders offers the underlying infrastructure that allows you to open your remote Web sites in
a Windows Explorer-like interface. If Web Folders is properly configured on your client machine
and your Web server supports remote authoring, it can be used to manage the Web site content
and add, remove, view, and copy files and folders to and from your remote Web site.

1 discuss the Web Client service and Web Folders in more detail later in this chapter.

Web server: the site-hosting machine

The Web server (IIS for this discussion) is the machine that hosts the Web sites and Web applications.
While I previously discussed the components that enable remote authoring on a Web server, 1
must mention that in order to enable live editing of Web sites in SharePoint Designer, the Web
server must support one of these technologies:

FTP

WebDAV

FPSE

SharePoint

Client-server communication protocols

HTTP is the base communication protocol that SharePoint Designer uses to converse with a Web
server. All other application protocols that SharePoint Designer exploits — for example, FrontPage
Remote Procedure Call (RPC), which is discussed later in this chapter — are HTTP-based.

HTTP protocol is not just limited in use for SharePoint Designer. It is, in fact, the standard com-
munication protocol for interaction between a Web client (for example, a Web browser) and a
Web server. When you type an address in a Web browser to view a Web site, the browser creates
an HTTP request and sends it to the Web server for processing. When the processing is complete,
the Web server sends an HTTP response back, which the browser interprets and then displays as a
Web page. The HTTP request is usually composed of these parts:

W A request line, such as GET /_vti_bin/author.dll HTTP/1.1, which requests the
file author.dll from the /_vti_bin directory. Here, GET is the HTTP verb being
used to indicate that the browser wants to retrieve the requested resource. Commonly
used HTTP verbs are GET, HEAD, POST, OPTTIONS, etc.
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| WebDAYV expands the set of standard HTTP verbs and allows for the use of verbs
- & such as LOCK, UNLOCK, PROPFIND, PROPPATCH, etc. These verbs enable the
remote authoring and live editing features for clients such as SharePoint Designer.

B Headers, such as Accept-Language: en. These headers provide a way for a browser
to tell the Web server about itself and the technologies that it supports.

B Anempty line

B An optional message body. This is usually the place in the HTTP request where the
FrontPage Remote Procedure Call (RPC) methods and SharePoint Simple Object Access
Protocol (SOAP) messages are sent. FPSE (and SharePoint SOAP Web Services) reads this
section to determine the action that needs to be performed for framing the HTTP
response to the Web browser for the request.

Similar to the HTTP request, the HTTP response also has these sections:

B Response line, such as HTTP/1 .1 200 OK, which indicates the result of the processing
done by the Web server for the HTTP request. If the processing fails for some reason, the
response code (for example, 401, 500, etc.) indicates the type of failure.

B Headers, such as Content-Length: 438. Like in the case of the HTTP request, the
headers in the response allow the Web server to specify information about itself and the
response that it just sent.

B Anempty line

B A message body; this is the actual response that’s parsed by the browser and displayed for
a user’s viewing. In the case of FPSE and SharePoint sites, this section might also contain
information that SharePoint Designer can use for various purposes, such as displaying
folder lists, rendering Web site content, working with Web parts, etc.

As discussed later in this chapter, FPSE (and SharePoint) sends a lot of optional information in the
HTTP request body. This information usually contains a Web method (with parameters and values),
which is executed on the Web server by FPSE (or SharePoint) to form an HTTP response that
SharePoint Designer can utilize to perform its functions. Obviously, if the execution fails and the
HTTP response indicates a failure, SharePoint Designer functionality relying on the response also fails.

Working with Web Folders
and Web Clients

While SharePoint Designer provides a smart design and development interface for working with
remote Web site content, it’s not the only interface that you can use for accessing remote Web site
content. Windows itself offers you the infrastructure that allows you to access remote Web site con-
tent much like a local folder on your computer. In fact, SharePoint Designer and other Office 2007
programs internally use this infrastructure as a basis for providing their remote-authoring features. A
problem in this infrastructure can cause the remote-authoring functionality of these programs to fail.
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The two main components offered by Windows for facilitating remote authoring are the Web
Client service and Web Folders.

Understanding client-side components
for remote authoring

The Web Client service (also known as the WebDAV Client Redirector) is a Windows service that
allows you to access content in Web sites (that support WebDAV) from a client machine in a
Windows Explorer-like interface. With this service enabled and running, you can access a folder
inside a Web site in Windows Explorer by using a UNC path (\ \webservername\ foldername).
You can also map network drives to folders inside Web sites. It’s a really useful tool for accessing Web
content on an intranet where you know the name of the Web server where your Web content resides.

The Web Client service is enabled and running by default on Windows XP and Vista client
machines. However, it’s disabled on a Windows 2003 server. You can enable or disable the Web
Client service by using the Services management console. To access the Services console, type
Services.msc in the Run dialog box (accessible by choosing Start=> Run). If the Web Client service
is disabled, you can enable it by right-clicking on it and then choosing Properties from the popup
menu. In the General tab of the WebClient Properties dialog box that opens, as shown in Figure
3.3, select Manual in the StartUp Type dropdown menu and then click Start. This should enable
and start the Web Client service on the computer.

FIGURE 3.3

The WebClient Properties dialog box
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To access a folder inside a WebDAV-enabled site in Windows Explorer by using the Web Client
service and then map a network drive to that folder, follow these steps:
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1.

Open Windows Explorer and then type the location inside the Web site that you
want to open by using the \\webservername\ foldername format. The contents of
the folder are displayed in the right pane inside Windows Explorer, and the Folders pane
on the left shows the other folders inside the site.

To map a network drive to a folder inside the Web site, click Start, right-click on
My Computer (Computer on Windows Vista machines), and then choose Map
Network Drive from the popup menu to open the Map Network Drive dialog box, as
shown in Figure 3.4.

FIGURE 3.4

The Map Network Drive dialog box
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Using the Drive dropdown menu, choose a name for this drive.

Type the UNC path (\\servername\foldername) of the folder in the Folder
dropdown menu.

Click Finish. A new drive with the name you chose is created in Windows Explorer. You
can now access the content of the folder inside the Web site by clicking on the mapped
drive. You can also use SharePoint Designer to modify content inside this mapped net-
work drive by choosing File = Open Site to display the Open Site dialog box. The Open
Site dialog box makes available the mapped network drive to be used for opening the
Web site in SharePoint Designer.



Exploring the Internals of Remote Authoring

Because SharePoint sites support WebDAV, the Web Client service can be very useful for accessing
document libraries inside SharePoint sites in a Windows Explorer—like interface, which can be
used to perform bulk copy/paste operations inside document libraries. Office 2007 programs also
use this service to directly open Office documents residing in Web sites for modification.

B Mapping network drives to folders inside SharePoint sites and then opening them
& in SharePoint Designer for editing isn’t recommended.

Using Web Folders in Windows XP
and Windows Vista clients

Web Folders is the other component offered by Windows for supporting remote authoring. Like
the Web Client service, the Web Folders technology provides the local infrastructure to open
remote sites in a Windows Explorer—like view. However, Web Folders is a relatively older technol-
ogy, and newer Windows operating systems, such as Windows Vista, don’t ship it by default. To
create a local Web folder for a Web site on a Windows XP machine, follow these steps:

1. Open Windows Explorer and then click My Network Places. This interface allows you
to create and view Web Folders.

2. Click Add a network place to open the Add Network Place Wizard and then
click Next.

3. Ensure that the Choose another network location option is selected and then
click Next.

4. Type the complete HITP address of the Web site in the Internet or network address
text field and then click Next.

5. Specify a name for the Web folder in the Type a name for this network place text
field.

6. Click Next and then click Finish.

Files and folders inside your Web site are displayed in a Windows Explorer—like interface. Also, inside
My Network Places is the newly created Web folder in the corresponding section. You can also create
and access a Web folder using IE. The Open dialog box in IE (accessible by choosing File=> Open) has
the Open as Web Folder check box that allows you to open a Web site as a Web folder.

Web Folders is installed by default on Windows XP machines. On Windows 2003 and Windows
Vista, the Web Client service is used by default to implement the Add a network place operation. If
the Web Client service is disabled, it falls back to Web Folders (if it’s installed).

F On Windows 2003 and Windows Vista machines, Web Folders isn’t installed, but

% you can use the Web Client windows service instead. However, you can download
and install Web Folders on Windows 2003 and Vista machines from www.microsoft.com/
downloads/details.aspx?FamilyId=17C36612-632E-4C04-9382-
987622ED1D64&displaylang=en.
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1f your Web Folders installation becomes corrupted, you might experience issues where SharePoint
Designer fails to open any sites for remote authoring, publish sites, etc. After you install Web
Folders on a machine, you can update and repair the associated files by using the webfldrs.msi
setup file:

1. Choose Start= Run and then type webfldrs.msi in the Run dialog box. The WebFldrs
Welcome Dialog box opens. You use this dialog box to add or remove features and
remove or reinstall Web Folders.

2. Click Reinstall. The WebFldrs Reinstall Mode dialog box opens, allowing you to choose
from a set of reinstall options.

3. Select all options and then click OK. All the files required for Web Folders to work
properly on the machine are now installed and registered.

Understanding FrontPage
Remote Procedure Call

When you open an FPSE-extended Web site (or a SharePoint site) for live editing, SharePoint
Designer internally has to perform a lot of operations, such as discovering the remote-authoring
mechanism supported by the Web site, opening the site, listing the files and folders of the Web
site, and determining the properties associated with the files. Even more such background opera-
tions need to be performed to implement other SharePoint Designer features, such as saving Web
pages, publishing content, etc.

SharePoint Designer accomplishes these operations by using an HTTP-based protocol called
FrontPage Remote Procedure Call (RPC). This protocol is the key component enabled for use on a
Web site when you extend it with FPSE (or set up a SharePoint site).

The remote-authoring operations are performed in the FrontPage RPC protocol by using Web meth-
ods. A Web method, simply put, is a function implemented by the remote-authoring mechanism
(FPSE or SharePoint) that performs a specific operation. For example, the Open Service Web
method offered by FPSE provides the necessary metadata information about a Web site that
SharePoint Designer can later use to open the Web site.

Investigating basic HTTP communication

To understand FrontPage RPC better, I take you through the operations performed when you open
an FPSE-extended Web site in SharePoint Designer and then discuss the Web methods involved:

1. Open Fiddler and then choose File= Capture Traffic to ensure that Fiddler is set to
capture HTTP traffic. You use this tool to capture HTTP Web sessions while opening an
FPSE site in SharePoint Designer.
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2. Open SharePoint Designer and then choose File= Open Site to open a Web site
extended with FPSE. Fiddler captures the Web sessions that take place during the pro-
cessing of opening the site, as shown in Figure 3.5. Unless you receive an error while
opening the site in SharePoint Designer, for this exercise, you need to concentrate only
on the HTTP Web sessions in Fiddler that show 200 in the Results column.

@ D Depending on whether this is the first time you’ve opened this site in SharePoint

st Designer, you might see that some of the Web sessions discussed might be
missing. SharePoint Designer caches information received from some Web methods to reduce
the HTTP traffic and improve efficiency.

3. Click the Web session with /_vti_inf.html in the URL column. This Web page is in
the root folder of your Web site after you extend it with FPSE. The HTTP response to this
request for _vti_inf.html tells SharePoint Designer about the relative URLs of the vari-
ous server executables (primarily shtml.d11, author.dll, and admin.dl11) that enable
remote authoring. These executables are installed with FPSE and SharePoint. SharePoint
Designer uses these relative URLs to formulate its next requests for the open site operation.

4. Click the Web session with /_vti_bin/shtml.dl1l/_vti_rpc in the URL col-
umn. If you view the raw HTTP request in the top pane inside the Session Inspector tab
for this session, the use of the Server Version Web method appears at the end of the
HTTP request. The FrontPage RPC Web methods are always sent at the end of the Web
request after the HTTP headers. The response to this Web method tells SharePoint
Designer about the version of FPSE the Web site is extended with. SharePoint Designer
uses this version to formulate the next HTTP request.

FIGURE 3.5

An HTTP Web session captured by Fiddler for the SharePoint Designer open site process
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5. Click the first Web session with /_vti_bin/_vti_aut/author.dll in the URL
column. The author.dl1l is the executable that provides the main server remote-
authoring functionality for SharePoint Designer. In the HTTP request, the Open
Service Web method response tells SharePoint Designer metadata information about
the Web site it needs to open.

6. Click the next Web session with /_vti_bin/_vti_aut/author.dll in the URL
column. This HTTP request has the List Documents Web method. The Web server’s
HTTP response to this Web method tells SharePoint Designer about the list of files and
folders inside the Web site and the metadata information about the files and folders.

As indicated by these steps, FrontPage RPC Web methods are heavily used by SharePoint Designer
to provide even the most basic functionality. Troubleshooting remote-authoring issues with
SharePoint Designer usually involves determining which Web method is being executed at the
time the problem occurs.

Exploring FrontPage RPC

If you examine an HTTP request in the last step in the previous exercise, after the initial verb and
the header information, SharePoint Designer sends this RPC method:

method=1list+documents%$3a5%2e0%2e2%2e6790&service$5fname=&1listHidd
enDocs=true&listExplorerDocs=false&listRecurse=false&listFiles
=true&listFolders=true&listLinkInfo=true&listIncludeParent=tru
e&listDerived=false&listBorders=false&listChildWebs=true&listT
hickets=false&initialUrl=&platform=WinI386

The name of this method is List Documents, and it takes the parameters service name,
listHiddenDocs, listExplorerDocs, listRecurse, listFiles, listFolders, etc.
The whole text is URL-encoded for fidelity across the Internet connection. As evident, SharePoint
Designer uses this Web method to request FPSE on the Web server to send folder information
about the Web site. The Web server HTTP response (that FPSE helps formulate) contains the
information and metadata about the files and folders inside the Web site. SharePoint Designer then
uses this information to display the list of files and folders inside the Web site.

Understanding the use of FrontPage RPC methods

Like Open Service and List Documents RPC methods, FPSE has a number of other Web
methods that are used by SharePoint Designer (and other Office applications) to enable their fea-
tures. Table 3.1 lists some of the important FrontPage RPC methods. Because SharePoint sites also
have their FPSE lineage, these proprietary Web methods are also used when authoring against
SharePoint sites in SharePoint Designer.
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TABLE 3.1

Common FrontPage RPC Methods

RPC Method Description

Server version Requests for the version of FPSE or SharePoint installed on the Web site
Open service Retrieves the information about the Web site for use in the client application
URL to Web URL Converts the given URL into the URL of the Web site

containing the given URL

List documents Provides the list of documents and folders inside the Web site. Also provides the
metadata, such as creation time, modified time, author, etc., associated with the
files for display in the client application

Get document Retrieves the document specified in the RPC method to the client for display

Get documents Provides the list of documents asked for in the parameter information of the RPC
method to the client application

While SharePoint Designer internally uses these methods, you can also consume these RPC meth-
ods in a custom program to query information and perform operations related to FPSE and
SharePoint.

s For a more complete reference to FrontPage RPC methods, visit this Web site:
e A‘Eé http://msdn.microsoft.com/en-us/library/ms954084.aspx.

Understanding Simple Object Access
Protocol and Web Services Basics

Along with using FrontPage RPC Web methods, SharePoint Designer relies on a number of Web
methods and functions exposed by SharePoint ASP.NET-based Web Services for the remote
authoring of SharePoint sites. SharePoint Designer uses Simple Object Access Protocol (SOAP) to
communicate with SharePoint Web Services for performing basic operations on SharePoint sites,
including opening Web pages, rendering SharePoint content in the Design view, and implementing
advanced features, such as Data Forms and Web Parts.

To be able to understand the background processes involved when working with SharePoint sites
in SharePoint Designer, it’s important to have some basic understanding of SOAP and ASP.NET
Web Services. In this section, I discuss Web Services and SOAP as a communication protocol to
converse with Web Services.
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Understanding SOAP technology

To put it in simple terms, SOAP allows a client program to remotely execute a method exposed by
a Web Service being hosted on a Web server. Unlike the FrontPage RPC methods discussed earlier,
the syntax of SOAP-based communication is mostly driven by XML-based messages. These XML
messages are sent in the body of the HTTP request to the Web Service on the Web server. The
Web Service processes the request based on the information in the HTTP request and formulates
an HTML/XML response for use by the client.

Web Services are programs with an . asmx file extension that, once developed by using an applica-
tion such as Visual Studio, can be installed on the Web server machine to provide the functionality
they offer to a Web site. Besides running their isolated server-side tasks, Web Services also provide
for a mechanism of Web methods that allows for the invocation of tasks from a remote client.
These Web methods are exposed by a Web Service and are discoverable by the client programs by
using a Web Services Description Language (WSDL) file.

For example, SharePoint installs a Web Service called Lists.asmx. If you browse to this Web
Service in a Web browser (by using the URL http://servername/_vti_bin/lists.asmx),
as shown in Figure 3.6, you can see the Web methods that this service exposes.

If you click on any of the Web methods, a sample of the HTTP request and response appears.

FIGURE 3.6

A description of the Lists.asmx Web Service

The following operations are supported, For a formal definition, please review the Service Description,

+ AddAttachment

AddDiscussionBoardItem

AddlList

AddlListFromFeature

* ApplyContentTypeTolist

CheckInFile

CheckOutFile

CreateContentType

DeleteAttachment

DeleteContentType

DeleteContentTypeXmlDocument

Deletelist

GetattachmentCollection

Getlist

GetListAnd¥iew
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Exploring Web Services and Web Methods

When you open a SharePoint site in SharePoint Designer, the client requests a lot of information
about the Web site by using a combination of FrontPage RPC methods and SharePoint Web
Services. While most of the FrontPage RPC methods are served by the author.dl1 that
SharePoint installs, the Web methods are processed by the corresponding SharePoint Web Service.

To understand the nature of the SOAP HTTP session that SharePoint Designer makes with a
SharePoint site, I discuss the GetWebPartPage Web method exposed by the WwebPartPages.
asmx SharePoint Web Service. This Web method is used when you open a SharePoint Web page
for editing in SharePoint Designer. Figure 3.7 shows the HTTP request captured by Fiddler that
shows the use of this Web method.

FIGURE 3.7
The GetWebPartPage SOAP Web method being used by SharePoint Designer
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The POST verb is used to post information to the WebPartPages . asmx Web Service:
POST /sites/teamsite/_vti_bin/webpartpages.asmx HTTP/1.1

In the header section is the SOAP action header, which defines the Web method that’s being
requested for execution by the client:

SOAPAction: http://microsoft.com/sharepoint/webpartpages/
GetWebPartPage
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TABLE 3.2

SharePoint Web Services for SharePoint Designer Remote Authoring

Later in the body of the HTTP request, the GetWebPartPage Web method was called with the
documentName parameter set to default.aspx. This indicates that SharePoint Designer is
requesting SharePoint to help it open the default.aspx page for editing:

<?xml version="1.0" encoding="utf-8"?>

<soap:Envelope xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.0rg/2001/XMLSchema" xmlns:soap="http://
schemas.xmlsoap.org/soap/envelope/"><soap:Body><GetWebPartPage
xmlns="http://microsoft.com/sharepoint/webpartpages"><documentNam
e>default.aspx</documentName></GetWebPartPage></soap:Body></
soap:Envelope>

The HTTP response to this request has the actual code of the default.aspx page, which is
displayed in the Code view of SharePoint Designer and rendered for display in the Design view.

Examining SharePoint Web Services for
SharePoint Designer authoring support

SharePoint provides the remote-authoring support for SharePoint sites to SharePoint Designer by
using a number of Web Services. While the most used Web Service is WebPartPages . asmx,
Table 3.2 lists some of the Web Services that SharePoint Designer uses while working with
SharePoint sites.

Web Service Web Method

WebPartPages.asmx Provides a large number of Web methods, such as GetWebPartPage,

GetAssemblyMetaInfo, ExecuteProxyUpdates, GetDataFrom
DataSourceControl, etc. This Web Service provides most of the
SharePoint capabilities of SharePoint Designer.

UserGroup.asmx Provides the GetRolesAndPermissionsForCurrentUser method

that’s used by SharePoint Designer to fetch user permissions from SharePoint

Sites.asmx Exposes the GetSiteTemplates used to show the list of available

SharePoint site templates in SharePoint Designer

Lists.asmx Exposes a number of Web methods for performing various SharePoint

lists—related operations
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After you become comfortable using Fiddler to understand HTTP requests and responses, you find
that many of the SharePoint-related operations of SharePoint Designer use these Web Services. If
the Web Services don’t properly respond or the HTTP response from SharePoint indicates a failure,
SharePoint Designer has no choice but to fail. Understand that these Web methods can help find
important clues to troubleshooting SharePoint authoring issues.
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Summary

Because SharePoint Designer can work as a remote-authoring tool for a number of Web server
types, the number of communication protocols it supports is enormous. This chapter focused on
providing you with some details on all these internal protocols, such as HTTP, FrontPage RPC, and
SOAP services. This should help you narrow down many issues you might run into while working
with these server types in SharePoint Designer.
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Ithough the current release of SharePoint Designer keeps the basic

FrontPage 2003 user interface, it also includes a large number of

enhancements to improve output and productivity for developing
both SharePoint and non-SharePoint Web sites. The SharePoint Designer
user environment focuses on consolidating similar features into dialog boxes,
toolbars, and dockable task panes. It provides you with the flexibility to
morph its environment to suit your style and design needs. You can custom-
ize the interface to keep the task panes and toolbars that you most com-
monly use in the front for easy access and hide the less commonly used user
interface.

In this chapter, I begin by familiarizing you with the SharePoint Designer
environment and then take you through some exercises and help you under-
stand how to customize the user interface to suit your needs. Also, I mention
some of the most commonly used user interface features that you encounter
every time you work with a Web site in SharePoint Designer. Later in this
chapter, I talk about the page-editing and application options that help you
make decisions about how certain user interface components should behave
and set default settings and schemas for use on Web pages.

When you open SharePoint Designer the first time after it’s installed, the
default interface layout is shown. Because there’s no Web site or Web page
open, most of the menu options and task panes in the interface are disabled.
The environment is divided into four sections:

B The top section has the main commands menu bar and toolbars
(the Common toolbar is enabled by default).

B The left section shows the Folder List task pane along with addi-
tionally enabled task panes.
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FIGURE 4.1

B The center section is either empty (if no page is open) or shows a page view (Design or
Code view) for a Web page.

B The right section has a set of task panes enabled by default.

Figure 4.1 shows the key components of the SharePoint Designer interface.

The SharePoint Designer environment
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It's important to understand that while this interface is the default interface, SharePoint Designer
allows you to customize it to a large extent. So, for example, if you feel more comfortable having
the Folder List task pane on the right side of the environment, you can move it there.

The first operation that you usually perform is to create or open a site. Choose File = Open Site to
open a site in SharePoint Designer. For illustration purposes, I use a WSS v3 site, open it in
SharePoint Designer, and then open its default . aspx page by double-clicking it in the Folder List
task pane. Figure 4.2 displays the SharePoint Designer user interface after opening a WSS v3 site in it.

The interface becomes live after you open the site in SharePoint Designer. The Folder List task
pane in the left section shows the list of subsites, lists, document libraries, folders, and files, with
icons representing the type and nature of the content.

The center section has a tabbed interface. The Web Site tab allows you to switch between a set of
Web Site panes, which I discuss later in this chapter. Then, depending on the number of pages
open for editing, you see multiple tabs, each allowing you to activate the associated page for edit-
ing. When you activate a Web page for editing, you can choose from a set of page views, which
allow you to edit the design and layout of the page or the code associated with the Web page.
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FIGURE 4.2

A WSS v3 site open in SharePoint Designer
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For more on page views, see Chapter 6.

In the right section is the Toolbox task pane, which is mostly disabled when you have the Web Site
tab open in the center section. However, when you switch to a Web page, the Toolbox task pane
becomes enabled and allows you to insert a number of HTML, ASP.NET, and SharePoint controls
on the Web page. I talk about the various task panes in detail when discussing the corresponding
features in various chapters in this book. However, later in this chapter, I show how you can repo-
sition task panes to customize the SharePoint Designer environment to suit your needs.

Using the New Dialog Box

One major improvement that SharePoint Designer offers compared to FrontPage 2003 is that it
provides a single interface to create all content associated with SharePoint and non-SharePoint
sites. The New dialog box, as shown in Figure 4.3, provides an integrated user interface that allows
you to create Web pages, Web sites, and SharePoint-related content.

Depending on the type of Web site being worked on in SharePoint Designer, the New dialog box
shows and hides the user interfaces available to you.
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FIGURE 4.3

The New dialog box
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Creating Web content and files

The Page

tab in the New dialog box allows you to create Web pages and other file types by using a

list categorized by the nature of the Web content:
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General: Allows you to choose from a list of general Web content types, such as HTML,
ASPX, CSS, ASP.NET master pages, dynamic Web templates, JavaScript, XML, and text

files. It also allows you to create new content based on existing dynamic Web templates
or master pages. You can also specify the programming language to be used while creat-
ing ASP.NET content.

ASP.NET: Filters the General list to ASP.NET—specific Web content. Also allows you to
create new ASP.NET web. config files, site maps, and Web user controls

CSS Layouts: Allows you to choose from a list of CSS layout templates that can be used
to lay out Web pages based on style sheets

Style Sheets: Allows you to choose from a list of style sheet templates
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B List View Pages: Available only for SharePoint sites, this allows you to create new view
pages for SharePoint document libraries and lists. A view page, usually just called a View,
is a customized or filtered view of the items in a list or document library.

B Frames Pages: Provides you with page templates that can be used to create Web pages
based on HTML frames

Using Web site templates

You use the Web Site tab in the New dialog box to create new SharePoint and non-SharePoint Web
sites from scratch or based on available templates. Here are the available options:

B General: Allows you to create a new Web site based on the One Page Web Site or Empty
Web Site templates or by using the Import Web Site Wizard

B Templates: Empty in the case of SharePoint Designer. In the case of Expression Web,
provides a list of non-SharePoint Web site templates

B SharePoint Templates: Allows you to create a Web site based on a list of templates pro-
vided by your SharePoint site

The Add to Current Web site and Use Encrypted Connection (SSL) check boxes are available if
you already have a Web site open prior to opening the New dialog box.

= The interface to list and use SharePoint templates can be a little confusing. This is
S8 because SharePoint Designer lists the SharePoint site templates by making SOAP

requests to the sites.asmx Web service inside the SharePoint site you type in the Specify

the location of the new Web site dropdown list box. When you click the Web Site tab, it’s not

necessary that the URL of the Web site typed in this text field be for a SharePoint site; thus, you

might have to follow a series of steps to show the available SharePoint site templates.

To list the site templates available for a SharePoint site in the New dialog box, follow these steps:

1. Open SharePoint Designer and ensure that there’s no Web site open in it. If a site is
open, choose Filew> Close Site to close the open site.

2. Choose Filew> New to open the New dialog box, as shown in Figure 4.4, and then
click the Web Site tab.

3. In the Specify the location of the new Web site dropdown menu, type the HTTP
address of your SharePoint Web application. Note again that you can’t use SharePoint
Designer to create SharePoint site collections. You need to create a Web application and
site collection by using the SharePoint interface before you can use SharePoint Designer
to create sites inside the site collection.

4. Click the SharePoint Templates list option in the Web Site tab. If this is already
selected, first click another option in the list (such as General) before clicking back to
SharePoint Templates. This process forces SharePoint Designer to make an HTTP-based
SOAP request to the Sites.asmx and then retrieve the list of site templates provided by
the SharePoint site.
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FIGURE 4.4

The New dialog box
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You can now click a site template from the available list and then create a new site inside the
SharePoint site that you typed in the Specify the location of the new Web site dropdown menu.

Exploring SharePoint content

After you open a SharePoint Web site in SharePoint Designer, a new tab called SharePoint Content
appears in the New dialog box, as shown in Figure 4.5. This tab can be used to create new
SharePoint content, such as lists, document libraries, surveys, and workflows:
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Lists: SharePoint Designer retrieves the available list templates from the SharePoint site
being edited. You can then use these templates to create new lists inside a Web site.

Document Libraries: Allows you to create new libraries based on the templates provided
by the SharePoint site being edited

Surveys: Allows you to create new SharePoint survey lists

Workflows: Links to the Workflow Designer that can be used to create workflows on
SharePoint sites

SharePoint Publishing: Available only for MOSS Web sites, this option allows you to
create new page layouts based on the available SharePoint content types.
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FIGURE 4.5

The SharePoint Content tab in the New dialog box
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While the New dialog box offers the combined interface for all content creation, shortcuts in
SharePoint Designer allow you to create Web content without having to open the New dialog box.
For example, in the File menu, if you just hover over the New menu option, another menu opens
that either lets you create Web content directly or opens the New dialog box.

Also, in the Web Site tab discussed earlier, a New Page icon in the top-right corner allows you to
create a new Web page (the document type of which is defined in the Page Editor Options).

Working with Page Views

The page-editing interface of SharePoint Designer offers three main views that you can use to
design and code for your Web page: the Design view, the Code view, and the Split view. Figure 4.6
shows the Split view of a Web page in SharePoint Designer. You can switch views by clicking the
tabs located near the lower-left corner.

To become familiar with the page views, follow these steps to create a simple SharePoint Web page
using SharePoint Designer:
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1. Choose Filew Open Site to open a WSS v3 site in SharePoint Designer. This exercise
creates a new Web page based on the default master page of a WSS v3 site.

For more on master pages, see Chapter 13.

2. Choose Filew> New to open the New dialog box. Under the Page tab in the General list,
click Create from Master Page. Keep C# as the Programming Language for the Web page.

3. Click OK. The Select a Master Page dialog box opens.

4. Keep the defaults in the Select a Master Page dialog box and then click OK.
SharePoint Designer now creates a new Web page and applies the Web site’s default mas-
ter page to it. When the default master page is applied to the new Web page, SharePoint
Designer renders the Web page in the Design view.

5. Press Ctrl+S or choose Filet> Save As to save the Web page inside the root folder of
the Web site.

FIGURE 4.6

The Split view for a page in SharePoint Designer
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The Design view is the canvas you use to develop your Web pages and see the first preview of how
your Web page would look. The Design view renders HTML tags and controls, ASP.NET 2.0, and
SharePoint controls in a manner very similar to the way they would look in a Web browser (hence,
WYSIWYG). It enables design features, such as visual aids and formatting marks, that assist you in
managing the design and layout of a Web page, and provides the user interface to selectively access
control properties and common control tasks.

To view the code associated with the Web page, open it the Code view, which you do by clicking
the Code tab at the bottom-left corner of the Web page. The Code view in SharePoint Designer
provides a rich, enhanced Visual Studio-like experience to aid in code writing. It supports features
such as IntelliSense and auto code completion for HTML, client-side scripts, and ASP.NET 2.0. It
also provides features such as code hyperlinks and incremental search that developers can use to
easily manage code on their Web pages.

The Split view allows designers to view both the Design and Code views of the Web page in a sin-

gle view. This view is particularly useful in quickly locating code associated with a tag or control in
the Code view. Simply clicking on the control in the Design view highlights the associated code in

the Code view.

To see this with the Web page that you just created in the previous exercise, follow these steps:

1. With the Web page open in the Design view, hover over the search box control in
the top-right corner of the Web page. A button with an arrow on it is enabled for the
search box control. This button is called the control’s Common Tasks button and is used
to open the Common Control Tasks menu, which allows you to change control properties.

2. Click the Common Tasks button and then click Create Custom Content. Now click
the Quick Launch bar on the left to move the focus away from the search box control.

3. Click the Split view tab of the Web page and then click the search box control again.

The code associated with the search box control is highlighted in the Code view. This ability is
very useful in locating code associated with a particular control, especially when the Code view of
the Web page has a large number of lines in it.

=1 For more on page views, see Chapter 6.

DR,

R

Understanding Web Site Panes

The Web Site tab shown in Figure 4.7 provides another set of standard panes in SharePoint
Designer to manage certain site-level components, such as site hyperlinks, reports, and navigation:
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FIGURE 4.7

The Web Site panes in SharePoint Designer
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B Folders: Like the Folder List task pane, this pane shows the list of folders and files inside
the Web site. Again, the icons for the files and folders indicate the type of content.

B Remote Web Site: Allows the use of SharePoint Designer publishing features for non-
SharePoint Sites. This pane is not available for SharePoint sites.

B Reports: The option provides the interface for viewing and managing a SharePoint
Designer site and usage reports for a Web site.

B Navigation: Displays the navigation structure of the Web site (for Web sites that use hid-
den metadata). Allows you to add and remove pages from the Web site’s navigation struc-
ture and set page titles

B Hyperlinks: This displays a visual representation and allows management of the hyper-
links inside the selected Web page.

Using Toolbars and Task Panes

SharePoint Designer makes most of its designing and development features available through tool-
bars and task panes. You can enable or disable toolbars in SharePoint Designer by choosing
View = Toolbars. The Task Panes menu in SharePoint Designer can be used to enable and disable
the task panes. One of the really cool features of SharePoint Designer task panes is that they can be
docked in and out of the user interface. This feature allows SharePoint Designer users to lay out
the environment as they want it. So, if a designer is working heavily on data views, he or she can
modify the interface so that the task panes and toolbars associated with data views are enabled and
activated for easy access.

Laying out your SharePoint Designer interface

While the default view of the SharePoint Designer environment has the task panes and toolbars
located in a specific manner, the interface is very flexible and allows you to modify it to keep the
most frequently used task panes activated.
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You can easily drag and dock task panes to either corner of the center section (which displays the
Web Site panes) or drag them to another screen if you're working with multiple monitors and run-
ning out of screen real estate. Toolbars and the menu bar can also be docked around any corner of
the screen. Figure 4.8 shows such a customized view of the SharePoint Designer environment.

The Style and Style application toolbars can be seen in the top section, the CSS Properties task
pane is activated in the left section, the CSS reports in the center section, and the Manage Styles
and Apply Styles task panes are enabled in the right section. This environment is set up for ease of
operation when working with CSS.

FIGURE 4.8

A customized view of the SharePoint Designer environment
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Using the Customize dialog box

The Customize dialog box, as shown in Figure 4.9, provides the Commands well for SharePoint
Designer, which is used to host menus, menu options, commands, etc. These menu options and
commands can be dragged and dropped into new or existing menus and toolbars to customize the
SharePoint Designer environment to suit your needs.
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The Commands well in the Customize Dialog box
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I SharePoint Designer stores the customizations you make to its interface in a state
file called CMDUI . PRF stored in the user’s profile at C: \Documents and
Settings\<username>\Application Data\Microsoft\SharePoint Designer\State.

In the next exercise, I take you through the steps to create a new toolbar for SharePoint Designer
by using the Customize dialog box:

1. Choose View=™ Toolbars=> Customize to open the Customize dialog box.

2. In the Toolbars tab, click the New button. Type the name for your custom toolbar in
the New Toolbar dialog box, as shown in Figure 4.10.

FIGURE 4.10

The New Toolbar dialog box
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3. Click OK. The new toolbar without any buttons is shown. The next step is to add but-
tons to the toolbar by using the Commands well.

4. To access the Commands well, click the Commands tab. Here, the left list shows the
command categories, and the right list shows the list of available commands.

5. Locate the commands you want to add to your new toolbar. Drag and drop the com-
mands into the newly created toolbar. After you drop a command inside the new toolbar,
the Modify Selection button becomes enabled. This button can be used to change the
name, image, and text of the command in the toolbar.

= The Customize dialog box is especially useful for providing command buttons to

% expose the functionality that developers might have created through macros by
using the SharePoint Designer object model. You can use the Assign Macro option (found after
clicking the Modify Selection button) to assign a macro to a command button. The macro can
then be run by just clicking the command button.

B You can learn more about macros at this Web site: http://msdn.microsoft.
% com/en-us/library/bbl149050.aspx.

When the toolbar is complete, you can drag and dock it to any of the four corners of the
SharePoint Designer environment.

Modifying Page-Editing
and Application Options

SharePoint Designer comes with some default general application settings that define its behavior
when it's open. These settings can be controlled by the Application Options dialog box, as shown
in Figure 4.11, which is accessible by choosing Tools=> Application Options. The Application
Options dialog box has four tabs:

B General: Allows you to establish application startup options that check whether
SharePoint Designer is the default editor for Web pages and Office documents, toggle the
SharePoint Designer status bar (displayed at the bottom of the SharePoint Designer inter-
face), show warnings in the status bar for expired FrontPage Include components, etc.

B Configure Editors: This tab allows you to associate programs with various file extensions
or change existing associations. You can also add, modify, or delete extensions.

B Reports View: Allows you to set some settings that apply to the site reports generated for
Web pages by SharePoint Designer

B FTP: Allows you to choose whether a file extension is transferred via FTP in binary or
ASCII format
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FIGURE 4.11

The Application Options dialog box
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The Page Editor Options dialog box, as shown in Figure 4.12, which can be accessed by choosing
Toolsw Page Editor Options or via the Page Editor Options link in the New dialog box, is the
interface that allows you to set master properties for a number of SharePoint Designer components
and features. These properties include general settings for HTML tags, Code view options, picture
and auto thumbnail settings, IntelliSense and code formatting options, CSS settings, etc. The Page
Editor Options dialog box has several tabs:

[ For more on page-editor options, see Chapters 6, 7, and 12.

B General: This allows you to establish general settings for HTML tags and set spelling
options and Code view options.

B  Auto Thumbnail: This allows you to change the width, height, and border thickness of
thumbnails created by SharePoint Designer during various picture operations.

B Default Fonts: This allows you to set the default font settings and the fonts for text dis-
play in the Design and Code views of SharePoint Designer. The font settings here for the
Design view don’t actually apply to the text of the Web page. While the preview on the
page in Design view uses the font settings you make here, the actual page text uses the
font specified using text formatting via HTML, CSS, etc. For example, if you set the
default font to Calibri, the portion of text that has Verdana applied to it in the HTML
code is displayed in the Design view in Verdana. However, a portion of text that has no
HTML, CSS, etc., applied to it is shown in Calibri.
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FIGURE 4.12

The Page Editor Options dialog box
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B Code Formatting: This allows you to set a number of options for the Code view of
SharePoint Designer.

=5 For more on code formatting, see Chapter 6.

B CSS: This allows you to set how CSS styles are applied to the various HTML tags.

B Color Coding: Settings in this tab allow you to specify the colors used to indicate various
SharePoint Designer components in the Design view. Also, you can set colors to differen-
tiate code in the Code view. While the default settings here usually work best, you can
change settings in case you're accustomed to a different set of code colors.

B Authoring: This allows you to set default new document types for non-SharePoint and
SharePoint sites. Also, you can set the document type declaration, Internet Explorer and CSS
schemas to be used for IntelliSense, auto code completion, and indicating errors in code.
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Picture: This provides the interface for setting default file types for pictures and picture
conversion.

Code Snippets: This allows you to add or remove code snippets. Code snippets is a fea-
ture offered by SharePoint Designer that allows you to quickly add frequently used code
pieces to the code of the Web page.

Ruler and Grid: This can be used to specify settings for rulers and grids in the Design view.

IntelliSense: This provides settings for auto code completions and code hyperlinks for
the SharePoint Designer Code view.

Font Families: This allows you to add fonts and create font families.

These options are discussed throughout the rest of this book.

Summary

By the end of this chapter, you have seen SharePoint Designer enough to be familiar with the lay-
out and placement of the various features. What makes this interface so easy is that most of the
functionality is easily accessible by using task panes and toolbars. As you work more with
SharePoint Designer, you start remembering shortcuts that make it even simpler to use. Have you
already figured out that pressing Ctrl+N creates a new page and opens it in one of the views? More
such shortcuts follow throughout the rest of this book.



n this chapter, 1 elaborate on Web page design and development. This
chapter focuses primarily on Web page development by using HTML
technology.

The default Web pages that come with SharePoint sites use a variety of com-
plex page design and development technologies. To avoid overload, I use
non-SharePoint sites to discuss Web page design and formatting concepts.
Once you understand these basic concepts, you can apply them to
SharePoint Web pages with relative ease. Although profound discussion on
HTML is beyond the scope of this text, I introduce you to some basic HTML
concepts and tags as you move along and design HTML Web pages by using
SharePoint Designer tools and features. Also, many page-formatting features
of SharePoint Designer rely heavily on CSS. I also discuss the SharePoint

Designer no-code implementation of such features.
% SS REF For more on Web page development by using DHTML
<A =% and ASP.NET 2.0, see Chapters 8 and Chapter 10. For
more on internal CSS implementation, see Chapter 12.

HTML is the principal language for developing Web pages. Even if you use a
server-side script, such as ASP.NET, to write the actual code of your Web
page, the code that a browser renders is always HTML. HTML provides its
features through a number of tags that you can set attributes for to define
your usage. For example, the <a> tag is used to create a hyperlink, and the
HREF attribute of the <a> tag is used to define the location of the hyperlink.

SharePoint Designer allows you to implement many of the commonly used
formatting techniques without having to write or understand the HTML cod-
ing that goes with it.
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Understanding Basic Formatting
and Positioning

In this section, I help you understand some of the very basic formatting features of SharePoint
Designer. Later, you might decide to implement functionality provided by these features by using
separate CSS styles. However, this section should help you develop understanding about how
these features work and also explore some code behind the implementation.

Setting fonts for text

Fonts and font styles help implement text formatting on Web pages. You implement basic font for-
matting in SharePoint Designer by using the Font dialog box, as shown in Figure 5.1. You access
the Font dialog box by either choosing Format= Font or by simply right-clicking on the Web page
in the Design view and then choosing Font from the popup menu.

FIGURE 5.1

The Font dialog box with the Font tab selected
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To apply a font to text on a Web page, follow these steps:

1. Open the Web page in the Design view and then select the text to which you want
to apply a font. Double-clicking a word in a line of text selects that word. Clicking three
times successively selects a whole paragraph.

2. Right-click on the selected text and then choose Font from the popup menu. The
Font dialog box opens, allowing you to choose the font, font style, and size you want to
apply to your text.

3. Using the Font list in the Font tab, choose the font that you want to apply to the
selected text. The Font list displays the font families and the fonts installed and available
for use on Web pages. Your selection is shown in the box just above the Font list. For this
exercise, choose Tahoma from the Font list.

B You can press Ctrl+Z to undo any changes made to a Web page. Ctrl+Y can be used
% to reapply the last change made. This comes in handy if you need to change only
certain aspects of a page and don’t want to access the Font dialog box for each change.

4. Use the Font style list to choose the style for the selected text. You can choose to dis-
play the text in bold, italics, both, or neither. Choose the (Default Style) option (which
actually means neither) in the Font style list for this exercise.

5. You can use the Size box and list to either specify a size (in points) or choose from
a set of predefined sizes. Choose a small size (such as 12 points) for the selected text.

6. Click the Color dropdown menu to choose a color for the text. You can either choose
from the standard colors shown in the default palette, custom colors that you created, or
document colors that already exist in the document. You can also click More Colors to
specify or create another color.

7. Choose More Colors from the Color dropdown menu to open the More Colors dia-
log box, as shown in Figure 5.2. Here, you can specify the hex value that defines the
color, create a custom color by using the Custom button, or choose from the hexagonal
palette of colors by clicking Select. Also, a preview in the bottom-right corner of the dia-
log box shows the New and Current colors.

8. Click Select to enable selection from the hexagonal palette in the dialog box. Choose
the color you want to use by clicking on it in the hexagonal palette. The Value text field
shows the hex code associated with the color, the Name text field shows the color name,
and the preview shows the selected color.

9. Click OK to view the preview of the selected color in the Preview section of the
Font dialog box.

10. In the Effects section, click the Underline, Overline, Strong, and Variable check
boxes. The Effects section allows you to choose from some default effects that have been
prepared for use. When you make a selection in the Effects section, some of the font
styles may change. For example, clicking the Strong check box changes the selection in
the Font style list to Bold.

11. Click OK to apply the font to the selected text.
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While the Design view of the Web page now shows the font formatting applied to the text, the
interesting aspect is how SharePoint Designer applies this formatting. You can view the code that
SharePoint Designer wrote for the previous steps by choosing the Code view of the Web page:

B Style section:

<style type="text/css">

.stylel {
font-family: Verdana;
font-size: small;
color: #CC6699;
text-decoration: overline underline;

}

.style2 {
font-style: normal;

}

</style>

B HTML section:
<p class="stylel"><var class="style2"><strong>test</strong></

var></p>

FIGURE 5.2

The More Colors dialog box
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As indicated in the Code view, fonts are implemented by using a combination of CSS and HTML
technologies. The font size, color, etc., are applied by using CSS styles (indicated by the
class="style" code), and the Strong effect is applied by using the <strong> tag.

Many of the formatting options provided by the Font dialog box are also available by using the
Common and Formatting toolbars, as shown in Figure 5.3. For example, you can use the
Formatting toolbar to quickly choose a font for the selected text, define the font size and apply font
styles, specify the background and foreground colors for lines and paragraphs, create borders for
lines and paragraphs, etc.

FIGURE 5.3

The Common (top) and Formatting (bottom) toolbars
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the General tab of the Page Editor Options dialog box, which you access by choosing

Tools > Page Editor Options. If you deselect this check box, SharePoint Designer uses the <b>

tag to bold text.

You can also use the Character Spacing tab in the Font dialog box to specify settings for the spac-
ing between the words and characters in the text. By default, the character spacing is set to normal.
However, you can choose to either expand (or condense) the characters and specify the measure
(by using the By list box) of the expansion (or condensation). In the next exercise, I help you
understand how you can position the text by using the options in the Character Spacing tab:

1. Create a new HTML Web page with some text paragraphs inside your Web site and
open it in the Design view.

2. Select a line of text in the paragraph on the Web page. Right-click on the selected text
and then choose Font from the popup menu to open the Font dialog box, as shown in
Figure 5.4.

3. Click the Character Spacing tab, and in the Spacing dropdown menu, choose
Expanded. Use the By list box to specify the amount of expansion.

4. In the Position dropdown menu, choose Super.
Click OK.
The selected text in the Design view appears positioned a little above the normal text of the para-

graph. If you investigate the Code view of the Web page, this functionality is again implemented
by using CSS with vertical-align and letter-spacing properties:
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B CSS section:

<style type="text/css">
.stylel {

letter-spacing: 5pt;
vertical-align: super;
}
</style>

B HTML section:

<p>Show me how to <span class="stylel">superscript</span></p>

FIGURE 5.4

The Font dialog box with the Character Spacing tab selected

EO—— 2lx|
Fank Character Spacing |
Spacing: IExpanded - I By: 1pt :I
Eosition: Isuper| b I
Preview
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oK I Cancel | Apply |

Because all the fonts might not be available on the machine where your Web page is being viewed
or supported by the browser being used to view the Web page, it’s useful to apply fonts by using
the font families. Font families allow you to apply fonts to text on Web pages by using a set of
fonts rather than a single font. If one font isn't available, a browser can display the text by using
another font in the font family. You can create font families in SharePoint Designer by using the
Font Families tab in the Page Editor Options dialog box, as shown in Figure 5.5.
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To create a new font family and use it to format the text on your Web page, follow these steps:

1. Choose Tools= Page Editor Options to open the Page Editor Options dialog box
and then click the Font Families tab.

In the Select font family list, click the (New Font Family) option.
Choose Arial from the Add font list and then click Add. Repeat this step to also add

Calibri, Tahoma, and Verdana to the new font family you just created.
4. Click OK.

The new font family is now created and is available for use in the Font dialog box or the Common
and Formatting toolbars.

I The Default Fonts tab in the Page Editor Options dialog box specifies the default

=% fonts to use for displaying text in the Design and Code views. The fonts you set here
are for dlsplay purposes only and don’t apply to the page itself. When you view the Web page in
a browser, fonts that are actually applied to the text using the Font dialog box (or other features)
are used.

FIGURE 5.5

The Font Families tab in the Page Editor Options dialog box
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Working with paragraphs and indentation

By default, SharePoint Designer allows you to format text by using paragraphs. Whenever you
press Enter on a Web page in SharePoint Designer, a <p> tag is inserted and a new paragraph is
started. Most of the paragraph formatting that can be applied by using the SharePoint Designer
user interface applies to the <p> tag by using CSS styles.

In the next exercise, you use the Paragraph dialog box, as shown in Figure 5.6, to implement para-
graph formatting to selected text on a Web page:

In the Design view, open or create a Web page that has text paragraphs.

2. Select a paragraph of text in the Design view and then choose Format=> Paragraph
to open the Paragraph dialog box.

3. Choose Center from the Alignment dropdown menu. This aligns the selected text in
the center of the Web page.

4. In the Indentation section, type the values of the indentation for the paragraph from
the left and the right sides as well as the indentation of the first line in the paragraph.

5. In the Spacing section, type the spacing you want before and after the paragraph
and between words in the paragraph. Also, type the spacing between the lines of the
paragraph by using the Line Spacing dropdown menu. The preview at the bottom of the
dialog box shows how the settings you make for the paragraph look.

6. Click OK and then save the Web page.

If you investigate the Code view of the page where you applied the settings using the Paragraph
dialog box, you see that most of the settings have been implemented by using CSS, with properties
such as text-align, line-height, word-spacing, margin-left, etc.

One interesting feature provided by the Common and Formatting toolbars is to quickly format text
lines and paragraphs by using predefined HTML and CSS styles. If you click the dropdown menu
that has the Paragraph option selected, a list of available HTML tags, such as Headings (<h1>,
<h2>, etc.) and Lists (<ul>, <ol>, etc.), are available for use on a paragraph. These tags format
text in different ways, allowing you to choose the best formatting for representing the text. For
example, the <ul> tag allows you to create a bulleted list in the text, while the <o1> tag allows
you to create a numbered list.

| You can also increase or decrease the indentation of a paragraph or a line of text by
using the Increase Indent Position (Ctrl+M) and Decrease Indent Position

(CtrI+Sh|ft+M) buttons in the Common and Formatting toolbars.
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FIGURE 5.6

The Paragraph dialog box
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Choose Format= Borders and Shading to apply borders and specify background colors and pat-
terns for your text lines and paragraphs. In the next exercise, you use the Borders and Shading dia-
log box, as shown in Figure 5.7, to apply borders to a paragraph of text inside your Web page:

1. In the Design view, open or create a Web page that has text paragraphs.

2. Select a paragraph of text and then choose Format= Borders and Shading to open
the Borders and Shading dialog box.

3. In the Setting section under the Borders tab, click Custom. The Settings section
allows you to choose from Default (no borders), Box (creates a border on all four bound-
aries of the selected text), and Custom (allows you to choose on which boundary the bor-
der should be applied).

4. In the Style list, choose double. The Style list allows you to choose from a list of styles
that you can use for borders.

5. Choose a color for the border by using the Color dropdown menu and then specify
a width (in pixels) for the border.
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FIGURE 5.7

The Borders and Shading dialog box
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6. In the Padding section, type the values (in pixels) in the Left and Right boxes for
applying padding to the left and right boundaries of the text paragraph. Padding
specifies the amount of space from the border where the text begins.

7. In the Preview section, click the appropriate buttons to apply the left and right bor-
ders to the text. The preview shows how the borders appear inside the Web page. You
can also click in the Preview box to set the borders.

8. Click the Shading tab and then choose the background and foreground colors by
using the Fill section. The Preview section shows a minor preview of the background
color that’s applied to the paragraph. If you want to specify a background picture for the
paragraph, you can do so by using the Patterns section.

9. Click OK and then save the Web page.

The formatting is again applied in the Design view of the Web page. The borders and shading for-
matting is also applied by using inline styles.

B It's important to understand that most of the borders and shading formatting is

s implemented by using CSS styles. When the formatting is applied, it’s not necessary
for the Borders and Shading dialog box to pick the settings back from the Web page for
modification with full fidelity (which might result in some confusion). To change the formatting,
it’s best that you clear the exiting style by using the Apply Styles task pane and apply a new one
instead. To clear the existing style, select the associated text line or paragraph, and in the Apply
Styles task pane, click Clear Styles. For more on the Apply Styles task pane, see Chapter 12.
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If you used the Pattern section in the Borders and Shading dialog box to set a background picture

for the selected text, you might be asked to save the picture locally inside your Web site if the pic-
ture doesn’t reside inside the Web site. You can simply specify the folder location inside your Web
site where you want to save the picture.

Using bullets and numbering
SharePoint Designer implements bulleted lists and numbered lists by using the <ul> and <ol>
HTML tags. To create a bulleted list and specify settings for it, follow these steps:

Create a Web page in SharePoint Designer and then open it in the Design view.

2. Place the cursor (or the insertion point) at the beginning of the line of text where
you want to begin the bulleted list.

3. Choose Format= Bullets and Numbering to open the Bullets and Numbering dialog
box, as shown in Figure 5.8, and then click the Plain Bullets tab.

FIGURE 5.8

The Plain Bullets tab in the Bullets and Numbering dialog box
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4. Choose the bullet style and then click OK. SharePoint Designer creates a bulleted list
by using the bullet format you chose.
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To create new bullet points in this bulleted list, simply press Enter right after the
end of a line of bulleted text.

To remove a bullet point from the list, place the cursor at the beginning of the line
of text corresponding to the bullet and then press Backspace. Or you can right-click
on the line of text corresponding to the bullet, choose List Item Properties from the
popup menu to open the Bullets and Numbering dialog box, and then choose the No
bullets option.

You can also create sublists inside the bulleted list by using these steps:

1.

In your existing bulleted list, create a new bullet point by pressing Enter right after
the end of a line of bulleted text.

Press Ctrl+M or click the Increase Indent Position button on the Common and
Formatting toolbar. This creates a child bullet list inside the existing bullet list. To add
new bullet points to this child list, press Enter right after the end of a line of bulleted text.

To remove a bullet point from the child list, press Ctrl+Shift+M or click the
Decrease Indent Position button on the Common and Formatting toolbar.

Using the previous steps, you can create inherited lists of multiple levels. In the Code view of the
Web page, SharePoint Designer uses the <ul> tags for creating the bulleted list. The list items are
created by using the <11i> tag. Also, the style created while creating the list uses the 1ist-
style-type property to specify the style of the bullet being used.

OIE

B The <ul> tag represents the unordered list and is used to create bulleted lists.

% The <ol> tag, on the other hand, represents the ordered list and is used to create

numbered lists.

If you want to add your own pictures instead of the existing bullets, use the Picture Bullets tab in
the Bullets and Numbering dialog box:

1.

On the bulleted list you created by using the previous exercise, click the line of text
corresponding to the bullet point where you want to change the bullet to a picture
of your choice.

Choose Format=> Bullets and Numbering to open the Bullets and Numbering dialog
box, as shown in Figure 5.9, and then click the Picture Bullets tab.

In the Picture section, click the Specify Picture radio button and then click Browse
to locate the picture you want to use instead of a bullet point.

Click OK and then save the Web page.

Because a picture appears instead of bullet points, make sure that you choose
“ a picture of smaller dimensions. This ensures that the Design view of the list

doesn’t become confusing and unmanageable when the picture is selected for the list.
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FIGURE 5.9

The Picture Bullets tab in the Bullets and Numbering dialog box
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You can create numbered lists instead of bulleted lists in the same manner by selecting the format
by using the Numbers tab in the Bullets and Numbering dialog box. You can also mix the num-
bered list with the bulleted lists. In other words, you can create a parent list as a numbered list and
then a child list (created by using the Increase Indent Position button) inside it as a bulleted list or
vice versa.

Positioning Web content

The Position dialog box (accessed by choosing Format = Position), as shown in Figure 5.10, allows
you to position content on the Web page by using a set of positioning CSS styles and HTML tags.
It also provides the option for you to overlap content on Web pages, which enables you to create
callouts and screen tips.
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The Position dialog box
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It’s really

important to understand the various positioning options available in CSS to choose

which one is best for your design. Here are the CSS positioning options:

Static: By default, when a browser displays the contents of a Web page, the object has a
static position in the display window.

Absolute: With this option, you can specify the top, left, right, and bottom distances
from the parent’s position where the object should be placed.

Relative: This option allows you to position the object relative to its original position
inside a Web page. The object’s original position is marked by an anchor sign in the
Design view.

Fixed: This option allows a browser to identify content with respect to the main window
so that the object maintains its position relative to the window even if the content is
scrolled.

The Position dialog box also allows you to specify the location of the object by using the left, right,
top, and bottom dimensions as well as set the change in width and height of the location. You can
also specify the overlapping position of the content by using the Z-Order box.
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Understanding Frames

Frames in HTML provide Web page designers with a means to divide their page layout into sec-
tions and then use these sections to manage content. A typical scenario is to divide the Web page
into a header, a footer, a left navigation section, and a contents section. Hyperlinks in one section
can then be used to display contents in another section. For example, you can create a navigation
hyperlink set in the left section so that clicking on the hyperlinks changes the Web page displayed
in the contents sections.

Frames are implemented by using a frameset page that becomes the backbone page on which the
frames are laid out. Then, the Web pages for each frame within the frameset page are set. To create
a new Frames Page, follow these steps:

1. Choose Filew> New to open the New dialog box.

2. Click the Page tab and then click Frames Pages. Under this option, choose the Header,
Footer and Contents template.

3. Click OK. The selected template opens in the Design view, as shown in Figure 5.11

FIGURE 5.11

A template open in the Design view
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Along with the Design, Code, and Split views, there’s now another view called No Frames view.
This view indicates the display of the Web page for Web browsers that don’t support frames. If you
click the Code view tab, you can see the Code view of the frameset page.

As mentioned before, this page provides the frames skeleton that hosts other pages shown inside
the frames. You can use the Design view to change the dimensions of the frames inside the frame-
set page by dragging the frame boundaries to your preferred width and height.

If you want to split a frame, press Ctrl while dragging the frame boundary to the required width or
height. This splits the existing frame into two frames. You can change the width of the splitting
lines by right-clicking on the frameset page and then choosing Page Properties from the popup
menu. The Frames tab, as shown in Figure 5.12, then appears in the Page Properties dialog box.

FIGURE 5.12

The Frames tab in the Page Properties dialog box

General I Advanced I Custam I Language Frames I

Erarne Spacing: lz_j

¥ Show Borders

QK I Cancel |

112

You can use the Frame Spacing box to change the width of the splitting lines. Also, you can dese-
lect the Show Borders check box if you don’t want to show the splitting lines. You can also access
the Frames tab by clicking Frames Page in the Frame Properties dialog box, as shown in Figure
5.13. You access this dialog box by right-clicking on the frame in the Design view.

You can use the Frame Properties dialog box to set the name, title, initial page, and description asso-
ciated with a frame. The name of a frame is used when targeting hyperlinks to specific frames inside
the frameset page. You can also choose whether to show the scrollbars if the contents of the page
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inside the frame extend beyond the frame’s width and height. Keep the Resizable in browser check
box selected if you want Web page viewers to be able to resize the frame in the browser window.

FIGURE 5.13

The Frame Properties dialog box
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Creating pages using frames

In this exercise, I take you through the steps for creating a navigation-based frameset page. If you
completed the other exercises, you should already have at least three Web pages that can be dis-
played in frames:

1. Choose File=> New to open the New dialog box, click the Page tab, and then click
Frames Pages to choose the Header template.

2. Click OK. The Header frame in this template hosts a page that contains hyperlinks that
open the corresponding Web page in the main section. The frames page created by using
the Header template has two frames: the header frame (on the top) and the main frame.

3. Right-click on the frameset page and then choose Page Properties from the popup
menu. The Page Properties dialog box opens.

4. Click the Frames tab, deselect the Show Borders check box, and then click OK.

Click the New Page button in the Header frame to create a new page. You use this
page to create hyperlinks for navigation.
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6. Right-click on the newly created header and then choose Hyperlink from the popup
menu to open the Insert Hyperlink dialog box.

In the Text to display box, type a display name for the hyperlink.

Type the location of the initial Web page of the main frame by using the Address
text field or by choosing the Web page from the Look in box.

9. Click OK to finish creating the hyperlink. Clicking on this hyperlink opens the first
page in the main frame.

10. Repeat steps 5 and 6 to create two more hyperlinks in the header for displaying the
second and third Web pages.

11. Click Set Initial Page in the main frame to set the frame page as the page you used
for creating the first hyperlink in step 8 and then click OK when you finish.

12. Press Ctrl+S to save the frames page and the header page.

When you browse to this page, clicking on the links in the header frame opens the corresponding
Web page in the main frame. The page created by using the Header template is designed so that
every hyperlink link opens in the main frame. In other words, the main frame is the target frame
for all hyperlinks.

Using inline frames on Web pages

As discussed earlier, when you use frames for designing Web pages, you have to create a skeleton
page that hosts all the frames. However, there may be cases where you might want to show the
contents of a Web page inside an existing Web page without using a separate frameset page. You
can accomplish this using inline frames.

Inline frames behave like standard frames except they can be placed directly inside the Web page
you're designing. To insert and configure an inline frame on a Web page, follow these steps:

Create a new Web page by using SharePoint Designer.

2. Choose Insert=> HTML = Inline Frame to insert an inline frame on the Web page.
The inline frame opens in the Design view, allowing you to set the initial page.

3. Right-click on the inline frame and then choose Inline Frame Properties from the
popup menu. The Inline Frame Properties dialog box, as shown in Figure 5.14, opens,
allowing you to set the name, title, initial page, and description. You can also change the
display text to be shown for browsers that don’t support inline frames, set the scrollbar
settings, and choose whether to display a frame border.

Close the Inline Frame Properties dialog box.

Set the Web page to be displayed in the inline frame by clicking the Set Initial Page
button.

6. Click OK.

Inline frames are implemented by using the <iframe> HTML tag. If you click the Code view tab
after you set the properties, the attributes for the inline frame appear with <i frame> tags.
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The Inline Frame Properties dialog box
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Creating Hyperlinks and Bookmarks

One of the most common operations that you perform on a Web page is to create hyperlinks to
content. Hyperlinks provide navigation for Web sites and link content placed at different locations
inside a Web site. The basic attributes of a hyperlink include display text and a URL that the
hyperlink points to. When you click hyperlinked display text, the Web browser directs you to the
URL connected to that hyperlink. You can create hyperlinks to almost any type of content, includ-
ing pictures, Web pages, documents, executables (.exe, .d11, etc.), and bookmarks.

You create hyperlinks in SharePoint Designer by using the Insert Hyperlink dialog box, as shown
in Figure 5.15. You access this dialog box by choosing Insert = Hyperlink or pressing Ctrl+K. This
dialog box is also used for editing hyperlinks (although the name changes to Edit Hyperlink).

The Insert Hyperlink dialog box allows you to create hyperlinks by using these panes:

B Existing File or Web Page: The default pane allows you to choose a file from the

Current Folder, Browsed Pages,

or the Recent Files list. The files or Web pages that are

currently open in SharePoint Designer show up with (open) at the end of the filename.
You can use the Look in dropdown menu to locate the content you want to create a

hyperlink for.
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B Place in This Document: Allows you to create hyperlinks to bookmarks on the Web
page you currently have open in SharePoint Designer. If no bookmarks have been cre-
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ated, the list is empty.

B Create New Document: Allows you to create a hyperlink to a new document. The inter-
face allows you to change the location of the new document and then specify a target
frame for the hyperlink. You can also choose whether you want to edit the newly created

document right after creation or later.

B E-mail Address: This option allows you to create a hyperlink to an e-mail address and

specify parameters.

FIGURE 5.15

The Insert Hyperlink dialog box
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Also, there are a number of buttons in the Insert Hyperlinks dialog box that allow for these

operations:

B Screen Tip: Allows you to specify the screen tip displayed when you hover over a hyper-
link. A screen tip can be used to display information about the content that the hyperlink

points to.

B Bookmark: Displays the list of bookmarks present on the document that you've chosen
as the URL for the hyperlink and allows you to add the bookmark to the hyperlink

B Target Frame: Allows you to choose the frame where the target document of the hyper-

link should open
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B Parameters: Allows you to specify parameters sent along with the hyperlink. These
parameters form the query string in the hyperlink and can be used by the target docu-
ment for performing various operations. This is especially useful in performing form-
based operations by using ASP, ASP.NET, and FrontPage components.

B Remove Link: Removes the link from the Web page

Bookmarks act as anchors that you can insert on Web pages at specific locations of interest and
later use hyperlinks to navigate to those locations. They’re especially useful if you have a long Web
page and you want a Web browser to be able to go directly to a location on the Web page rather
than have a user scroll down to the location. You can create a bookmark on a Web page by follow-

ing these steps:

1. Place the cursor at the location on the Web page where you want to create the
bookmark.

2. Press Ctrl+G or choose Insert= Bookmark to open the Bookmark dialog box,
as shown in Figure 5.16. You use this dialog box to manage the bookmarks on the
Web page.

FIGURE 5.16

The Bookmark dialog box
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3. Type the name of the bookmark and then click OK.

When you view the Code view after inserting a bookmark, the bookmark is just an <a> tag with a
Name attribute specified for it. To create a hyperlink to your newly created bookmark, follow these

steps:

117




m Developing Web Page Components

118

1. Select the text on which you want to create a hyperlink. This could be a word or line
of text at the top of your Web page. When you click the hyperlink, the browser takes you
to the location on the Web page where the bookmark was placed.

2. Right-click on the selected text and then choose Hyperlink from the popup menu.
Or you can click the Hyperlink button on the Common toolbar to open the Insert
Hyperlink dialog box. The Text to display box shows the text you selected on the Web
page for creating the hyperlink on.

3. In the Existing File or Web Page pane, choose the Web page where the bookmark
exists.

4. Click the Place in This document icon. The Select Place in Document dialog box
opens, displaying all the bookmarks in the document selected in step 3.

5. Choose the bookmark you want to use with the hyperlink and then click OK. The
bookmark is indicated in the hyperlink by its name after the # sign.

6. Click OK.

To preview the Web page in a browser, press F12. If the page is long enough (to activate scrollbars
in the browser), when you click the newly created hyperlink, the page automatically scrolls to the
location of the bookmark.

Creating parameters in hyperlinks

Sometimes, you might want to send some information with hyperlinks. This information could be
used by scripts running on the target Web page to perform operations. For example, you can send
values of variables that could be used by an ASP target page to retrieve information from a database.

Sending parameters in a hyperlink involves creating a query string along with the hyperlink. A
query string is a string concatenation of name-value pairs of variables that you want to send with
the request for the target Web page. The target Web page can use these name-value pairs for oper-
ations by using client- or server-side scripts. To understand the SharePoint Designer interface for
creating parameters, the following steps take you through the process of creating a hyperlink that
has three parameters: ID, Name, and ZipCode:

Select the text on the Web page on which you want to create a hyperlink.

2. Right-click on the highlighted text and then choose Hyperlink from the popup menu
to open the Insert Hyperlink dialog box.

3. Choose the target Web page of the hyperlink by using the Existing File or Web Page
pane and then click Parameters. The Hyperlink Parameters dialog box, as shown in
Figure 5.17, opens.

4. In the Query String section, click the Add button. The Add Parameter dialog box
opens.

5. Type ID in the Name text field, type value 1 in the Value text field, and then click OK.
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FIGURE 5.17

The Hyperlink Parameters dialog box
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6. Repeat step 5 to add a Name parameter with value Texas and a ZipCode parameter
with value 75052.

7. Click OK to return to the Insert Hyperlink dialog box. The complete target URL of the
hyperlink is in the Address box.

8. Click OK.

The hyperlink that’s created as a result of the previous steps has this code after the name of the tar-
get Web page:

?ID=1&Name=Texas&ZipCode=75052

This portion of the URL forms the query string that’s passed on to the target Web page in the GET
request for the target Web page. A script on the target Web page can retrieve parameters from this
query string and then use them for performing its business.

Although in this exercise you created only static parameters with fixed values, you can create ASP
or ASP.NET Web pages where these parameters can have values filled dynamically (such as from a
database).

| For more on ASP.NET controls, see Chapter 10.
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Targeting frames in Web pages

Using the Target Frame dialog box, as shown in Figure 5.18, while inserting hyperlinks, you can
specify which frame window the target page should open in. You have these options available by
default in the Common Targets list:

Page Default: No target frame is specified.

Same Frame: Uses target=_self attribute to indicate that the target page opens in
the same frame window as the page containing the hyperlink

Whole Page: Uses target=_top to specify that the target page opens in the main
browser window

New Windows: Uses target=_blank to specify that the target page opens in a new
browser window

Parent Frame: Uses target=_parent to specify that the target frame opens in the par-
ent frame of the frame in which the current Web page is open

Other than the default options, the Common Target list also displays the frames that exist in the

current page where the hyperlink is being created. The Set as page default check box allows you to
set a particular frame as a default frame type for all hyperlinks in a Web page. This is done by add-
ing a <base> tag in the <head> section of the Web page, indicating that the default frame should

be used.

FIGURE 5.18

The Target Frame dialog box
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Using Tables and Table Layouts

Tables have been widely accepted as a versatile tool for laying out Web pages for the Internet.
Using tables, you can design the structure of a Web page and then fill in the content pieces as
needed. The use of tables also reduces formatting and positioning issues that might occur because
of the differences in computer screen size and resolution.

SharePoint Designer provides three main interface components to work with tables and related
features:

B Table menu: Allows you to insert, modify, and delete tables on Web pages. You can also
use this menu to convert text to tables and vice versa.

B Layout Tables task pane: Allows you to create table layouts for Web pages and provides
an intuitive interface to format and resize tables and cells. The task pane also allows you
to choose from a set of table layout templates on which to base your table layout.

B Table toolbar: This provides shortcuts to the most commonly used tasks in the Table
menu and the Layout Tables task pane.

To create a table on a Web page, follow these steps:

1. In the Design view, open the Web page in which you want to create the table.

NOTE. - If you want to ensure that new tables created in SharePoint Designer are assigned
. k’{\E SSSSS unique IDs for identification, click the Assign unique IDs to new tables check box in
the General tab of the Page Editor Options dialog box. This ensures that when you copy and
paste tables in the Design view, the unique IDs are used for easy identification of tables.

2. Choose Tabler> Insert Table to open the Insert Table dialog box, as shown in Figure
5.19. The Insert Table dialog box allows you to set the properties for the new table.

3. In the Size section, specify the number of rows and columns you want for the table.
You can type a rough estimate, as the number of columns and rows can be changed later.

4. In the Layout section, specify the text alignment, width, and height of the table and
cells. You can also set the cell padding and cell spacing values in this section. Cell pad-
ding specifies the amount of space from the border of the cell where text can be placed.
Cell spacing determines the amount of space between adjoining cells of the table.

5. In the Borders section, specify the width and color of the table border. You can also
click the Collapse table border check box if you want the adjacent borders of the table
and cells to overlap.

6. In the Background section, specify the background color to use for the table. If you
want to enable the layout tools for tables (discussed later in this chapter), click the Enable
layout tools check box. Also, you can click the Set as default for new tables check box if
you want to keep the settings you made in the previous steps for new tables

7. Click OK. A new table using the settings specified in the Insert Table dialog box is created.
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FIGURE 5.19

The Insert Table dialog box
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After the table is created, you can modify its properties by right-clicking on the table and then
choosing Table Properties from the popup menu. When you right-click on the table, the Cell
Properties menu option also appears. As shown in Figure 5.20, you can use the Cell Properties dia-
log box to modify the properties of the corresponding cell in the table.

Besides the ability to set formatting properties such as width, height, and text alignment, these set-
tings for the cells are also available:

B Header cell: You can specify whether the corresponding cell is a table header. Table
headers are cells specified with the <th> tag and have special formatting applied to them
(such as center alignment and bold text).

B No wrap: Keep the No wrap check box deselected if you want the noncontiguous text in
the cell to be wrapped once the table width is reached. If this check box is selected, the
width of the table is increased to accommodate the text without wrapping it.
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FIGURE 5.20

The Cell Properties dialog box
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Also, when you right-click on a table, a set of menu options is available for inserting, selecting,
modifying, and deleting the rows and columns of the table:

B Insert: Allows you to add a column, row, or cell to the left side or the right side of the
column, row, or cell where the cursor exists in the Design view

B Select: Allows you to choose the row, cell, or column where the cursor is active

B Delete: Allows you to delete the row, column, or cell in the table

B Modify: Allows you to merge or split cells and tables, apply predefined formatting to

tables, and auto-fit the tables to text inside them

In the next exercise, you use the auto-format feature to automatically format tables by using some
predefined formatting templates:

1. Choose Tablec> Insert Table to open the Insert Table dialog box and then create a
new table with the number of rows and columns of your choice.

2. Open the Table AutoFormat dialog box by either right-clicking on the table and
then choosing Modify=> Table AutoFormat from the popup menu or clicking on the
Table AutoFormat button on the Tables toolbar, as shown in Figure 5.21.
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FIGURE 5.21

The Tables toolbar
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3. Choose the format that you want to use for your table by using the Formats list in
the Table AutoFormat dialog box, as shown in Figure 5.22. Choosing a format shows
a preview of the format in the Table AutoFormat dialog box.

FIGURE 5.22

The Table AutoFormat dialog box
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4. Use the Formats to apply and Apply special formats sections to specify where you
want to apply the styles configured in the format selected in step 3.

5. Click OK. A new table with auto formatting is created.
When you apply auto formatting to the table, a number of CSS styles are created inside the Web

page. These styles are used to implement the formatting applied to the table and can be modified
by using the CSS SharePoint Designer interface.
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SharePoint Designer also inherits the FrontPage 2003 feature for creating and managing tables and
cells called Table Layouts. A layout table or cell is nothing but an HTML table or cell that has
SharePoint Designer layout tools enabled for it. Layout tools provide for resizing and management
of the tables. As mentioned earlier, you can have the layout tools enabled for a table inserted by
choosing Table > Insert Table and then clicking the Enable layout tools check box in the Layout
Tools section.

You can insert layout tables and cells by using the Layout Tables task pane, as shown in Figure
5.23. You access this task pane by choosing Task Panes©> Layout Tables.

The Layout Tables task pane has some default layout plans for tables that you can use to design
your Web pages. These layout tables are listed in the Table layout section of the Layout Tables task
pane. To insert a layout table based on a template, simply open a Web page, place the cursor at the
location where you want the layout table to be placed on the page, and then click the template in
the task pane.

The following exercise can help you understand how you can use the layout tools to design your
tables in SharePoint Designer. If used correctly, layout tools can be of great help in resizing and
formatting table layouts. In this exercise, you use the Layout Tables task pane to create a new lay-
out table and then insert and resize layout cells in it:

1. Create a new HTML page by choosing File=> New. The New dialog box opens. Ensure
that the Layout Tables task pane is enabled by using the Task Panes menu option.

2. Click the Insert Layout Table button in the Layout Tables task pane. A new table
with one row and one column, with layout tools enabled, appears on the Web page. By
default, a layout table is represented with a green border in the Design view when you
hover over the table border. You can click the green border to see the resizing tools. You
can view the properties of this table by using the Table Properties dialog box, just like
with any other HTML table. On all four sides of the table, you have dropdown menus
showing the width of that side. Clicking on the dropdown menu on the top or the bot-
tom of the table shows these options:

Change Column Width: Allows you to change the width of the selected column

Make Column Autostretch: Specifies the width in percentages and uses it to auto-
stretch the columns based on the width of the page

Use Column Spacer Image: Inserts a placeholder image (a white-colored image of
the width and height of the column) in the table cell

3. Click the dropdown menu for the top table side and then choose Make Column
AutoStretch. The display text of the dropdown menus on the top and bottom sides
changes to reflect the percentage of page width being used.

4. Place the cursor inside the layout table you just inserted and then click the Insert
Layout Cell button on the Layout Tables task pane to open the Layout Cell
dialog box.
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FIGURE 5.23

The Layout Tables task pane
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Keep the defaults in the Layout Cell dialog box and then click OK. The one cell that

exists in the layout table is now converted into the Layout Cell. By default, a layout cell is
represented by a blue border in the Design view. You can click the blue border to enable

the resizing tool for the layout cell.

Use the resizing boxes (small square boxes) on the blue border to resize the layout
cell to half the height and width of the layout table.

Ensure that the layout cell is selected (a blue border shows with the resizing boxes)
and then click the Insert Layout Cell button on the Layout Tables task pane. The
Insert Layout Cell dialog box opens.

In the Insert Layout Cell dialog box, click the Vertical radio button in the Layout
section and then click OK. This ensures that the new layout cell is inserted vertically
next to the existing layout cell.

Using the resizing boxes, change the height of the new layout cell to half the height
of the layout table.
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10. Click the layout cell inserted in step 8 and then click the Insert Layout Cell button
in the Layout Tables task pane to insert another layout cell in the table.

11. Keep the defaults in the Insert Layout Cell dialog box and then click OK.
12. Change the width of the newly created cell to half the width of the table.
13. Click the Insert Layout Cell button again to insert another layout cell vertically

after the cell inserted in step 10. In the Insert Layout Cell dialog box, click the Vertical
radio button in the Layout section.

14. Click OK.

Avoid randomly resizing the layout cells and columns, as that may create unwanted

e == new cells in the layout table. Instead, make room for the new cell by systematically
resizing the existing cells and then fill the empty table space (indicated by a gray background)
with a new cell.

You now have a layout table with four layout cells in it. If you click the Code view tab, SharePoint
Designer recognizes layout tables by using HTML comments placed inside the HTML code of the
table and the cell:

<table cellpadding="0" cellspacing="0" style="width: 986px; height:

450px">
<!-- MSTableType="layout" -->
<tr>

<td valign="top">
<!-- MSCellType="empty" -->
&nbsp;</td>
<td valign="top" style="height: 213px">
<!-- MSCellType="empty" -->
&nbsp; </td>

</tr>

<tr>
<td valign="top" style="width: 537px">
<!-- MSCellType="empty" -->
&nbsp;</td>
<td valign="top" style="height: 237px; width: 449px">
<!-- MSCellType="empty" -->
&nbsp; </td>

</tr>

</table>

As highlighted in the previous code, there’s one layout table and four layout cells.

It's important to understand that you can’t resize a cell if there’s no room for the
resizing. For example, using the layout table you created in the previous steps, if
you try to resize the bottom-right cell from the top or the left outline, it won’t resize because
there’s no space to resize. Instead, resize the adjacent cells to make room for the cell and then
resize it accordingly.
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Working with Layers

A layer in SharePoint Designer is basically a <div> tag that’s absolutely positioned inside the Web
page. You can drag and drop layers anywhere around the Web page with relative ease and thus
layers provide a very simple design surface for laying out Web pages.

You use the Layers task pane shown in Figure 5.24 to work with layers. You access this task pane
by choosing Task Panes=> Layers.

FIGURE 5.24

The Layers task pane

Layers

To create a new layer and configure its settings, follow these steps:

1.

Open a Web page and then place the cursor where you want to insert the layer. To
easily understand the layer positioning, choose View = Formatting Marks = Show.

Choose View = Formatting Marks and ensure that all menu options except Show
and Positioned Absolute are disabled.

Click the Insert Layer button in the Layers task pane. A layer (a <div> tag) is created
on the Web page. Also, the anchor formatting mark appears, showing the location where
the layer was actually inserted. The newly created layer is displayed in the Layers list in
the Layers task pane.

Drag the layer to the location where you want to place it for absolute positioning.

To create another layer inside the Web page, place the cursor outside the existing
layer and then click the Insert Layer button.

To create a nested layer (a layer inside the existing layer), place the cursor inside
the existing layer and then click the Insert Layer button.

You can also nest layers by using the Layers task pane to drag the layer you want to
“ nest into the parent layer. To un-nest the layer, simply drag the layer into the Layer

list header.

7. You can now place your text, pictures, or other content inside the layer and then
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position it by using Layers. Using this method, you can easily lay out and format Web
pages.
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OTl I It's important to understand that because layers are absolutely positioned, any
IAEC content on the page that’s not absolutely positioned might appear to have moved
when you view the Web page in a browser. It’s best that when you use layers heavily, you
absolutely position all content on the Web page to maintain formatting.

The cool feature about layers is that along with the ability to position them in the horizontal plane,
they can also be positioned vertically — in other words, you can overlap them (in the Z dimen-
sion). Every time a layer is created, a z-index attribute is set for it. The layers with higher
z-1index values appear on top of layers with lower z-index values.

The Z column in the Layer task pane shows the z-index value for a layer. You can change this
value by right-clicking on a layer in the Layer task pane and then choosing Modify Z-Index from
the popup menu, which also has these options:

B Cut, Copy and Paste: Allows you to cut, copy, and paste the layer from one location to
another

B Visibility: You can choose whether you want the layer to be visible or hidden by using this
menu option. The menu options set the visibility style (such as visibility:hidden) for
the <div> tag associated with a layer. If a layer is set to be hidden, it’s represented with a
closed eye in the first column in the Layers list. If it’s set to visible, it’s represented with an
open eye.

B Modify Z-Index: Used to modify the Z order of the layer

B Modify ID: Used to modify the ID for the layer

B Borders and Shading: Opens the Borders and Shading dialog box for setting properties
for layer borders and background

W Positioning: Opens the Position dialog box

The real functionality of setting layer visibility becomes apparent when you change the visibility of
a layer to show or hide it dynamically. SharePoint Designer provides a feature called Behaviors that
enables you to implement such functionality without having to manually write code.

E‘F For more on Behaviors, see Chapter 8.
= \'l:-:'

Summary

In this chapter, I discussed the basic page layout features of SharePoint Designer. You learned
about the font and paragraph formatting of Web content. I also discussed how you can use the
borders, shading, bullets, and numbering features of SharePoint Designer to enhance the look of
text on Web pages. Later in this chapter, I took you through a number of exercises to help you use
tables and layers to lay out Web pages.
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rom your exposure to the SharePoint Designer interface in the previ-

ous chapters, you should be comfortable with the Design and Code

views. However, some features of these views can help you further
enhance your designing capabilities with SharePoint Designer.

In this chapter, I discuss the designing aids and tools that SharePoint
Designer provides for ease of designing Web pages and placing content in
the Design view. I show you how you can use the Quick Tag Selector to
quickly locate and highlight components and sections on Web pages. I also
discuss special tools, such as Format Painter, Paste Special, etc., that provide
ways to replicate formatting across Web pages.

Also, 1 take you through features, such as IntelliSense and code checking,
offered by the Code view in SharePoint Designer that give developers a refer-
ence that they can use while writing code for Web pages in the Code view.
Later in this chapter, I talk about Find and Replace and how you can use this
awesome tool to quickly find and replace content, HTML tags, and code
across an entire Web site.

SharePoint Designer offers Web site developers a number of tools that pro-
vide the ability to easily reuse content without having to re-create all the for-
matting associated with it. You can import content from other applications,
such as Microsoft Word, and still retain the formatting applied to the con-
tent. This special copy and paste feature allows you to develop content by
using the program of your choice and still maintain the formatting to a large
extent. Along with this, you also have an option to repeat the formatting
applied to one section of the content to another section. These features pro-
vide the flexibility, speed, and simplicity needed when designing Web con-
tent with other applications.

131

Working in the Design view

Working in the Code view

Using the Find and Replace
features

Working with the Quick Tag
Selector




m Developing Web Page Components

1 begin by taking you through an exercise that helps you understand how you can use SharePoint
Designer features to move content with formatting from one page to another or from a document
to a Web page:

132

1.

Using an advanced text editor, such as Microsoft Word, open or create a document
with text that has some formatting applied to it.

Press Ctrl+C or choose Edit=> Copy to select and copy the contents of the document
so that they’re placed in the Clipboard. Choose Task Panes= Clipboard to show the
Clipboard task pane and view current and previous contents of the Clipboard.

In SharePoint Designer, open the Web page where you want to move the copied
content.

Place the cursor at the location on the Web page where you want to paste the con-
tent and then press Ctrl+V or choose Edit=> Paste to paste the copied content. The
content is placed on the Web page, and the formatting applied in the original document
is retained. Also, the small Paste Options menu appears beside the content that you just
pasted.

Click the Paste Options menu to show these menu options, which appear as radio
buttons:

Keep Source Formatting: Retains the formatting applied to the content being pasted
Remove Formatting: Removes the formatting applied to the content being pasted

Keep HTML Only: Only formatting applied as HTML is kept. Other formatting, such
as styles, isn’t retained.

Keep Text Only: Opens the Paste Text dialog box (also accessible by choosing
Edit=> Paste Text), where you can specify whether the paragraph, line breaks, and
rows should be retained

If you don’t want to use the Paste Options menu and want to hide it, you can do so by deselecting
the Show Paste Options Buttons check box (in the Cut and Paste Options section) in the General
tab of the Page Editor Options dialog box.

While the Paste Options menu allows you to specify whether you want to keep the formatting
applied to the text, there might be cases where you just want to keep the formatting but not the
text or content. To replicate formatting applied at one location to another in the same Web page or
across different Web pages, you can use the Format Painter. The Format Painter is available as a
button in the Standard toolbar, which can be enabled by choosing View > Toolbars.

To use the Format Painter to replicate the formatting used on text in one location and apply it to
text in another location, follow these steps:

1.

Open the source Web page that contains the content with formatting you want to
replicate and then open the destination Web page where you want to apply the
formatting.

In the Design view of the source Web page, place the cursor at the location where
you want to copy the formatting from.
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3. Click the Format Painter button in the Standard toolbar. The mouse pointer changes
to a paintbrush. SharePoint Designer has now copied the formatting that was applied to
the text at the location where the cursor was placed.

4. Click the destination Web page in SharePoint Designer by using the tabbed inter-
face. The mouse pointer is still shown as a paintbrush.

5. Using the mouse, highlight the content where you want to apply the formatting you
copied in step 3. The formatting that SharePoint Designer copied is applied to the con-
tent in the destination Web page.

Working in the Design View

Before discussing the Design view features of SharePoint Designer that enhance your designing
experience, I want to discuss the Color Coding tab, as shown in Figure 6.1, in the Page Editor
Options dialog box.

FIGURE 6.1

The Color Coding tab in the Page Editor Options dialog box
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As shown in previous chapters, various SharePoint Designer layout tools, components, and con-
trols are represented by certain colors in the Design view. For example, the layout table is repre-
sented with a green border, the layout table cell with a blue border, etc.

The Color Coding tab in the Page Editor Options dialog box allows you to set colors that represent
these features in the Design view. If you don’t feel comfortable with the default color settings, you
can change the colors in the Color Coding tab. If you want to revert the changes you make to the
colors here, click Reset Defaults.

Using visual aids and formatting marks

The View menu in SharePoint Designer allows you to enable visual aids and formatting marks in
the Design view. You use these two tools to obtain a detailed visual look at tags, placeholders,
spaces, carriage returns, etc., on a Web page in the Design view. It’s especially useful to indicate
and locate components and content formatting that normally hide in the Design view, such as lay-
ers with the visibility style set to hidden.

Choose View = Visual Aids to choose from these menu options:
B Show: Shows the visual aids selected in the Visual Aids menu in the Design view. You
can press Ctrl+/ to show all the selected visual aids. By default, all visual aids are selected.

B Block Selection: Displays a dotted rectangle around certain tags

W Visible Borders: Makes the borders visible only for reference in the Design view when
the borders have been disabled for a component

B Empty Containers: Displays a dotted rectangle around empty objects in the page

B Margins and Padding: Displays the margins and padding applied to a Web page, tables,
paragraphs, etc., in the Design view

B CSS Display:none Elements: Displays the elements (HTML tags or controls) that have
the display:none style applied to them

M CSS Visibility:hidden Elements: Displays and indicates the location of the elements
that have visibility:hidden style applied to them

B ASP.NET Non-visual Controls: Displays the ASP.NET controls that don’t have a visual
interface — for example, data source controls, such as SQLDataSource, for reference —
on a Web page

B ASP.NET Control Errors: Displays the errors in the Design view for ASP.NET controls
that error out while rendering the Web page

B Template Region Labels: Displays the names of the editable regions when working with
Dynamic Web templates (DWTs)

= For more on Dynamic Web templates (DWTs), see Chapter 13.
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B Visual aids might affect the formatting and positioning of your Web page in the
% Design view to a certain extent but shouldn’t affect the Web page itself, as the
visual aids aren’t shown in the browser.

You can also toggle visual aids on or off by using the Visual Aids panel in the status bar of
SharePoint Designer. As previously discussed, you can enable or disable the status bar via the
Application Options dialog box, which you access by choosing Tools=> Application Options.

Like Visual Aids menu, the Formatting Marks tool shows the locations in the Design view of HTML
tags and other formatting applied on a Web page. Choose View = Formatting Marks to choose
from these menu options:

W Show: Shows the formatting marks selected in the Formatting Marks menu in the Design
view. You can press Ctrl+Alt+/ to show all the selected formatting marks. By default, all
formatting marks are selected.

B Tag Marks: Shows the HTML tags in the Design view

The Layout Tables task pane is disabled when you enable Tag Marks.

B Paragraph Marks: Shows the location of the end of a paragraph

B Line Breaks: Shows in the Design view where the <BR> tags are present

B Spaces: Indicates the location of empty spaces (&nbsp;) inside a Web page
|

Comments: Shows where the HTML comments are located inside a Web page. HTML
comments aren’t rendered in the Design view, so this option can help you quickly iden-
tify where in the Web page code HTML comments have been placed.

B Script Blocks: Indicates the location of the script blocks in the Web page code

B Positioned Absolute: Displays an anchor that shows the location of the content, such as
layers with absolute positioning

B CSS Display:none: Indicates tags on which the display :none style has been used for
reference in the Design view

B Hidden Form Fields: Shows the location of the hidden form fields on a Web page

Enabling formatting marks can act as a great way to learn about the HTML tags
“ associated with the components that you can insert by using the SharePoint
Designer user interface. However, they might cause confusion if you enable them on large
Web pages.

Using rulers and grids

The Ruler and Grid functionality offered by SharePoint Designer allows you to quickly position
components, such as tables and layers, on Web pages. Choose View > Ruler and Grid to enable the
Ruler and Grid menu for the Design view. The Ruler and Grid menu has these options:
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B Show Ruler: Displays a ruler at the top and left edges of a Web page. You can use this
ruler to quickly determine the top and left position of content on the Web page. It also
helps you determine the width and height of pictures, tables, layers, etc., on a Web page.
By default, the display unit of the ruler is pixels. You can change the measurement by
choosing View = Ruler and Grid = Configure.

B Show Grid: This displays a grid on the Design view of the Web page, which, combined
with the ruler, allows you to position content relative to each other.

B Snap to Grid: When selected, this option snaps the content to the grid when resizing in
the Design view.

W Set Origin from Selection: This sets the origin of the ruler from the selection in the
Design view; that is, the ruler begins from the left margin of the selection you make in the
Design view.

B Reset Origin: This resets the beginning of the ruler to the default settings.

B Configure: This opens the Page Editor Options dialog box for modifying the settings for
the ruler and grid.

The Configure menu option in the Ruler and Grid menu takes you to the Ruler and Grid tab, as
shown in Figure 6.2, in the Page Editor Options dialog box.

You can use this tab to configure these attributes of the ruler and grid for the Design view:

B Ruler and grid units: Allows you to specify the units to use for the ruler and grid

B Display Grid: Provides settings that allow you to modify the spacing, line style, and line
color

B Snapping Grid: Allows you to change the distance by which the content is snapped
when the Snap to Grid option is enabled (which you access by choosing View > Ruler
and Grid=> Snap to Grid)

Using and configuring the tracing image

Tracing images is one of the features introduced in FrontPage 2003 that has been carried over to
SharePoint Designer. The concept behind designing Web pages by using a tracing image is to pro-
vide a way to put an image in the background of the Design view interface, allowing the image to
be used as a reference for placing and sizing the actual content of a Web page.

In scenarios exploiting a tracing image feature, a Web designer would create the layout for the
Web page in the form of an image by using the tool of his or her choice. The designer would pro-
vide the image to the Web page developers, who then place the image as a tracing image in the
background of the Design view in SharePoint Designer. They can then easily set the content of a
Web page so that it fits the tracing image.

You can configure the tracing image you want to use for a Web page by choosing View = Tracing
Image = Configure, which opens the Tracing Image dialog box, as shown in Figure 6.3.
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FIGURE 6.2

The Ruler and Grid tab in the Page Editor Options dialog box
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FIGURE 6.3

The Tracing Image dialog box
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FIGURE 6.4

In the File Name text field, specify the location of the tracing image to be used. In the X and Y text
fields, set the coordinates (top and left) for where on a Web page the tracing image should be
placed. Also, the Opacity slider allows you to specify the transparency of the tracing image.

Working in the Code View

SharePoint Designer exposes a number of tools for the Code view to help developers with coding
for Web pages in an intuitive Visual Studio-like environment. Along with the Tag Properties task
pane, the Code view in SharePoint Designer can be used to write code blocks and set properties
and attributes of tags, controls, and components.

Like the Design view, the color coding settings of the Code view of SharePoint Designer can also be
changed using the Color Coding tab in the Page Editor Options dialog box. Although the default
settings here work just fine, the Color Coding tab simply provides a way for you to customize the
colors used for various types of code blocks in case you're not comfortable with the default color
settings.

While working in the Code view, it’s really useful to enable the Code View toolbar, as shown in
Figure 6.4. This toolbar exposes many buttons in a single, easily accessible location, helping you
avoid having to go through menus to access these features.

The Code View toolbar

Safen sEnl Jenebi bl e om e
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Starting from left to right, the Code View toolbar offers these buttons for the Code view:

B List Members (Ctrl+L): Displays the properties and events associated with the control
where the cursor is placed. For example, if you want to list all the HTML attributes asso-
ciated with a table tag, just place the cursor on any of the attributes (or the space between
the attributes) and then press Ctrl+L.

B Parameter Info (Ctrl+Shift+spacebar): Displays the parameters of the function
being used

B Complete Word (Ctrl+spacebar): Provides suggestions for auto-completing a tag or
control. Press Ctrl+spacebar to auto-complete words.

B Code Snippets (Ctrl+Enter): Opens a list where you can choose the code snippets you
created by using the Code Snippets tab in the Page Editor Options dialog box. Press
Ctrl+Enter to access the code snippets list at the location where the cursor is placed in the
Code view.
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=1 For more on code snippets, see Chapter 4.
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B Follow Code Hyperlink(Ctrl+[): A code hyperlink is a link in the Code view that takes
you to the location where the code block associated with the code that's marked as a
hyperlink exists.

B Next Code Hyperlink (Alt+<): Takes you to the next available code hyperlink
B Previous Code Hyperlink (Alt+—): Takes you to the previous code hyperlink

B Function Lookup: This dropdown menu in the Code view lists the client-side script
functions, if any, present on a Web page open in SharePoint Designer. Choosing a func-
tion takes you to the corresponding function definition in the open Web page.

B Toggle Bookmark (Ctrl+F2): Creates a bookmark on the Code view of the Web page.
Code view bookmarks can be used to identify lines of code and quickly jump from one
section of code marked by a bookmark to another.

Next Bookmark (F2): Jumps to the next available bookmark
Previous Bookmark (Shift+F2): Jumps to the previous bookmark
Clear Bookmarks: Removes all bookmarks from the Code view

Select Tag (Ctrl+:): Selects the tag along with the inner HTML and the contents

Find Matching Tag (Ctrl+;): Finds the matching starting or ending tag that corresponds
to the tag selected

Select Block (Ctrl+’): Selects the code block

B Find Matching Brace (Ctrl+]): Finds the matching starting or ending brace in the code
block

B Insert Start Tag (Ctrl+,): Provides the angle brackets to place the starting tags

B Insert End Tag (Ctrl+.): Provides the angle brackets to place the end tags

B Insert HTML Comments (Ctrl+/): Provides the angle brackets that can be used to place
HTML comments in a Web page

B Options: Provides an interface to enable or disable code wrapping, line numbers, code
checking, etc., for the Code view

B Microsoft Scripting Editor: Opens the Microsoft Script Editor, which can be used to
write code in an environment similar to Visual Studio

Most of these options are also available by choosing Edit=> Code View, choosing Edit= IntelliSense,
or by right-clicking on a Web page while in the Code view. However, the Code View toolbar con-
solidates these features for easy use. Remembering the shortcuts associated with these options can
also greatly expedite your development time.

The Page Editor Options dialog box also provides a set of tabs for provisioning various settings for
the Code view in SharePoint Designer.
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General tab
The Code View Option section in the General tab provides the same check boxes that are also

available via the Options button in the Code View toolbar:
Word wrap: Enables or disables word wrapping for the code blocks in the Code view
Auto indent: Automatically indents the code inside the Web page to show hierarchy

Line numbers: Displays the line number in a margin on the left side of the Code view

Selection margin: Provides a margin on the left side of the Code view to help with
selection

Highlight invalid HTML: Underlines HTML that’s deemed invalid based on the selected
document type declaration and schema. When you hover over invalid code, the Code
view shows a screen tip indicating the reason behind the invalidity.

B Highlight incompatible HTML: Underlines HTML that’s not compatible with the
selected document type declaration and schema

Code Formatting tab

The settings provided in this tab don’t make any real changes to the Web page code except format-
ting it in ways that make the Code view more comprehendible. Most of these settings determine
how the HTML tags and their attributes are formatted for viewing in the Code view. For example,
selecting the Tag names are lowercase check box ensures that the Code view shows the tags as
lowercase.

You can also specify the size of a tab (in character space units), the size of an indentation, and the
size of the right margins in the Code view. Also, you have a list of HTML tags for which you can
define the code formatting and line breaks.

The Use shorthand properties when generating styles check box at the bottom

- of the Code Formatting tab allows SharePoint Designer to create styles by using
shorthand — for example, font size: 120; font color: red; and font weight: bold can be
shortened to: 120, red, bold.

Code Snippets tab

The Code Snippets tab allows you to create, modify, and delete code snippets. Code snippets offer
a mechanism where you can create blocks of code that you would commonly reuse while writing
Web pages. You can then insert the code blocks at the required location by just pressing
Ctrl+Enter and then choosing the code block you want to insert.

By default, a number of code blocks are already available in the Code Snippets tab, as shown in
Figure 6.5.
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FIGURE 6.5

The Code Snippets tab in the Page Editor Options dialog box
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When you create a new code snippet, you define a keyword (and description) to identify the code
block associated with the snippet and then specify the code block text for the code snippet. In the
Code view, when you press Ctrl+Enter to choose the code snippet for insertion, you only see the
keyword and description associated with the code block.

IntelliSense tab

The IntelliSense tab, as shown in Figure 6.6, allows you to make settings for auto code completion
in the Code view. It offers several options that you can have IntelliSense enable:

B Auto Popup: The check boxes available here allow you to enable the automatic popup of

code reference boxes for HTML, CSS, ASP.NET, and client-side scripting.

Auto Insert: The options available in this section allow you to configure the automatic
insertion of closing tags and quotes around the HTML, CSS, and ASP.NET attributes.

B Code Hyperlinks: These check boxes allow you to enable code hyperlinks for CSS,
scripting, and Web page content, such as pictures, Web pages, etc.
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FIGURE 6.6

The IntelliSense tab in the Page Editor Options
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Understanding code hyperlinks

Code Hyperlinks is a feature that assists Web developers working on large projects to quickly jump
from one section of code to another related section. It saves time by helping you locate actual code
being referenced by a code hyperlink.

In the Code view, a code hyperlink looks just like a normal hyperlink that can be clicked to navi-
gate to the code being referenced at the location of the hyperlink. SharePoint Designer allows you
to use code hyperlinks to locate code and functions within the same Web page, different Web
pages, style sheets or script files, and other documents.

When you hover over a code hyperlink in the Code view, a screen tip indicates that you can press
Ctrl+click to jump to the code being referenced at the location. Clicking the code hyperlink in this
manner opens the associated file and highlights the code section for review.
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Using IntelliSense for auto code completion

IntelliSense is a feature shared by many Microsoft application development programs, providing
you with a ready reference to simplify the code-writing process. Like in most applications, in the
Code view, just by pressing Ctrl+spacebar at the location where you're writing code (HTML,
Script, ASP.NET, and CSS), a dropdown menu appears, allowing you to choose from a contextual
menu of functions, attributes, and properties.

Also, IntelliSense provides for the automatic completion of code, such as HTML tags, script braces,
etc. For example, you don't have to manually complete tags or care about quoting attributes when
IntelliSense is turned on. To see how IntelliSense works, follow these steps:

1. Open a Web page in the Code view.

2. Find the <body> tag inside the Code view, place the cursor after the ending angle
bracket of the <body> tag, and then press Enter.

3. Place a starting angle bracket (<) at the cursor location. A popup menu appears with
a list of HTML tags that you can choose from.

4. Choose the <a> tag from the popup menu and then press the spacebar. Another
contextual menu opens, showing you all the attributes and events associated with the
<a> tag.

5. Choose href from the popup menu. SharePoint Designer automatically places the
attribute with quotes and provides you with a button to pick a URL.

6. Click the Pick URL button to open the Insert Hyperlink dialog box and then choose
a file for the hyperlink.

7. Place a closing angle bracket (>) at the end of the inserted code. The closing tag (</
a>) is placed automatically to close the <a> tag.

8. Between the <a> and </a> tags, you can place the display text of the hyperlink.

You just created a hyperlink by using the IntelliSense feature of SharePoint Designer’s Code view.
Although this exercise was fairly simple, you can gauge the usability of this feature when working
with complex code.

Using the Find and Replace Features

SharePoint Designer offers an advanced Find and Replace tool that allows you to find and replace
content and code in the Design and Code views. This feature provides for searching in a Web page,
a set of Web pages, or all across a Web site open in SharePoint Designer. You can match content to
be searched by using expressions created with the regular expression syntax. Also, you can create
rules for specifying search criteria to match HTML tags and then choose to replace a tag, an attri-
bute within a tag, or the inner content of a tag.
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The user interface for Find and Replace is composed of the Find and Replace dialog box and the
Find 1 and Find 2 task panes.

Working with the Find, Replace, and HTML Tags tabs

You can access the Find and Replace dialog box, as shown in Figure 6.7, by choosing Edit= Find
or Edit=> Replace. To begin with, you can enable the Find 1 and Find 2 menus by using the Task
Panes menu. A Play button on both these panes also takes you to the Find and Replace dialog box.
The Find 1 and Find 2 task panes provide for running and comparing two search operations at the
same time.

a—m The Replace functionality of SharePoint Designer is an irreversible operation. You
i

can’t undo the replacement once it occurs. SharePoint Designer warns about this
before it runs the replacement operation on a Web site.

FIGURE 6.7
The Find and Replace dialog box
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The Find and Replace dialog box exposes its features using three tabs: Find, Replace, and HTML
Tags. All three tabs have a Search Options section that allows you to choose from a set of options
to define the scope and direction and set other settings.
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Find tab

The Find tab allows you to specify the text you want to search. You can also choose to create
search queries by using HTML rules and regular expressions, which are discussed later in this
chapter. To find some text or code, simply type it in the Find what text box and then click Find
All The Find task pane shows the list of Web pages where your search is successful. Also, the
Matched Text column highlights in red the text you typed in the Find what text box.

Replace tab

The Replace tab adds the interface to the Find tab for specifying the replacement text and options.
Considering that replacement is irreversible, it's recommended that you choose to find first to
understand the results retrieved and then run the replacement later. You need to specify the
replacement text in the Replace with text box and then click Replace to replace the first occurrence
of the text or Replace All to replace all occurrences.

HTML Tags tab

The HTML Tags tab allows you to specify a Find HTML tag and then choose a replacement action
to define what needs to be replaced or changed in the tag. Choose the HTML tag you need to find
by using the Find tag dropdown menu and then choose a replace action by using the Replace
action dropdown menu. The Replace action dropdown menu has these options:

B None: Only finds the tag and doesn’t perform any replace action

B Replace tag and contents: Shows a With text field where you can specify the replace-
ment text that replaces the selected tag and its contents

B Replace contents only: Allows you to specify the replacement text that replaces only the
contents of the tag

B Add after start tag: Allows you to specify the replacement text that's added after the start
of the selected tag

B Add after end tag: Allows you to specify the replacement text that’s added after the end
of the selected tag

B Add before start tag: Allows you to specify the replacement text that’s added before the
start of the selected tag

B Add before end tag: Allows you to specify the replacement text that’s added before the
end of the selected tag

B Remove tag and contents: Removes the selected tag and contents
B Remove tag: Removes the tag only

B Change tag: Provides a To dropdown menu that allows you to choose a replacement tag
for the selected tag

B Set attribute value: Shows an Attribute dropdown menu that allows you to choose the
selected HTML tag’s attribute and set a value for it

B Remove attribute: Allows you to choose an attribute for the tag that needs to be removed
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= NOTE

Most of the settings in the Search options section of the dialog box are common across all tabs:

B Find where: Allows you set the search scope. You can choose to search in the current
page, in pages selected in the Folder List task pane, in pages that are open, or all pages.

B Display results in: Allows you to choose the Find task pane where the results of the
search are shown

B Direction: When searching in a page, you can choose the direction of the search.

B Advanced: Provides check boxes that allow you to set if the search should match the text
case, find the whole word only, ignore white space differences, use regular expressions,
or find text in a source code

Besides this, the Search options section also provides you with two buttons (placed in the bottom
right) that allow you to open an existing query or save the query you create in the Find and
Replace dialog box for later use.

SharePoint Designer saves the query you create in the Find and Replace dialog box
WSS by using an XML format in an FPQ file.

Exploiting the HTML rules

The Find and Replace dialog box provides a cool feature to create matching criteria for your search
for HTML tags inside the Web pages. All three tabs in the Find and Replace dialog box have an
HTML Rules button. You can click this button to create HTML rules that help you drastically isolate
your search. For example, you can find all <a> tags inside the Web site pages that have the target
attribute value set to blank and then change the attribute to _self in a single operation.

To create a new rule, follow these steps:
1. In the HTML Tags tab in the Find and Replace dialog box, choose the <a> tag from

the Find Tag dropdown menu.

2. Click the HTML Rules button. The HTML Rules dialog box, as shown in Figure 6.8,
opens.

3. Click New Rule to enable the New Rule dropdown menu at the bottom of the
dialog box.

4. Choose the With Attribute menu option in the New Rule dropdown menu to enable
another set of dropdown menus in the dialog box.

5. In the [any attribute] dropdown menu, choose the target attribute. Keep the
Equals option selected in the next dropdown menu.

In the [any value] dropdown menu, choose _blank.
Click OK.
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FIGURE 6.8

The HTML Rules dialog box
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You just created an HTML rule that allows you to find all <a> tags that have the target attribute
set to _blank. You can now use the Find and Replace dialog box to specify the replace actions.

Using regular expressions

Regular Expressions is a standard mechanism used by a lot of programs to help identify text strings
in large amounts of text based on patterns. In simple terms, a regular expression is a format that
describes a pattern of characters in text. For example, the regular expression ca. matches all three-
letter words that have ca as prefix, such as cat, can, cap, etc.

The Find and Replace dialog box allows you to use these regular expressions to search for text or
text patterns in Web pages and replace them with the needed text. If you click the right-pointing
arrow next to the Find what text box, a menu appears showing you a number of commonly used
regular expressions, as shown in Figure 6.9.

Regular Expressions is a complex but intuitive way to perform searches across Web

L content by using SharePoint Designer. You can combine the characters displayed in
Figure 6.8 to make an advanced expression for comparison. For example, the [A-Za-z0-9] regular
expression matches all alphanumeric characters.
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FIGURE 6.9

The Regular Expressions menu in the Find and Replace dialog box
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Using incremental searches

Incremen

tal Search is another cool feature especially useful in the Code view. It allows you to

search for code by just typing the search text and then jump from one occurrence to another. To
use an incremental search, follow these steps:

1.

2.

In the Code view, open the Web page where you want to perform an incremental
search.

Press Ctrl+Alt+F to enable an incremental search. The mouse pointer changes, and
the status bar at the bottom of the SharePoint Designer window displays Incremental
Search: text.

Type some text that you want to search. The Code view jumps to the text and then
highlights it.

Press Ctrl+Alt+F to jump to other occurrences of the search text in the Code view.
Also, you can press Ctrl+Alt+Shift+F to reverse the direction of the incremental search.
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Working with the Quick Tag Selector

The Quick Tag Selector feature of SharePoint Designer allows you to quickly choose a tag and then
highlight the content or code associated with the tag in the Design or Code view. On Web pages
that have a lot of code, you can use the Quick Tag Selector to quickly identify the location of the
code for a specific control in the Code view.

The Quick Tag Selector, as shown in Figure 6.10, is placed just above the page view of the Web
page you're working on. It can be enabled or disabled by choosing View s> Quick Tag Selector.

FIGURE 6.10

The Quick Tag Selector
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To use the Quick Tag Selector, simply place the cursor at the location of your choice in the Design
view. The Quick Tag Selector shows you a breadcrumb trail-like view of the tags from the location
where you placed the cursor to the first parent tag. For example, if you have nested tables in the
body of the Web page and you place the cursor in a deeply nested cell, the Quick Tag Selector
shows you a view of tags that identify the container table row and table tags until you reach the
topmost parent tag. Just click the tag to highlight it in the Design or Code view.

If you hover over a tag in the Quick Tag Selector, an arrow on the right opens a dropdown menu.
This dropdown menu has these options:

Select Tag: Selects and highlights the tag in the Design or Code view

Select Tag Contents: Selects the contents of the tag only

Edit Tag: Opens the Quick Tag Editor, allowing you to make modifications to the tag

Remove Tag: Removes the tag if it doesn’t have associations with other tags

Insert HTML: Allows you to insert HTML code inside the tag by using the Quick Tag
Editor
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B Wrap Tag: Wraps the tag with the tag you specify in the Quick Tag Editor
B Positioning: Allows you to choose the positioning of the tag

B Tag Properties: Takes you to the dialog box corresponding to the tag you selected. For
example, clicking on the tag properties for the <body> tag opens the Page Properties
dialog box.

Summary

In this chapter, I discussed the various features and tools available to you when working in the
Code and Design views in SharePoint Designer. You also learned about Find and Replace, Regular
Expressions, Incremental Search, and the Quick Tag Selector.



ictures, animation, and multimedia form one of the key components

of a Web site; I don't really need to emphasize the importance of

these components. Probably one of the first questions that you would
ask of a product while designing Web sites is how easily can you work with
graphics and animation. SharePoint Designer makes it a very simple task to
work with pictures, create hyperlinks on pictures, and create photo albums
on your Web sites. You can either quickly make modifications to pictures
within SharePoint Designer or use it to open the picture in your favorite pic-
ture editor tool for editing. SharePoint Designer also allows you to add spe-
cial controls, such as applets, plug-ins (including media players, Flash, and
ActiveX controls), etc., on Web pages.

In this chapter, I take you through the features of SharePoint Designer
related to working with pictures and graphics. I discuss how you can use
SharePoint Designer to create hotspots on pictures as well as create photo
albums and thumbnails.

Inserting Pictures and Symbols

IN THIS CHAPTER

Most of the menu and toolbar options related to pictures are disabled until
you place the cursor on a Web page open in SharePoint Designer. Inserting
and working with pictures is simple enough, and once your Web page is
open, you just have to choose Insert= Picture to pick a picture you want to
insert on the page. You have the option of inserting a picture from a folder
location on your computer where you saved it, from a scanner or camera, or
from the pictures available in the Office clip art gallery.
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B Web pages in general are expected to load fast. Thus, it's recommended that you
% insert pictures of reasonable sizes on Web pages. This helps in loading the page

faster. The file types suggested for the Internet are GIF, JPEG, and PNG.

For example, to add clip art to your Web site, follow these steps:

1.

Open the Web page you want to add a picture to, click your cursor where you want
the picture to appear, and then choose Insert= Picture = Clip Art. The Clip Art task
pane opens. This task pane allows you to search for clip art and other media on your
computer and on the Microsoft Office Web site.

Type Designer in the Search for text field and then click Go. If you're connected to the
Internet, you might just find 0438675 .wm£. Or choose a picture you like and then
hover over it in the Clip Art task pane. You can also double-click the image. A menu but-
ton appears on the right side of the picture.

Click this menu button and then click Insert. You can also drag and drop the clip art
onto the Web page. Notice the Preview/Properties option in this menu. As shown in
Figure 7.1, this menu opens the Preview/Properties dialog box, which shows the name,
the size and resolution, and the location of the picture.

FIGURE 7.1

The Preview/Properties dialog box

Preview/Properties i |
Mame: j0149887 wnf
Type: WMF Image
Resolution: 261 {w) x 209 (h) pixels
Size: SKE
Created: 8/14/1998 10:45:41 PM
COrienkation: Landscape
Open with:  Windows Picture and Fax Yiewer
Keywords:
-
Farming
fFarming equipment
Farms
tractors
Captian: ;I
= | Refresh | = | Edit Keywords. ..

Paths

File: C:\Program FilesiMicrosoft OfficelMEDIANCAGCATLON0 149887 wmf
Catalog: C:\Program Files\Microsoft OfficeiMEDIAVCAGCAT LOVCAGTAT L0, MM
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4. When you insert the picture on the Web page, the Accessibility Properties dialog
box opens. You can use this dialog box to specify the alternate text for the picture. If you

don’t want this dialog box to appear every time you insert a picture, deselect the Show
this prompt when inserting images check box.

Alternate text is used by screen readers and narrators to read out the description
of the picture. Having an alternate text for pictures is one of the key requirements

of common accessibility standards. Ensure that the text you type provides a short and clear
description of the picture.

5. Click OK. The picture is then displayed on your Web page with the resolution indicated
in the Preview/Properties dialog box.

Click the picture, and the Design view shows a picture border with holders that you can use to
change the width and height of the picture. Also, notice that the picture is inserted as an <img> tag
on the Web page. A smart tag is also displayed at a corner of the picture, as shown in Figure 7.2.

FIGURE 7.2

A smart tag for pictures

Web Sike | |Untitled_13.htm*

X

 Clip Art

v x
[ 7]
im ~ || search For:
[ |
Search in:
| Selected collzctions | -|
Results should be:
| All media File bypes | v|
| —
e -

Only Modify Size Attribubes T ?}

) Resample Picture To Match Size
= =
y i g

]

N Cl'l
W
|&] organize clips. ..

Si‘ Clip art on OFfice Online

j N @) Tips for finding clips

To proportionally resize a picture, ensure that you hold Shift while dragging on

a corner handle. If you drag the picture from another handle, you change the
dimensions only for the side you grab.
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® You can automatically change the dimensions of a picture by double-clicking the

LASSSSSE picture. The Picture Properties dialog box opens, and under the Appearance tab,
you can change the height and width. Click the Keep aspect ratio check box to align the
proportions.

The smart tag has two options:

B Only Modify Size Attributes: This is the default option and signifies that only the width
and height attributes of the picture are changed when you modify the picture.

B Resample Picture to Match Size: When you choose this option, the picture is resampled
to fit the size, which means SharePoint Designer tries to refine the picture in its modified

width and height.

When you save the Web page with the picture on it, you're shown the Save Embedded Files dialog
box, which allows you to specify where you want to save the picture you inserted on the page. As
shown in Figure 7.3, the Save Embedded Files dialog box allows you to rename the picture and
specify the location where you want to save the file.

Besides allowing you to change the picture name and save location, the Save Embedded Files dia-
log box lets you to perform the following operations:

B Set Action: This option allows you to either save the picture within the Web site by
clicking the Save File radio button or use the picture from its original location, such as a
Web site on the Internet.

B Picture File Type: Discussed in the next section, this button allows you to change the
file type of the picture.

FIGURE 7.3

The Save Embedded Files dialog box

Save Embedded Files cd |
Embedded files to save: Picture preview:
: | Falder | Action |
Save
|
Rename Change Falder... Set Action. .. | Bickure File Type... |
[a]4 I Cancel |
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Setting picture properties

When you right-click on the picture you inserted on the Web page, a popup menu appears with a
set of tools available for modifying the settings for the picture.

Reset Size

As the name suggests, you can use this option to reset the picture size back to the original size
before modification. This option is only available in the menu if you’ve modified the size of the
picture in the current Web page editing session. SharePoint Designer doesn’t remember the origi-
nal size of the picture after you save the page and close it.

Resample

This option can be used after you modify the size of the picture. Like the resample option in the
smart tag for the picture, this option also resamples the picture after a change in size. Once used,
this option isn’t available until you modify the size of the picture again.

AutoThumbnail

The AutoThumbnail option allows you to automatically create a thumbnail of the picture on the
Web page. Choosing the AutoThumbnail option tells SharePoint Designer to create a smaller
thumbnail picture of the original picture.

As shown in Figure 7.4, the settings for how the thumbnail picture should be created can be speci-
fied by using the AutoThumbnail tab in the Page Editor Options dialog box.

You have the following options for configuring how SharePoint Designer generates the thumbnail
for the picture you choose to create a thumbnail for:

B You can specify the width of the thumbnail. Thumbnails are square images, so the width
you specify is used as the height of the thumbnail image.

B You can choose to have a border around the thumbnail image and specify the width of
the border in pixels.

B The thumbnail picture can also be set to have a beveled edge.

Change Picture File Type

If you want to change the file type of the picture, you can use the Picture File Type dialog box to
choose a file type that matches your needs. As shown in Figure 7.5, the Picture File Type dialog
box gives you a brief description of the file type, its recommended usage, and allows you to specify
the quality of the picture.

For GIF and JPEG file types, you have options to specify how the picture loads when viewed in a
browser. You can enable interlacing for GIF images and progressive passes for JPEG files by using
the Picture File Type dialog box.
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FIGURE 7.4

The AutoThumbnail tab in the Page Editor Options dialog box

General

Page Editor Options

Authaoring | Picture | Code Snippets I Ruler and Grid I IntelliSense I Font Families
AutaThumbnail | Default Fonts | Code Formatting | css | color Coding

Pixels: IIDU ﬁ

21|

oK I Cancel

FIGURE 7.5

The Picture File Type dialog box

Picture File Type i |

Criginal file: 0149857, wnf Crriginal size: 7.99KE

Changed File: 0149587, jpg Changed size: 6.49 KB

 GIF Best For line art and computer-generated drawings, Only 256 colors,
Insufficient color For many photaos.

i+ Biest For photos. Accurate color and small file size. Bad For line art and
computer-generated drawings.

" PMG-8  Similar to GIF but with better colar support,  This format isn't very comman
and isn't supported by all browsers,

¢ PMG-24  Similar to JPEG but with lossless compression and usually larger file size. This
format isn't very common and isn't supporked by all browsers.

Setkings:

Quality: I ag j
Lowering the Quality reduces the file size of the picture.
Progressive passes: I 0 ﬁ

Quickly displays a low-guality version of the picture and gradually
increases the quality.

oK I Cancel

156



Working with Graphics and Animation Components

Picture Properties

As the name suggests, this dialog box can be used to change the general settings for the selected
picture. As shown in Figure 7.6, the Picture Properties dialog box has the following tabs:

B General: Allows you to change the name of the picture and specify its alternate text.
Clicking Edit opens the picture in the associated picture editing program installed on
your machine. The Hyperlink section allows you to create hyperlinks on the picture. The
Accessibility section can be used to specify alternate text and description for the image so
it can be read by text reader programs.

B Appearance: Provides settings for positioning, margining, and resizing the picture. You
can specify the border thickness as well as the picture’s width and height.

FIGURE 7.6

The Picture Properties dialog box

Picture Propetties 2xl

General | Appearance I

Picture:
|:usoFt Office/MEDIASCAGCATL0/0149587 wimf Browse.., | Edit...

Picture File Type... |

Accessibility

[V Alternate Text: ||

Long Description: I Browse, .. |
Hyperlink.

Location: I Browse. .. |
Target Erame: I J Parameters. .. |

oK I Cancel I

Creating hyperlinks on pictures

You can create a hyperlink on your picture by choosing either Picture Properties or Hyperlink from
the popup menu when you right-click on a picture in the Design view.

The Hyperlink option opens the Insert Hyperlink dialog box, which you can use to create a hyper-
link or bookmark. The more interesting exercise, however, is to create multiple hyperlinks at spe-
cific locations on a single picture.
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SharePoint Designer provides the ability to create hotspots by using the Pictures toolbar. Hotspots
are hyperlinks that are active on a specific area within a picture. So, a single picture can have mul-
tiple hyperlinks on it. To create hotspots on a picture, follow these steps:

1. Choose View > Toolbars = Pictures to enable the Pictures toolbar and then drag it
to the toolbar area in SharePoint Designer to dock it.

2. Open the Web page that has the picture on which you want to create hotspots.
Ensure you're working in the Design view.

3. Hover over the buttons in the Pictures toolbar to find the Rectangular Hotspot but-
ton. The mouse pointer changes to a Pencil icon.

4. Using the mouse pointer, draw a rectangular box on a certain area of the picture
where you want to create a hyperlink. After the box is drawn, the Insert Hyperlink dia-
log box opens.

Using the Insert Hyperlink dialog box, create a hyperlink for the hotspot.
Click OK. Repeat these steps to create multiple hotspots in different areas of the picture.

Save the page and then preview it in a browser.

Now, when you hover over the picture, a number of hyperlinks are available. SharePoint Designer
implements hotspots using the <map> and <area> tags. Here is a piece of HTML code for a Web
page that has a picture with hotspots on it:

<map name="FPMap0" id="FPMap0">

<area href="http://spdexplorer:8009/button5.jpg" shape="rect"
coords="146, 36, 293, 95" />

<area href="http://spdexplorer:8009/button6.jpg" shape="rect"
coords="17, 131, 142, 185" />

<area href="http://spdexplorer:8009/Figurel5.2.JPG" shape="rect"
coords="185, 183, 262, 269" />

</map>

<img alt="" src="http://spdexplorer:8009/MPj04386750000([1].Jjpg"
width="384" height="351" usemap="#FPMap0"/>

Notice the <map> tag containing the <area> tags that have been created for each hyperlink in the
previous code. The <map> tag’s ID is then used as a reference in the picture’s <img> tag to enable
the hotspot.

Exploiting the Pictures toolbar

The Pictures toolbar, as shown in Figure 7.7, allows a Web site designer to perform some basic
operations on pictures that have been inserted on a Web page. As discussed in the previous sec-
tion, you've already used the Pictures toolbar to create and manage hotspots on pictures. Besides
creating hotspots, you can also perform the following operations:
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FIGURE 7.7

The Pictures toolbar

] G B4 ch b 20+l EE GO @ %

Insert Picture from File: Opens the Picture dialog box to allow you to choose a picture
to be inserted from a specific location

Auto Thumbnail: Automatically creates a thumbnail for the selected picture
Bring Forward: Changes the z-order of the picture to bring it to the top

Send Backward: Reduces the z-order of the picture to take it to the bottom of other con-
tent on the page

Rotate Left 90°: Rotates the picture to the left by 90 degrees
Rotate Right 90°: Rotates the picture to the right by 90 degrees
Flip Horizontal: Creates a horizontal mirror image of the picture
Flip Vertical: Creates a vertical mirror image of the picture
More Contrast: Increases the color contrast

Less Contrast: Decreases the color contrast

More Brightness: Increases the brightness

Less Brightness: Reduces the brightness

Crop: Allows you to crop a picture to desired dimensions. To crop a picture, click the
Crop button on the Pictures toolbar. Use the box that appears on a picture to set the
cropped dimensions. Click the Crop button again to implement the cropping.

Set Transparent Color: For GIF picture file types, this option allows you to set the
transparent color for the pictures. To use this option, you need to convert the picture to
the GIF file type.

Color: Allows you to change the look of a picture to grayscale or washout
Bevel: Add beveled edges a picture

Resample: Resamples a resized picture to improve quality

Select: Selects a picture

Rectangular Hotspot: Creates a rectangular hotspot

Circular Hotspot: Creates a circular hotspot

Polygonal Hotspot: Allows you to create a multisided hotspot

Highlight Hotspots: Shows the hotspots that have been created on a picture

Restore: Undoes the changes made to a picture in the current editing session
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Using symbols

Sometimes, you might need to insert some special symbols on your Web pages that allow you to
more accurately represent that data your Web pages are offering. Using the Symbol dialog box, as
shown in Figure 7.8, you can insert a symbol you need.

To insert a symbol on a Web page, follow these steps:

Place the cursor at the location on the Web page where you want to insert a symbol.
Choose Insert=> Symbol to open the Symbol dialog box.

Choose the font you want to use for the symbol by using the Font dropdown menu.

B wbd =

Choose the symbol from the list of symbols in the dialog box or choose from the
recently used symbols list. The Character code for the symbol is displayed in Unicode
encoding format. Specify the encoding that you want to use in the from dropdown menu.

5. Click Insert to place the symbol at the cursor location on the Web page and then
click Close to close the Insert dialog box.

While the font formatting is applied to the symbol using in-page styles and basic symbols, such as
®, ©, etc., are inserted as is in the code of the Web page, certain subsets of symbols are inserted as
numerical encodings, which are interpreted by a browser to display the actual symbol. For exam-
ple, the smiley symbol is inserted in the code of the Web page as &#9787 ;.

FIGURE 7.8
The Symbol dialog box

symbol
Font: [Times Mew Roman =l Subset: |Latin-1 Supplement
AEAEARI NN IR IR K ©
(2 ey ,IO”%%%E,AJ
AAJA|AJA|\E|C|E|E|E|E|T|T|T|1|D
N|O[O|O|0|0]|x|0|U|U|U|U|Y|B|B]|4a
ald|d|ld|lale|g|é|é|éle|i|i|T]|i]|d
fijo|6]6]8 |5+ |ojuju|l ||y |b|¥]A
Recently used symbols:
o|®fe[u| |¥|E|£]0]°[5[R[€|¥ ™|
REGISTERED SIGM Character code: [00AE from: |Unicods (hex) =]
P
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Using the Photo Gallery Web Component

The photo gallery Web component in SharePoint Designer is a simplified way to design galleries or
albums for sharing pictures on Web sites. It offers a wizard-based approach to create photo galler-

ies with captions and other features and provides four layouts that you can use to arrange pictures.
To create a photo gallery by using SharePoint Designer, follow these steps:

1. In the Design view, open the Web page where you want to insert a photo gallery.
2. Choose Insert=> Web Component to open the Insert Web Component dialog box.

3. Choose Photo Gallery in the list of components and then choose a layout option.
You can choose to insert a horizontal, montage, or vertical layout or you can insert a slide
show of pictures.

4. Click Finish. The Photo Gallery Properties dialog box opens, as shown in Figure 7.9.
You use this dialog box to choose pictures to be added to the gallery and change the cho-
sen layout for the gallery.

FIGURE 7.9

The Photo Gallery Properties dialog box

Photo Gallery Properties ﬂﬂ

Pictures | Layaout |

Eemove |

Fickures from Scanner or Cameras. .. | Thumbnail size:

Witk IIDD j Pixels
Height: IlUU ill Pixels

¥ [Maintain aspeck ratio

I~ 5t as default size

[Mave U | Mowe Do | You have 0 pictures in this gallery,

& Use fonk Formatting from page

 Owerride and use custom font Formatting

ITimesNew Roman jIS (12 pt) jl O j B I II

Caption:

Description:

oK Cancel
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5. Click the Add button to add pictures from a file location, a scanner, or a camera.
You can choose multiple images to be added to the gallery.

6. After you select the images, click Open. SharePoint Designer adds the pictures to the
gallery. The Pictures tab in the Photo Gallery Properties dialog box shows the number of
pictures inserted in the gallery. You can change the order of the pictures by clicking
Move Up and Move Down.

7. 1If you want to edit the pictures that you just added to the gallery, select a picture
and then click the Edit button. This opens the selected picture in the Edit dialog box,
where you can resize, crop, or change the direction of the picture.

8. Choose a picture in the list of pictures in the gallery. Using the Thumbnail size
options, specify the size of the thumbnail to be generated for the picture.

9. Type the caption and description for the picture in the respective boxes. You can
also apply font formatting to the caption and description text by using the options pro-

vided.

10. Click the Layout tab to change the layout of the photo gallery. The Layout tab also
provides a preview of the layout and allows you to specify the number of picture to be
shown in a row.

11. Click OK to allow SharePoint Designer to create the photo gallery component for
you on the Web page.

Like many of the legacy FrontPage components, the photo gallery component is shown in the
Code view of the Web page as an HTML comment, which SharePoint Designer uses as a place-
holder for rendering the component in the Design view:

<!--Webbot bot="PhotoAlbum" U-Include="photogallery/photo00031001/
real.htm" clientside="" TAG="BODY" -->

However, if you open the same Web page in Notepad, the actual code that’s used to implement the
photo gallery Web component appears. Here is the sample code of the slide show photo gallery
layout as viewed in Notepad by using the Open With=> Notepad option in the SharePoint Designer
Folder List task pane:

<!--Webbot bot="PhotoAlbum" U-Include="photogallery/photo00031001/
real.htm" clientside="" TAG="BODY" startspan -->

<picture file-href="photogallery/photo00031001/real_p.htm" />

<picture file-href="photogallery/photo00031001/real_x.htm" />

<div align="center">

<center>

<layer visibility="hide">

<div style="display:none;" id="fpGalleryCaptions_5306">

<div></div><div></div></div>

<div style="display:none;" id="fpGalleryDescriptions_5306">

<div></div><div></div></div>

</layer>
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<script language="javascript" src="photogallery/photo00031001/
sldshow.js">

<l-———-

</script>

<table border="0" cellspacing="0" cellpadding="5" width="700"
dir="1ltr">

<tr>

<td nowrap="" align="center">

<layer visibility="hide">

<img border="0" align="middle" src="photogallery/photo00031001/
prevdis.gif" lowsrc="photogallery/photo00031001/prev.gif"
id="fpGalleryLeftBtn_5306" onclick="JavaScript:fp_
ScrollLeft (5306)" width="25" height="29" />

</layer>
<script language="JavaScriptl.l">
<!--

if (fp_ied()) {

document .write("<span align='center' style='width:23
5;overflow:hidden' id='fpGalleryListCell_5306'>");
}
if (fp_ns6()) {
document .getElementById("fpGalleryLeftBtn_5306").
style.visibility="hidden"
}
-—>
</script>
<a target="_self" href="Javascript:fp_ShowImg (document['fpphoto_2349"
],'430','567"','5306"',0); "><img hspace="10" vspace="5" border="0"
src="photogallery/photo00031001/Figurel5.2.JPG" id="fpphoto_2349"
name="fpphoto_2349" lowsrc="Figurel5.2.JPG" width="75"
height="100" title="" align="absmiddle" /></a>
<a target="_self" href="Javascript:fp_ShowImg (document[' fpphoto_3821"
]1,'17','16','5306',1);"><img hspace="10" vspace="5" border="0"
src="photogallery/photo00031001/test.JPG" id="fpphoto_3821"
name="fpphoto_3821" lowsrc="test.JPG" width="100" height="94"
title="" align="absmiddle" /></a>
<span style="width:0;height:100;visibility:hidden">.</span>
<script language="JavaScriptl.l">
<!l--
if (fp_ied()) {
document .write("</span>") ;
}
—-——>
</script>
<layer visibility="hide">
<img border="0" align="middle" src="photogallery/photo00031001/
nextdis.gif" lowsrc="photogallery/photo00031001/next.gif"
id="fpGalleryRightBtn_5306" onclick="JavaScript:fp_
ScrollRight (5306)" width="25" height="29">
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<script language="JavaScriptl.l">
if (fp_ns6()) {
document .getElementById (" fpGall
eryRightBtn_5306") .style.visibility="hidden"
}
</script>
</img>
</layer>
<hr width="95%" size="1" color="#000000" />
</td>
</tr>
</table>
<img id="fpGalleryMainImg_5306" name="fpGalleryMainImg 5306"
width="430" height="567" src="Figurel5.2.JPG" title="" />
<layer visibility="hide">
<div id="fpGalleryCaptionCell_5306">
</div>
<div id="fpGalleryDescCell_5306">
</div>
</layer>
</center>
</div>
<!--Webbot bot="PhotoAlbum" i-checksum="3109" endspan -->

While you really don’t need to understand this code, keep in mind that you shouldn’t modify the
code by using any other HTML editor or you might be at risk of losing the photo gallery Web com-
ponent. Also highlighted are the files that form the backbone of the photo gallery component.
These files may change depending on the layout that you chose when creating the gallery.

Exploring associated folders and files

After you insert the photo gallery component on the Web page, SharePoint Designer creates a
photogallery folder to keep all associated files of the gallery together. Every gallery has a
unique folder within this folder. These folders remain even after you delete the gallery from a Web
page. Depending on the layout selected for the gallery, the following files are created when you
insert a photo gallery on a Web page:

B Real_p.htm: Contains the tabular structure that defines the initial look and design of
the Web page

B Real_x.htm: Contains references to the list of pictures added to the photo gallery com-
ponent along with the properties (captions, descriptions, etc.) specified for the pictures

B Real.htm: Combines the real_p.htmand real_x.htm pages to form the actual lay-
out of the photo gallery component

B Sldshow. js: This file has the JavaScript implementation of the slideshow layout of the
photo gallery Web component
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The SharePoint Designer photo gallery component relies on a number of JavaScript

- files for creating the photo album of the selected pictures. If you have antivirus
software installed on your machine that blocks JavaScript files, SharePoint Designer might fail
while creating galleries.

Modifying the photo gallery properties

After the photo gallery is inserted on a Web page, you can simply right-click on the component
and then choose Photo Gallery from the popup menu to open the Photo Gallery Properties dialog
box. You can then modify the properties associated with the pictures inside the gallery by using the
steps discussed in the previous sections.

Using Advanced Controls

SharePoint Designer’s Insert Web Component dialog box allows you to insert a number of
advanced controls that are commonly used by Web site designers. These include java applets,
plug-ins, ActiveX controls, etc. In this section, I take you through the process of inserting such
controls on Web pages by using SharePoint Designer.

Inserting Java applets and ActiveX controls

Applets are small applications that perform specific operations when inserted on a Web page. To
insert a Java applet on your Web page, follow these steps:

In the Design view, open the Web page on which you want to insert an applet.

2. Choose Insert=> Web Component to open the Insert Web Component dialog box
and then click Advanced Controls.

3. In the Choose a control list, choose Java Applet and then click OK. The Java Applet
Properties dialog box opens, as shown in Figure 7.10, where you can specify the source
and settings for the applet you want to use.

4. Specify the Applet source (usually a class file) and Applet base URL in the text
fields provided.

5. If the applet that you're using requires parameters to be passed to it, you can spec-
ify them in the Applet Parameters section in this dialog box.

6. Click OK to insert the applet on the Web page.
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confirm if he or she wants to allow the ActiveX control to run.

FIGURE 7.10

The Java Applet Properties dialog box

Java Applet Properties cd |
Applet source:
Applet base URL:
Message For browsers without Java suppork;
Applet parameters:
Mame Value Type Yalue
add...
IEdif.. |
Bemmnye |
Layout
Horizontal spacing: ID Alignment: IDeFauIt Yl
Vertical spacing: ID
Size
Width: |123 Height: |128
(6]4 | Cancel |

If you click the Code view tab after you insert the applet on the Web page, the Java Applet
Properties dialog box merely becomes the interface to set attributes for the <applet> tag.

Similar to applets, ActiveX controls are predeveloped controls and applications that can be inserted
on Web pages to provide specific functions. SharePoint Designer allows you to insert a number of
Microsoft ActiveX controls usually available with the operating system. When you elect to insert an
ActiveX control by using the Insert Web Component dialog box, you're provided with a list of
ActiveX controls installed on the SharePoint Designer machine.

Both Applets and ActiveX controls aren’t allowed to run in IE directly. When a
user browses to a page that has an ActiveX control on it, he or she is prompted to

ActiveX controls are inserted on Web pages by using the <object> tag. SharePoint Designer pro-
vides contextual Properties dialog boxes for ActiveX controls that allow you to modify the proper-
ties of the controls by using the user interface rather than having to set them in the Code view.
After the control is inserted on a Web page, right-click on the control and then choose ActiveX
Control Properties from the popup menu to modify the control properties.
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Inserting Flash controls

Inserting Flash movies on a Web page by using SharePoint Designer can be a little tricky. However,
if you understand the concept involved here, you might be able to subsequently insert Flash files
in a quick manner. Follow these steps to insert a Flash movie on a Web page:

1. Import the Flash file you want to use on your Web site. You can do this by simply
dragging and dropping the file from Windows Explorer to the SharePoint Designer
Folder List task pane.

2. Using the Insert Web Component dialog box, choose Advanced Controls=> Plug-In
and then click Finish. This inserts a plug-in on the Web page and opens the Plug-in
Properties dialog box.

3. Type the name and location of the Flash file in the Data source dialog box. Specify a
text message to be shown for those browsers that don’t support plug-ins.

4. Save the Web page and then preview it in a browser.

SharePoint Designer inserts the Flash movie by using the <embed> tag on the Web page. You can
also use the <object> tag to play Flash movies on Web pages by using the following code:

<OBJECT classid="clsid:D27CDB6E-AE6D-11cf-96B8-444553540000"

codebase="http://download.macromedia.com/pub/shockwave/cabs/flash/
swflash.cab#version=6,0,0,0">

<PARAM NAME=movie VALUE="flash.swf">

<EMBED src="flash.swf" TYPE="application/x-shockwave-flash"
PLUGINSPAGE="http://www.macromedia.com/go/getflashplayer"></
EMBED>

</OBJECT>

In the highlighted code, the value of the classid attribute is the CLSID (class identifier) of the
Flash player ActiveX control.

Using MSN Web components

SharePoint Designer allows you to insert MSN components for creating and linking to maps, show
stock quotes, and use MSN Search. These components are available in the Insert Web Component
dialog box under MSN Mapping Components and MSN Components.

To insert an MSN map on your Web page by using the MSN mapping component provided by
SharePoint Designer, follow these steps:

1. In the list of Web components in the Insert Web Component dialog box, click MSN
Mapping Components.

2. Choose Insert a map in the list of components and then click Finish. The Insert a
map Properties dialog box opens.
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3. Use the Insert a map Properties dialog box to specify the address you want to insert
a map of.

4. Click Next to preview the map, click Next, and then click Finish to insert the map
on the Web page at the location of the cursor.

While inserting the MSN stock quote component on a Web page, ensure that you
% place the cursor outside the <form> tag in the page. This component inserts its
own <form> tag and fails to get inserted inside an existing <form> tag.

Summary

Using SharePoint Designer to work with picture and animation can be quite fun, and you can
quickly build a complex Web site without writing much code by hand. In this chapter, I discussed
the SharePoint Designer picture and photo gallery features. I also talked about how you can insert
advanced controls, such as applets, plug-ins, and other components, on Web pages.
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ost of the Web sites on the Internet don’t really have static content.

Instead, the Web pages are mostly live with dynamics such as

dropdown and popup menus, hover-over tabs and buttons,
expanding and collapsing content, etc. While HTML is a great technology for
developing static Web pages, if you combine it with a client-side scripting
technology, such as JavaScript, you can really bring your Web pages to life.
Using DHTML effects to enable and disable content on Web pages is recom-
mended by many as a key strategy to structure and simplify access to key
areas inside Web sites.

Dynamic effects on Web pages are driven by events. An event is an action
that a user who browses to the Web page takes. For example, a user may
move the mouse over a certain area or section of the Web page or click a cer-
tain HTML tag on the Web page. Most such user actions are categorized into
events that can be associated with an HTML tag. When such an event hap-
pens, the Web site designer is given control on the operation that needs to
be performed for that event. Most common events are onmouseover,
onmouseout, onclick, onkeydown, ondlbclick, etc. Using a client-
side script, a designer can program what operation should be performed
when an event occurs.

SharePoint Designer carries forward one of the key features of dynamic Web
page development from FrontPage 2003 called behaviors. Behaviors com-
bined with layers offer limitless capabilities in creating dynamic effects on
Web pages. In the back end, behaviors are mostly driven by JavaScript func-
tions. However, SharePoint Designer hides the complexity of these functions
from Web designers and offers an intuitive user interface to use JavaScript as
a means to vitalize content on Web pages. The SharePoint Designer user
doesn’t really need to possess understanding of client-side scripting technol-
ogies and can just use the interface to use JavaScript for inserting dynamic
effects on select HTML content.
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In this chapter, I discuss how you can use the SharePoint Designer behaviors to create dynamic
Web content. I take you through steps and exercises that help you develop an understanding about
how to exploit behaviors in SharePoint Designer. Later in this chapter, I also talk about some leg-
acy FrontPage DHTML effects that you might want to use on your Web sites.

But first, I begin by familiarizing you with one of the other cool features that SharePoint Designer
inherited from FrontPage 2003. This feature, called interactive buttons, uses JavaScript at the back
end to provide you with a set of buttons that become active when a user hovers over them.
Interactive buttons were introduced in FrontPage 2003 and replaced the FrontPage hover buttons.

Working with Interactive Buttons

Inserting interactive buttons on Web pages is simple. You can follow these steps to create the inter-
active buttons of your choice on a Web page:

1. In the Design view, open the Web page where you want to insert an interactive
button.

2. Choose Insert= Interactive Button to open the Interactive Buttons dialog box, as
shown in Figure 8.1. This dialog box allows you to choose a format for the button and
shows a quick preview of how the button will look on the Web page.

3. In the Buttons list, choose the button you want to use, type the button text, and
specify the URL to be associated with the button.

4. Click the Font tab. Here, you can change the font of the text on the button and also
specify the various colors that text should take when the mouse is over or moved off the
button text.

5. Click the Image tab. Using this tab, you can specify certain properties of the image of
the button that’s created by SharePoint Designer. You can choose whether the hover and
the clicked image should be created. The hover image is displayed when the mouse is
hovered over the button, and the clicked image is displayed when the button is clicked.

Click OK. The button is inserted on the Web page.

Save the Web page. SharePoint Designer asks you to save the images associated with the
interactive button. Save the images to the location of your choice.

When you preview the page in a browser, the button changes color when you move the mouse
over it. When you click the button, the image changes again.

To understand what SharePoint Designer did internally for enabling the interactive buttons, open
the Behaviors task pane from the Task Panes menu. After the Behaviors task pane opens, just

click the newly inserted button. As shown in Figure 8.2, a number of events (onmousedown,
onmouseout, onmouseover, and onmouseup) have been set for the <img> tag associated with
the button.
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The Interactive Buttons dialog box
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FIGURE 8.2

The Behaviors task pane for an interactive button
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While I discuss these in more detail in the next section, the point to understand is that when you
created the interactive button, SharePoint Designer first created three images and then created a set
of JavaScript functions that swap the images based on the event that takes place. To successfully
use the interactive button on a Web page, it's important that the images associated with the button
are available. For example, when you publish a Web page that has an interactive button on it, you
must ensure that the button images are also published.
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Using SharePoint Designer Behaviors

Behaviors allow Web site designers to create DHTML effects and functionality on Web pages with-
out having to write a lot of JavaScript code. SharePoint Designer has prewritten JavaScript actions
that provide a large set of functions. In this section, I discuss these actions and show you how to
use them for Web page development.

Understanding behaviors

Behaviors are basically predefined JavaScript functions that can be used with various DHTML
events to obtain a specific functionality. Table 8.1 shows a list of behaviors available in SharePoint

Designer.

TABLE 8.1

Behavior

List of SharePoint Designer Behaviors

Description

Call script

Change property

Change property restore

Check browser

Check plug-in
Go to URL

Jump menu
Jump menu go

Open browser window
Play sound

Popup message
Preload images

Set text

Swap images

Swap images restore

Allows you to use a JavaScript function that you want to use (in case you have a
function you wrote)

Allows you to change the HTML properties and attributes of selected HTML tags
and elements

Restores the HTML properties/attributes changed by the Change Property
behavior

Allows you to check the version of a browser being used and redirect to a URL
based on that browser’s version

Allows you to check the plug-in type and redirect to a URL based on that type
Takes you to the specified URL

Allows you to create a dropdown menu with choices that take you to the associ-
ated URL

After the Jump menu is used, allows you to go to a URL based on the selected
index of the Jump menu

Opens the specified URL in a new browser window

Allows you to specify a music file to be placed

Displays a specified message

Preloads the specified images at page load time

Allows you to set text for a frame, layer, browser status bar, or text field
Allows you to change the display image of the <img> tag

Restores the image swap
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The basic process of implementing a behavior on an HTML element is as follows:
B Choose the HTML tag or element that you want to apply the behavior on in the currently
open Web page.

B Choose the behavior that you want to use and then specify the settings for the behavior
by using the associated dialog box.

B  Choose the DHTML event on which the behavior should fire.

Working with the Behaviors task pane

The Behaviors task pane is the SharePoint Designer interface to create behaviors and associate them
with HTML tags. As shown in Figure 8.3, the Behavior task pane is contextual — that is, only the
behaviors associated with the current selection in the Web page are displayed in the task pane.

FIGURE 8.3

The Behaviors task pane

Behaviors X
=%
Call seript EE'
| Change Property | | Actions
Change Property Restore Change Property Restore

Check Browser Change Property

Check Plug-in
Go To URL

Jurnp Menu

Cpen Browser Window
Flay Sound

Popup Message
Preload Images

Set Text »

The Tag label indicates the selected tag for which the behaviors are being displayed. The list of the
behaviors and the associated DHTML events applicable to the selected tag are displayed in the
Behaviors list. You can insert new behaviors by using the Insert menu and delete existing ones by
first selecting them from the list and then clicking Delete.
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Inserting behaviors on HTML elements

To demonstrate how you can use SharePoint Designer behaviors to dynamically change HTML

attributes, follow these steps:

1.

In the Design view, open your Web site and then create a new Web page. Ensure

that the Behaviors task pane is open.

Choose Insert=> HTML = Paragraph. This inserts a <p> tag on the Web page, which is

selected and shown in the Quick Tag Selector.

Type some text inside the paragraph. Ensure that the Behavior task pane shows the
selected tag as a <p> tag. You see this in the Tag: label in the top section of the Behaviors

task pane.

In the Behaviors task pane, choose Insert=> Change Property. The Change Property

dialog box, as shown in Figure 8.4, opens.

FIGURE 8.4

The Change Property dialog box
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Ensure that the Current Element radio button is selected and then click Font.
Choose Bold in the Font Style and then change the color to Green.
Click OK. The selections made in the Font dialog box appear as styles in the Change

Property dialog box.
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8. Click Borders, click the Shading tab, choose Silver as the background color, and
then click OK.

9. Click the Restore on mouseout event check box and then click OK. Two behaviors
are then applied to the selected paragraph. The first behavior changes the look of the
paragraph when the mouse is hovered over it, and the second behavior restores the origi-
nal look of the paragraph when the mouse is moved away from it.

10. Save the page and then preview it in a browser.

You can use the behavior in a similar manner on other HTML tags and elements. In the next exer-
cise, you use a combination of behaviors to show and hide content on a Web page.

Implementing dynamic effects by using behaviors

To begin this exercise, first create a new Web page using the following HTML code:
<html xmlns="http://www.w3.0rg/1999/xhtml">

<head>
<meta http-equiv="Content-Language" content="en-us" />
<meta http-equiv="Content-Type" content="text/html;
charset=windows-1252" />
<title>Untitled 10</title>
<style type="text/css">
.stylel {
border: 2px solid #ffffff;
background-color: #ffffff;
}
</style>
</head>

<body>

<table style="width: 100%" class="stylel">
<tr id="trl">
<td style="width: 305px">First Paragraph</td>
</tr>
<tr id="tr2">
<td style="width: 305px">Second Paragraph</td>
</tr>
</table>
<p id="pl" style="visibility:hidden">This is the text of the first
paragraph.</p>
<p id="p2" style="visibility:hidden">This is the text of the second
paragraph.</p>

</body>

</html>
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The page simply contains a table with two rows and two columns. The first row, tr1l, has the text
First Paragraph in it, and the second row, tr2, has the text Second Paragraph. Later in the code,
there are two paragraphs (pl and p2) with the visibility:hidden style applied to them.

The exercise is to use behaviors to show the p1 paragraph when the mouse moves over the trl
row and show the p2 paragraph when the mouse moves over the tr2 row. To do this, follow
these steps:

1. Ensure that trl is selected in the Behaviors task pane and then choose
Insert= Change Property.

2. In the Change Property dialog box, click Select Element and then type p as the
Element Type and pl as the Element ID.

3. Click Visibility and then click the Visible radio button. The resulting selection is
shown in Figure 8.5.

FIGURE 8.5

Using behaviors to show and hide content
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Click the Restore on mouseout event check box and then click OK.
Repeat the previous steps for the tr2 row and the p2 paragraph.

Save the page and then preview it in a browser.
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resource: http://support.microsoft.com/?id=902326. To create multipage
forms using SharePoint Designer behaviors, visit the following online resource: http://
support .microsoft.com/?id=912673.

Using Page Transitions

Page Transition is a legacy feature carried forward from FrontPage versions that allows designers to
create an effect of transition when a user browses from one page to another. Page transitions target
four events: Site Enter, Site Exit, Page Enter, and Page Exit. As their names suggest, the
transition associated with an event happens when the user enters or leaves a Web site or a Web page.

You can specify the page transitions settings by choosing Format &> Page Transition. As shown in
Figure 8.6, the Page Transitions dialog box allows you to choose the event, the transition effect,
and the duration within which the transition takes place.

FIGURE 8.6

The Page Transitions dialog box
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In the Code view of the Web page (after you apply a page transition effect to the Web page), a new
Meta tag is added to the <head> section of the Web page HTML code. For example, the following
code shows the Box out transition effect for 25 seconds when a user browses to this particular page:

<meta http-equiv="Page-Enter" content="revealTrans (Duration=25.0, Tran
sition=1)" />
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Summary

SharePoint Designer’s behaviors and layers offer a lot of flexibility to Web site designers to allow
them to create dynamic content using a no-code interface. You just need to know about the event
for which you want to target the dynamic content, and SharePoint Designer allows you to make
changes to the HTML based on your selection.
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ne of the most commonly used features of FrontPage is Web com-

ponents, which provide prewritten functionality for use in Web

sites. Web components, such as FrontPage forms, search forms,
page hit counters, etc., offered with FrontPage have been quite popular and
are used exceedingly on Web sites that support FPSE. The readiness and ease
of usage of these Web components make them a choice for many Web site
designers looking to quickly implement advanced Web site operations.
SharePoint Designer inherits most of these Web components from FrontPage
2003 and allows Web site designers to use them on FPSE-based and, in
some cases, SharePoint Web sites.

Each of these Web components provides an effortless interface that allows
Web designers to set their properties and attributes. After a Web component
is inserted on a Web page, a designer configures its properties by using the
SharePoint Designer user interface and then saves the Web page. At runtime,
based on the properties set for the Web component, a server-side code (usu-
ally implemented by FPSE or SharePoint) renders the HTML for the Web
component to be displayed in a browser so that a Web site visitor can inter-
face with the component. In this way, the Web component hides its code
implementation from the Web designer, allowing him or her to simply make
some settings for the component rather than having to think about coding the
actual implementation of the functionality that the Web component offers.

To begin this chapter, I discuss how many of these Web components pro-
vide functionality that can now be obtained by using other advanced and
more contemporary technologies, such as ASP.NET 2.0. Hence, I named
these Web components here as FrontPage legacy components. If you're look-
ing at developing new Web sites, my recommendation is to consider using
ASP.NET 2.0 and other relatively new technologies to implement the fea-
tures provided by these components. My intention in this chapter is to help
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you understand how to use Web components so that if you run into a Web site implementation
that uses these Web components, you can use SharePoint Designer to maintain such Web sites
effectively and develop suitable migration strategies.

This chapter discusses the FrontPage legacy components available in SharePoint Designer. These
include components such as forms; search components; included content such as substitution,
included pages, etc.; hit counters; and a table of contents, among others. I start by first broadly
classifying these components based on the Web server requirements. Then, I introduce you to
these Web components and show how you can insert and configure them on Web pages by using
SharePoint Designer.

Understanding the Types
of Web Components

SharePoint Designer, as in previous versions of FrontPage, installs many client components that
provide support for authoring Web components. These client components facilitate insertion and
setup of the Web components through SharePoint Designer. Web components available in
SharePoint Designer can be of two types, depending on how they function after being configured
on a Web page.

Author time Web components

Author time Web components require the services provided by FPSE only at the time they’re being
inserted and configured on a Web page. After they’re set up on Web pages, they don’t need FPSE
to operate. This means that the Web pages that use these components can be placed on Web sites
that don’t have FPSE on them. The following is a list of some of the commonly used author time
Web components:

B Included Content: Allows you to include content, such as pages, pictures, date, and
time, on the Web pages

B Link Bars: Provides navigation features to Web sites by allowing you to create bars with
links to various sections

B FrontPage Themes: Provides formatting and styling by using HTML and CSS
B Photo Gallery Component: Allows you to create picture galleries on Web pages
B Table of Contents: Allows you to compile a table of contents for your Web sites

While these components don’t require FPSE, they still need to use the hidden
metadata for functionality and maintenance.

Runtime Web components

Runtime Web components require the services provided by FPSE at the time they’re configured on a
Web page as well as at the time when a Web page is being browsed to. Runtime Web components
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don’t work if the Web pages in which they're placed are published to a Web site that doesn’t have
FPSE properly configured for it. At runtime, these components use FPSE for performing their opera-
tions. The most commonly used runtime Web components include the following;

B Hit Counter: Keeps track of the number of page hits made to a Web page on which the
component is inserted

B FrontPage Form Handlers: Provides features to create HTML forms that send data col-
lected from a user to a file, e-mail address, etc. They also provide enhanced features, such
as custom confirmation pages, save format, etc.

B Search Component: Allows you to enable content search on Web sites
B File Upload Components: Enables file upload by using form handlers
B Confirmation Fields: Allows you to create dynamic custom confirmation pages when

using form handlers

Throughout the rest of this chapter, I show you how you can use SharePoint Designer to configure
these Web components on Web pages.

Inserting Web Components

Most SharePoint Designer Web components are available in the Insert Web Component dialog box,
which is accessible by choosing Insert= Web Component. You need to have a Web page active
(open in the Design or Code view) in SharePoint Designer to be able to insert Web components.

[ If the Manage the Web site using hidden metadata check box in the Site Settings
% dialog box isn’t selected for a Web site, most of the components in the Insert Web
Components dialog box are thus disabled.

Creating hit counters

Hit counters are a very desirable feature, and the Hit Counter Web component provides an easy
way to implement this functionality on a Web site. To insert a hit counter on a Web page of your
Web site, follow these steps:

1. Open the Web page where you want to insert the hit counter.
Choose Insert=> Web Component to open the Insert Web Component dialog box.

In the Component type section, select Hit Counter. In the Choose a counter style sec-
tion, you can select the style of counter you want to use, as shown in Figure 9.1.

4. Click Finish. The Hit Counter Properties dialog box opens, as shown in Figure 9.2.
Choose the style you want for your hit counter. You can also click the Reset counter to
check box and then specify the initial value from which the counter should start count-
ing. Clicking the Fixed number of digits check box allows you to specify the number of
digits to be used in the hit counter.

5. Click OK to complete the configuration of the hit counter for the Web page.
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Inserting a hit counter on a Web page
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FIGURE 9.2

The Hit Counter Properties dialog box
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When you browse to the Web page that has the hit counter, the hit counter is incremented on
every refresh of the Web page by using a hit counter image. The image that you choose is divided
into 10 sections for each number and then the sections are swapped to show the increment in the
hit count at runtime. As shown in Figure 9.3, the actual counter value is stored in a file with the
extension .cnt in the _private folder for the Web site. You can change the value of the counter
in this file to reset the counter.

FIGURE 9.3

Counter value for the Hit Counter Web component

File Edit Format Wiew Help
FPCountFile 00000001001

The design of the hit counter allows you to use a custom image for the hit counter. You can create
an image of suitable dimensions by using your favorite graphics-creation program or picture editor
program and then specify in the Hit Counter Properties dialog box that the hit counter should use
the custom image.

Working with included content

As shown in Figure 9.4, when you select the Included Content component type in the Insert Web
Component dialog box, you can make use of a number of options for including content on the
active Web page. In this section, I take you through the components that assist in including content.

Comment

Selecting Comment in the Choose a type of content list allows you to insert an HTML comment on
the Web page contents, which are visible in the Design view in SharePoint Designer. When you
insert a comment in this way, the following code is written to the Code view of the Web page:

<!--webbot bot="PurpleText" PREVIEW="Insert image here" -->

SharePoint Designer provides the interface that allows you to change the value of the Preview
attribute, which actually forms the comment that’s displayed in the Design view. You can right-
click on the comment component and then choose Comment Properties from the popup menu to
change the preview text.

Date and Time

The Date and Time component provides a way to show when the page on which the component is
inserted was last modified. As shown in Figure 9.5, when you insert a Date and Time component,
you can choose whether you want to show the date when the page was last edited or when the
page was last automatically updated.
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FIGURE 9.4

Inserting included content Web components
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FIGURE 9.5
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You can choose from a list of date and time formats by using the Date and Time dialog box.

Depending on the format chosen, the following code is inserted on the Web page to enable the

Date and Time component:

<!--webbot bot="Timestamp" S-Type="EDITED" S-Format="%A, %B %
%1:%3M:%S %p" -->

When you preview the Web page in a browser, the Date and Time Web component displays the
last modified date and time of the Web page. This information is picked up from the hidden meta-

data that’s maintained for all pages inside the Web site that support hidden metadata.
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T If you try to put a Date and Time Web component on a Web page inside a

- ! Web site that doesn’t support hidden metadata — for example, by cutting
and pasting code — it won’t work. This means that the dates and times in the Web component
aren’t refreshed.

Substitution

The Substitution Web component provides a way to centrally manage commonly displayed text on
Web sites. For example, consider a situation where you need to specify some volatile information
on a lot of pages inside a Web site. If you type this information on every page, a change would
require you to go back and change the information on all the Web pages.

Instead, you can use a Substitution Web component in conjunction with a site parameter to dis-
play this information on all pages. Follow these steps:

1. With your Web site that supports hidden metadata open in SharePoint Designer,
choose Site Site Settings.

2. Click the Parameters Tab, click Add to add a parameter name and value, as shown
in Figure 9.6, and then click OK.

FIGURE 9.6

Creating a new site parameter via the Site Settings dialog box
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3. Choose Insert=> Web Component to open the Insert Web Component dialog box
and then select Substitution in the Included Content component type. This displays
the Substitution Properties dialog box. The Substitute with dropdown menu shows the
parameter created in step 2 as an available choice.

4. Select the site parameter and then click OK.

The value of the site parameter is inserted on the Web page, and the following code is inserted in
the code of the Web page:

<!--webbot bot="Substitution" S-Variable="Announcement" -->

You can insert a Substitution Web component on all the Web pages where the value of the site
parameter needs to be displayed. Whenever a change is required, all you need to do is change the
site parameter by using the Site Settings dialog box, and the substitution components are automati-
cally updated to show the new information.

Page

The Page Web component allows you to display the contents of a Web page inside another Web
page. When you insert the Page Web component on a Web page, the user interface allows you to
pick a Web page that needs to be included in the currently active Web page.

After you insert the page Web component, if you switch to the Code view of the Web page, the fol-
lowing code is inserted for the Web page:

<!--webbot bot="Include" U-Include="bottom.htm" TAG="BODY" -->

The Code view actually hides the fact that the actual code of the included Web page is included for
the page on which the page component has been added. As shown in the following code, if you
open the Web page by choosing Open With=> Notepad, the code of the included page is actually
present in the Web page:

<body>

<p>&nbsp; </p>

<!--webbot bot="Include" U-Include="bottom.htm" TAG="BODY" startspan
-—>

<p>Contents of bottom.htm</p>

<!--webbot bot="Include" i-checksum="18282" endspan -->

</body>

As shown in the previous code, the content of the included page exists with the webbot com-
ments of the page Web component.

Page Based On Schedule

The Page Based On Schedule Web component allows you to configure the included page in such a
manner that it’s displayed only for a certain period of time.
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For example, you can configure this Web component to show the included page only between cer-
tain dates. When the scheduled date and time passes, the included page isn’t displayed on the par-
ent page anymore. Optionally, as shown in Figure 9.7, you can configure another included page to
display before and after the scheduled time.

FIGURE 9.7

Configuring an included page based on a schedule

Scheduled Include Page Properties cd |

Page to include:

During the scheduled time:

Icontents.htm Brawse.. . |

Biefore and after the scheduled time {optional):

|Iav.htm Brawse.., |
Starting: [2008 =| [war x| Joz | [ouisez4pm :I

Sunday, March 02, 2008

Endng: [2008 x| Japr x| [0 x| Jousezepm :I

Thursday, April 10, 2005

Ok I Cancel I

The following code is inserted on a Web page when you add the Page Based On Schedule Web
component:

<!--webbot bot="ScheduledInclude" U-Include="contents.htm" U-Else-
Include="lay.htm" D-Start-Date="02 Mar 2008 17:03:07" D-End-
Date="10 Apr 2008 17:03:07" -->

I Because this Web component is an author time Web component, it’s important to
- understand that the decision to make the switch is made at the time the component
is inserted or the Web page is saved.

Picture Based On Schedule

The Picture Based On Schedule Web component allows you to insert a picture on a Web page and
then schedule it to be displayed only during a certain time period. As shown in Figure 9.8, the
Scheduled Picture Properties dialog box allows you to specify the picture and the alternate text to
be used between the specified times. Optionally, you can specify to use a picture that’s displayed
before and after the specified time has passed.
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Configuring a picture based on a schedule

Scheduled Picture Properties cd |

Picture to display

During the scheduled time:

|button4. jpal Erowse, ., |

Before and after the scheduled time {optional):

Ibuttons.jpg Browse. .. |

Alkernative texk

During the scheduled time:

J5ubmit

Before and after the scheduled time:
IExpired

starting: [2008 | [war =] Joz =] fosimzeem

Sunday, March 02, 2003

endng: [2008 | [aer =] Jos =] fosiimzeem

‘\Wednesday, April 09, 2008

oK I Cancel |

Page Banner

If the Web page that you're working on is part of a Web site’s navigation structure, you can use the
Page Banner Web component to display the title of the Web page. Using the Page Banner
Properties dialog box, as shown in Figure 9.9, you can also specify whether the page banner
should be displayed as a picture or just plain text. You can also modify the text to be displayed in
the page banner.

FIGURE 9.9

The Page Banner Properties dialog box

Page Banner Properties ed |

Properties

Page banner bext

Ok I Cancel
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Creating page categories and a table of contents

While creating Web pages in SharePoint Designer, you have the option to create Page Categories
and then associate each newly created Web page with a specific category. Categorizing the Web
pages in this manner is useful later in developing a table of contents for your Web site.

To create new page categories and then associate Web pages with them, follow these steps:
1. Right-click on a Web page for a Web site in the Folder Lists task pane and then

choose Page Properties from the popup menu.

2. Click the Workgroup tab. As shown in Figure 9.10, the Workgroup tab can be used to
associate the selected Web page with one or more categories. You can also add new cate-
gories by clicking Categories.

FIGURE 9.10

Associating a Web page with a page category

contents.htm Properties 2x

General I Summary  Workgroup I

Itern(s) belong to these categaries:

IExpense Report, GoalsfObjectives, Ideas

Awailable categories:
v Expense Report
[V Goals/Objectives
|2 1d=as

[ InProcess ;I

Categories...

L L

Assigned to:

I j Mames. .. |
Review status:

I j Statuses...

[ Excluds this file when publishing the rest of the Web

,TI Cancel | Apply |

3. Click Categories to open the Master Category List dialog box, type the name for
your custom category, and then click Add. The new category appears in the list of
available categories.

4. Choose the categories with which you want to associate the Web page.

Click OK to save the changes.
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FIGURE 9.11

After you categorize your Web pages in this manner, you can use the Table of Contents Web com-
ponent to display a table of contents based on the page categories. When you insert a table of con-
tents based on the page category by using the Insert Web Component dialog box, the Categories
Properties dialog box, as shown in Figure 9.11, opens.

Choose the page categories you want to include by using the Choose categories to list files by sec-
tion, specify the sorting order, choose whether to include date modified and comments added to
the Web page, and then click OK. A categorized table of contents is created for you on the Web
page. The table contains links that navigate the user to the corresponding Web page.

Selecting page categories to be used in the table of contents for the Web site

Categories Properties ed |

Selected categories:

|Business, Cormpetitian, Expense Report

Choose categories to list files by:

¥ Eusiness -
v Caompetition

[~ 1deas LI
Sort files by: IDocument Title j

Include the Following information:

¥ Date the File was last modified:

[ comments added ta the file

If you're not using page categories and just want to add a table of contents for your Web site, click
the For This Web Site list option in the Table of Contents component type in the Insert Web
Component dialog box. As shown in Figure 9.12, this displays the Table of Contents Properties
dialog box, which allows you to specify the starting page for the table of contents.

Te ) Clicking the Recompute table of contents when any other page is edited check
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=AHENDER hox in the Table of Contents Properties dialog box makes SharePoint Designer

recompute the table of contents every time any Web page inside the Web site is saved. Although
negligible for small Web sites, it may take a long time to recompute the table of contents for
large Web sites. Don’t select this option on large Web sites. Instead, choose Site=> Recalculate
Hyperlinks to recompute the table of contents.
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FIGURE 9.12

The Table of Contents Properties dialog box

Table of Contents Properties 2lxl

Page URL For starting paint of table:

IDeFauIt.htm Browse, .. |
Heading font size: |2 - l

Options

¥ show each page only once
[ Show pages with no incoming hyperlinks
[~ Recompute table of contents when ary other page is edited

oK I Cancel

Implementing Web search

SharePoint Designer exposes the use of the search features available in Web sites that support
FPSE. While FPSE handles the indexing and querying of the content of Web sites, SharePoint
Designer allows Web designers to create search forms on Web pages (using the Search Form Web
component), which act as the user interface for entering the search query.

The Web Search component type in the Insert Web Component dialog box has two options:

B Current Web: This option creates search forms on Web pages inside Web sites that have
FPSE configured for them.

B Full Text Search: This option creates search forms on Web pages inside WSS v2
Web sites.

To insert a search form on a Web page inside an FPSE-enabled Web site, simply select the Current
Web option in the Insert Web Component dialog box and then click Finish. The Search Form
Properties dialog box shown opens, as shown in Figure 9.13, and can be used to configure some
general settings for the search form.

The Search Form Properties dialog box allows you to customize the search form created by the
Web Search component. You can specify the label for the search box and the captions for the
Submit and Reset buttons. When you browse to a Web page containing the Web Search compo-
nent, a search form is displayed, as shown in Figure 9.14.

When you type a query for a word to search in the Web site content, the search form redirects the
request to the _vti_bin/shtml.dll file. This file is an FPSE file residing in the _vti_bin
directory (created when you configure FPSE on a Web site) and processes the search query to
return the results for display in a browser.
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Configuring the search form properties

Seatch Form Properties ﬂil

Search Form Properties ISearch Results |

Search input

Label For inpuk; ISearch For:|
width in characters: IF
Label for "Start Search" button: IStart Search
Label for "Reset” button: IReset

OK I Cancel

FIGURE 9.14

Using the search form on a Web page

Search for: [search

Start Search | Reset |

Number of documents found: 1. Click on a document to view it, or submit another search.

Search Results

Document Title
default htm

If FPSE isn’t properly configured or the Indexing service isn’t running on
the Web server hosting the Web site, the search fails to return results.
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Using the Top 10 usage lists

The Top 10 List Web component allows you to display usage data made available by the usage
analysis tools in FPSE and SharePoint sites on your Web pages.

! For more on usage analysis for SharePoint and non-SharePoint Web sites,
see Chapter 25.

As shown in Figure 9.15, the Insert Web Component dialog box allows you to choose from a num-
ber of usage lists. The data presented by the Web component is gathered by the FPSE or
SharePoint components running on the Web server.

e Top 10 lists are only updated when the component is inserted on a Web
% page or when a Web page containing the component is resaved.

FIGURE 9.15

The Top 10 Lists Web component options

Insert Web Component 2=l

Component bype: Choose a usage list:
é,?g Dwnamic Effects = visited Pages ;I
@ Weh Search Referring Domains
Hit Counker Referring URLs
Photo Gallery Skrings
% Included Content: Wisiting Users
= Link Bars Operating Syskems
Table of Contents Browser
List Wi
Diocurnent Library Wi
“ M5 Mapping Components =
 MSN Components j LI

Shaow the top 10 search strings site visitors used in search engines ta find this web site.

Find components on the web Cancel = Back [ext = | Einish I

P

Creating Forms

The form components based on form handlers available with FPSE have been some of the most
commonly used Web components of FrontPage 2003. They have also been inherited by SharePoint
Designer, although the access points for configuring these forms have changed a little. FrontPage
forms can be used to submit data to various types of files, to send to e-mail addresses, or to store it
in databases. Web designers can use the SharePoint Designer interface to configure the forms, and
the FPSE components implement the actual function of saving the data to the back-end file.
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Because of the simplicity introduced by these form components to develop interactive forms for
collecting data from users visiting the Web sites, these components have been a feature of choice
for many Web site developers for a long time.

Using HTML form controls

The first step in creating a form by using SharePoint Designer is to collect data from a user to cre-
ate the form. Most of the form controls that you might want to place in your form are available in
the Form Controls section of the Toolbox task pane.

To create a simple form using the form controls in SharePoint Designer, follow these steps:

1. Choose Task Panes=> Toolbox to display the Toolbox task pane.

2. If the form control doesn’t already exist on the Web page, using the Form Controls
section, double-click Form to insert an HTML <form> tag inside the Web page.

3. Using the Form Controls section of the toolbar, add other form controls to the
<form> tag to create a form. Ensure that you also insert the Submit and Reset button
controls on the form. A sample form is shown in Figure 9.16. An HTML table is used to
format the form a little better.

4. Save the Web page.

FIGURE 9.16

Creating an HTML form using form controls

|4 Web Site || UsingFormComponents.htm*
E||<b0dy>||<Form>||<table.stylel>| E|

Ttapse-enter-thefollowing-details:

X

3

AccountTTumber;:
First-Mame: -
Last-Mame: +/
Telephone:
User-lame: <
Password: <
Ee-enter-Password:-

submit | reset I

ot ottt ot

After you create the form structure, you have to choose how it performs the save operation. You
can make these choices by configuring the form properties.
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& Using the form handlers provided with FPSE to send data to files or e-mail addresses
= requires that the Web page where the form is inserted be an HTML/HTM Web page.
If you use the form to send data to a database, the page is automatically saved as an ASP page.

Setting forms properties

You can right-click the HTML form on a Web page and then choose Form Properties from the
popup menu to access the Form Properties dialog box. As shown in Figure 9.17, you can use the
Form Properties dialog box to choose which method you want to use to save the form data.

Click Advanced to specify any hidden data that needs to be saved along with the form data. Based
on the radio button selection you make in the Form Properties dialog box, the user interface avail-
able when you click Options changes.

FIGURE 9.17

The Form Properties dialog box

Where ko skore results
o §end ko (Requires FrontPage Server Extensions);

File name: I Browse. .. |

E-mail address: I

™ gend to database (Requires FrontPage Server Extensions)

" gend ko ather IDiscussion Faorm Handler (FrontPage Server Extensiorj

Form properties

Forrm narme: I

Target Frame; I ﬂ

Options... | &dvanced...l (814 I Cancel |

Sending to a file or an e-mail address

You can choose to send data submitted in the form to a file residing inside the Web site or to an
e-mail address. Simply click Browse to choose the file where you want to save the data and then
add an e-mail address in the E-mail address text field. As indicated in the Form Properties dialog
box, you need to have FPSE configured on a Web site to use this feature.

For security purposes, SharePoint Designer recommends that you save the files in
=5 the _private folder of your FPSE-based Web site. FPSE makes this folder secure by
adding special permissions to it.
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With this option selected in the Form Properties dialog box, clicking Options opens the Saving
Results dialog box, as shown in Figure 9.18, where you can set more properties for the form.

The Saving Results dialog box provides the following tabs for setting form properties:

B File Results: Allows you to choose the file where the form data should be saved. You can
also choose the format in which the form data should be saved in the file. Optionally, you
can choose to send the form data to another file.

B E-mail Results: Allows you to specify the e-mail address where the form data should be
sent to. Again, you can choose the format in which the form data should be sent and then
type a custom Subject and Reply To line.

B Confirmation Page: Allows you to optionally specify a custom confirmation page that’s
displayed when the user submits the data by using the form

B Saved Fields: Allows you to choose from which form controls the data should be saved.
Also, you can use this tab to optionally save the date and time when the form was sub-
mitted as well as additional fields, such as computer name, username, and browser type.

" If you're designing a custom confirmation page, you can use the Confirmation
HlrlalRAS Fields control available in the Advanced Controls component type in the Insert Web
Component dialog box to display the form data that the user provided to fill in the form on the
confirmation page.

FIGURE 9.18

Configuring the form properties by using the Saving Results dialog box

File Results IE-maiI Results I Confirmation Page I Saved Fields I

File name:

|| Browse... |

File farmat:

JHTeL |
v Include field names [V Lakest results at end

Cptional second File:

File name:

I Erowse. .. |

File Farmat:

JHmeL |
¥ Include figld names [V Lakest results at end

QK I Cancel
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Sending to a database

Click the Send to database radio button in the Form Properties dialog box and then click Options
to open the Options for Saving Results to Database dialog box. This dialog box allows you to create
a database file (an .mdb file) with a table that holds the form data. When you click Create
Database in this dialog box, SharePoint Designer automatically creates an Access database file with
a table inside it to hold the data from the form. As shown in After you create the database,
SharePoint Designer displays a message indicating that the database is stored in the £pdb folder
inside the Web site, as shown in Figure 9.19.

FIGURE 9.19

Creating a new database file to store data from a form

Microsoft Office SharePoint Designer x|

° SharePoint Designer has successfully created a database For wou,
\J) The database can be found at "fpdbjUsingFarmComponents. rdb".
‘“When using the Database Results Wizard, use the data connection "UsingFarmComponents",

Also, if you click Add Connection in the Options for Saving Results to Database dialog box, the
Site Settings dialog box opens. The Database tab in this dialog box shows the newly created data-
base connection that’s used to establish the connection to the database file for storing the data. You
can also click the Database tab to create custom connection strings to different database types.
SharePoint Designer, like FrontPage 2003, generates ASP code in the background to enable the
send results to database functionality. The database connection code is stored in a file named
global.asa that’s created during the process of creating a new database.

The Send to database feature in SharePoint Designer uses a lot of proprietary legacy
- i ASP code. Given a choice, it’s recommended that you use the new ASP.NET 2.0 data
controls to create forms that save data in a database. These controls are discussed in Chapter 16.

After you create the database for storing the form data, click the Saved Fields tab in the Options for
Saving Results to Database dialog box to match the columns in the database to the form controls.
To summarize, follow these steps to send form data to a database:

1. Right-click on the form and then choose Form Properties from the popup menu to
open the Form Properties dialog box.

2. Click the Send to database radio button and then click Options to open the Saving
Results to Database dialog box.

3. Click Create Database to let SharePoint Designer create an Access database for stor-
ing the form data. After the database is created, the Database Connection to Use and
Table to hold form results dropdown menus are automatically populated with the newly
created database connection and newly created table in the database, respectively. You
can also specify a custom confirmation and error page in the Database Results tab.
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4. Click the Saved Fields tab and then ensure that the form fields are correctly
mapped to the corresponding database columns. This is shown in Figure 9.20. If not,
double-click the form field in the list and then use the Modify Field dialog box to match
the form field to the database column. You can also add additional fields to be saved in
the database by using the Additional Fields tab.
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5. Click OK. If the Web page you started with is an HTM/HTML page, a request to change
the extension of the Web page to ASP appears. This is important, as the Save Results to
Database feature is implemented by using ASP.

6. Save the Web page with an .asp extension.

FIGURE 9.20

Mapping form fields to database fields

Options for Saving Results to Database
Database Resuks Saved Fields I.ﬁ.dditional Fields |

Form Fields to Save:

Form Field I Database Column l &l Fields |

2]

Password] Passwordl
Passwordz Passwordz Add. ..
Textl Textl
Textz Textz Modify, ..
Textd Texkd
SEAR: Bemove |

Texts Texts

ok I Caneel

Sending to other

Clicking the Send to other radio button in the Form Properties dialog box allows you to send the
form data to a custom CGI ASP script running on the Web server for processing. It also allows you
to use the discussion and registration form handlers provided by FPSE.

In the next exercise, I show you how you can use the SharePoint Designer discussion form handler
in conjunction with the Included Content’s Page Web component to quickly create a discussion
Web page inside a Web site. As a prerequisite to these steps, ensure that you have an HTML form

created with the required form fields:
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1. Right-click on the HTML form and then choose Form Properties from the popup
menu to open the Form Properties dialog box.

2. Click the Send to other radio button and then choose Discussion Form Handler
from the dropdown menu.

Click Options to open the Options for Discussion Form Handler dialog box.

In the Discussion tab, type the title for the discussion and the name of the folder to
store all the discussion files.

The Directory box already has an underscore in it. Usually, the directories with the
- i prefix _ are considered as directories containing files on which other functionality
depends. Because the discussion form that you create in this exercise depends on the
discussion folder, you might want to add an underscore prefix to it.

5. Click the Date, Time, and User name check boxes. The completed Discussion tab is
shown in Figure 9.21.

FIGURE 9.21

The Options for Discussion Form Handler dialog box

Options for Discussion Form Handler 21

Discussion |nrticle I Confirmation Page I

Title: IDiscuss about yourself|

Diteckary: I_discussion

Table of contents layvout

Eorm Fields: ISuhject

IV Time: [ Remaote computer name

v Date ¥ User name

I~ Order newest ko oldast

Get background and colors from page (optional):

I Erowse. .. |

QK I Cancel |

6. Click OK and then save the Web page. If you refresh the Folder List task pane, a new
folder (_Directory Name) is created for storing the discussion files. This folder has a
tocproto.htm file in it.

7. Place the cursor below the form in the discussion form Web page.
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Choose Insert= Web Component to display the Insert Web Component dialog box.

Select Included Content in the Component type section and then choose Page in the
Choose a type of content list.

10. Click Finish. The Include Page Properties dialog box opens. Specify the location of the
tocproto.htm file here.

11. Click OK.

12. Save the Web page and then preview it in a browser.

If you’re working on a disk-based Web site, you need to publish the Web page to a
] - server-based Web site that has FPSE configured for it.

When you submit the form, you're taken to the Form Confirmation page. When you go back to
the form page and refresh (by pressing F5), a new article is shown at the location of the included
page Web component. Clicking on the article takes you to a Web page inside the folder you cre-
ated for storing the discussion files.

Validating forms

If you right-click on a form control inside your HTML form, the Form Field Properties menu
option appears. Clicking on this menu takes you to the properties dialog box specific to the form
control being worked on.

The Validate button in this dialog box provides an access point to the SharePoint Designer user
interface to create validation constraints on the form fields. These constraints are implemented by
SharePoint Designer as client-side scripts that are used to validate whether the user input matches
a specific format. If the user input doesn’t meet the required format, the form submission is can-
celled. Figure 9.22 shows the validation dialog box specific to text form fields.

Depending on the constraint you choose in the Data Type dropdown menu, the rest of the valida-
tion options are enabled. For example, choosing Text as a data type in the Data type dropdown
menu enables the Text Format group of options that allow you to further define the validation con-
straint for text format.

After the constraint is applied to a form field, the Code view just shows an HTML comment and
hides the actual validation script that enables the constraint. For example, you should see the fol-
lowing code after applying a validation constraint to a text form field:

<!--webbot bot="Validation" S-Data-Type="Integer" S-Number-
Separators="." B-Value-Required="TRUE" S-Validation-
Constraint="Greater than" S-Validation-Value="9" -->

However, when you open the page in another text editor, such as Notepad, the actual script that
implements the validation appears.

SharePoint Designer hides the actual code for the script in the Code view to avoid
unintentional tampering.
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FIGURE 9.22

The Text Box Validation dialog box

Display name: I

Data bype:

Text farmat
[ Letters [ wWhitespace

[ Digits [~ other: I

Murneric farmat

GrOURInG: ! Comma % Perind " Space ! rone
Degimal: %) Comma °) Eetind

Data length

W Required 1Min length: I Max length: I

Data value
v Field musk be: IGreater than 'I yalue: |9
[ and must be: ILess than or equal ko 'I Value: I

ok I Caneel |

Summary

FrontPage legacy components discussed in this chapter have been available for quite a while now,
and you might run into many Web site implementations where these components are being heav-
ily used. With the advent of many other Web technologies that make Web page development sim-
pler, the future of these Web components is uncertain. In this chapter, I discussed many of the
commonly used FrontPage components to familiarize you with them in case you run into a Web
site implementation that uses these components. If you're working on a new Web project, it’s rec-
ommended that you consider other technologies, such as ASP.NET 2.0, before implementing the
functionality using these components.
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SP.NET 2.0 introduces a large number of server controls that can

easily be used to implement most of the common Web site functions.

The term server controls means that these controls hold ASP.NET
code, which is actually processed on a Web server, and the resultant HTML
code generated is then sent to a Web browser for display. Using these con-
trols, Web designers can implement complicated scenarios on Web sites
without having to manually write much code. Most of these controls can be
worked with declaratively, which means you don’t have to write a large
amount of code to make use of these controls, and the purpose can be
availed by setting properties or attributes for the controls in HTML at design
time. This makes working with these controls very easy and significantly
reduces the development time and overhead. ASP.NET 2.0 provides Web
controls for many commonly needed Web site operations, such as data
access, login screens, validation, navigation and menus, treeviews, etc.

SharePoint Designer provides the ability to make use of most of the ASP.NET
2.0 controls. Using a design interface similar to Visual Studio, Web designers
can insert controls on ASP.NET Web pages and then exploit them by using
control properties and attributes. SharePoint Designer allows you to work
with the following set of control categories:

B Standard Controls: These are generic controls (including drop-
down menus, list boxes, text fields, and buttons) that aid in design-
ing Web site features, such as forms, views, wizards, etc.

B Data Controls: These are Web controls that allow you to declara-
tively develop applications for data access from a wide range of
data sources, such as SQL Server, XML files, Access databases, etc.

B Validation Controls: This set of controls provides built-in valida-
tion capability for user input. These controls can be bound to other
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FIGURE 10.1
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Web controls to constrain and verify user input, thereby providing security and protec-
tion to the back end that interfaces with the Web controls.

B Navigation Controls: These provide out-of-the-box functionality for developing site nav-
igation, dropdown menus, and treeviews.

B Login Controls: These allow you to develop login screens for Web sites and helps imple-
ment an interface for custom authentication and secure access.

it

For more on ASP.NET 2.0 data controls, see Chapter 16.

This chapter discusses using the SharePoint Designer designing interface to develop Web pages by
using the ASP.NET 2.0 Web controls. You work with many of the ASP.NET 2.0 controls in the
various exercises throughout this chapter and gain understanding about the properties, attributes,
and usage of these Web controls.

ASP.NET pages need to be published to a Web server to run. The Web server is responsible for
processing the code that ASP.NET pages carry. If you browse to an ASP.NET Web page directly
from the file system path (for example, C: \websitelocation), you would see the actual code
of a Web page in a browser. When you press F12 in SharePoint Designer to preview a Web page,
SharePoint Designer invokes the ASP.NET Development Server for executing the Web page. The
ASP.NET Development Server, which is installed when you install SharePoint Designer, is a light-
weight Web server that assists designers who don’t have a Web server machine to quickly preview
the ASP.NET Web pages in a browser. As shown in Figure 10.1, when you work on a local Web
site (residing on a file system location) and then preview an ASP.NET Web page in a browser by
pressing F12 in SharePoint Designer, SharePoint Designer instantiates the ASP.NET Development
Server.

The ASP.NET Development Server is invoked when previewing a disk-based ASP.NET Web page.

-

b,

i) ASP.NET Development Server E
http:fflocalhost: 14084/ SPDExplorer

Vi)

o
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The local ASP.NET page is executed and rendered by the ASP.NET Development Server and then
displayed in a browser. The ASP.NET Development Server isn’t invoked when previewing the ASP.
NET Web pages inside a server-based Web site. In that case, the Web page is requested from its
Web server location itself.

If you click the ASP.NET Development Server button in the notification area of the taskbar, the
ASP.NET Development Server dialog box opens, as shown in Figure 10.2.
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The ASP.NET Development Server dialog box

i
ASP.NET Development Server
Fiun A5P.MET applications locally. -
Physical Path: |C:ASPDE splorer
“irtual Path: |HSPDE:¢pI0rer
Fart: 14084
Foot URL:

This dialog box displays the physical file system location of the Web site being rendered by using
the ASP.NET Development Server. It also provides you with a Stop button that you can click to
stop the ASP.NET Development Server. As shown in Figure 10.3, the Preview tab in the Site
Settings dialog box (accessible by choosing Site = Site Settings) allows you to specify whether you
want to use the ASP.NET Development Server for previewing ASP.NET Web pages.

FIGURE 10.3

The Preview tab in the Site Settings dialog box

Site Settings ed |
Language | Mavigation I Database I
General Preview Parameters I Advanced
o

[V Use Microsoft A5P.NET Development Server:
& Faor only ASP.MET Web pages
~ For all Weh pages

™ Preview using custom URL For this Web site

I Erawse, ., |

[o]'4 I Cancel Aol
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You can choose to use the ASP.NET Development Server for previewing only ASP.NET pages or all
Web pages inside a Web site. The option to use the ASP.NET Development Server is grayed out
when working on server-based Webs. SharePoint Designer indicates that you can only use the ASP.
NET Development Server for disk-based Webs.

Using Standard Controls

The SharePoint Designer Toolbox task pane includes most of the standard ASP.NET 2.0 controls.
You use the Toolbox task pane to insert controls on an ASP.NET Web page. You can either drag
and drop the controls at the location of your choice on a Web page or insert the cursor at the
required location on a Web page and double-click the control in the Toolbox task pane to insert it
on a Web page. Figure 10.4 shows the standard controls available for use in the SharePoint
Designer Toolbox task pane.

While similar controls available in the Form Controls section of the Toolbox are
HTML controls, these controls are different in that they’re ASP.NET 2.0 controls.

FIGURE 10.4

Standard controls in the Toolbox task pane
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When you insert an ASP.NET control on an ASP.NET Web page, SharePoint Designer automati-
cally places it in an HTML form that has the runat="server" attribute set.

<form id="forml" runat="server">
<asp:MultiView runat="server" id="MultiViewl">
</asp:MultivView>

</form>

This means that the form controls are actually executed at the Web server where the Web site con-
taining the Web page is being hosted. ASP.NET 2.0 controls expose a number of properties that
can be used declaratively to set the control behavior at runtime. SharePoint Designer exploits this
ability of ASP.NET controls to provide a user interface that can be used to modify these properties.

T SharePoint Designer isn’t really a very useful tool for manually writing code-behind

- ® files (files with extensions .cs, .vb, etc.) for ASP.NET Web pages. For more
involved custom coding using ASP.NET programming languages, such as C# or VB.NET, you
need a developer tool, such as Visual Studio.

When ASP.NET controls are inserted on a Web page, SharePoint Designer displays a control-spe-
cific Common Tasks menu in the Design view. As shown in Figure 10.5, the Common Tasks menu
allows you to set the most common and important properties for the ASP.NET control.

FIGURE 10.5

The Common Tasks menu for the DropDownlList ASP.NET control
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You can show or hide the Common Tasks menu for an ASP.NET control by using the small arrow
button displayed in the top-right corner of the control in the Design view. The common operations
available for ASP.NET controls in the Common Tasks menu include:

B  Choose Data Source: Allows you to bind the ASP.NET control to a data source

1E‘F For more on data-bound controls, see Chapter 16.
Al

B  Enable AutoPostBack: Allows you to set the AutoPostBack property of an ASP.NET
control
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= ASP.NET controls implement a mechanism that allows for the Web page to be

- S8 posted back to the Web server for processing based on certain events in the
control. Called as AutoPostBack, a property is available for certain controls, which, if set to
true, sends the request to the server when an event happens in the control. For example,
setting the AutoPostBack property for the DropDownList ASP.NET 2.0 control to true posts
the ASP.NET Web page back to the server for processing whenever a user selects a different
value in the DropDownlList control.

B Auto Format: Allows you to choose from an out-of-the-box list of styling options for the
ASP.NET control

B Edit Templates: For ASP.NET 2.0 controls that allow template-based editing, this menu
option provides an access point to the user interface to change the templates associated
with the control.

Working with the Tag Properties task pane

One of the more detailed panes for setting declarative properties for the ASP.NET 2.0 controls in
SharePoint Designer is the Tag Properties task pane. As you already know, the Tag Properties task
pane can be used to set properties and attributes for HTML form controls and tags. When you view
Tag Properties for ASP.NET 2.0 controls, you make available a list of properties exposed for use by
the control. The Tag Properties task pane provides a Visual Studio-like interface to Web designers
for working with ASP.NET control properties. While you can use the IntelliSense feature in the
Code view to set these properties, the table-like structure of the Tag Properties task pane lists the
available properties and lets you set them without having to remember them. The Tag Properties
task pane is especially useful for working with ASP.NET 2.0 controls, as it provides a tabular list of
properties exposed by the control, and the designer can easily specify values for them. The Tag
Properties task pane displays the properties in various categories, as shown in Figure 10.6.

You can enable the Tag Properties task pane by choosing Tasks=> Tag Properties or by right-click-
ing the ASP.NET 2.0 controls and then choosing Properties from the popup menu. When you
select an ASP.NET control to show its properties in the Task Properties task pane, the top section
of the Tag Properties task pane shows the HTML tag for the ASP.NET control. The top section also
has the following buttons:

B Show categorized list: Sorts the properties in the task pane based on categories, such as
accessibility, appearance, behavior, data, etc.
B Show alphabetized list: Sorts the properties in the task pane alphabetically

B Show set properties on top: Displays the properties that have been manually set at the
top of the list or the category
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The Tag Properties task pane for the DropDownlList control
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Besides categorizing the properties, the Tag Properties task pane also provides you with the option
to expand or collapse property groups to attain more real state in the task pane. Many properties
allow access points to the user interface that can be used to set them. For example, selecting the
ForeColor property enables a dropdown menu that can be used to access the interface to choose
a color to be set as a value for the property. The Items property on the DropDownlList control has
the ellipsis (...) button that allows you to access the user interface to create new list items in the

control.

Working with standard controls

There are a number of commonly used controls in the Standard section of the Toolbox task pane.
Many of these standard controls are pivotal in providing interface elements to ASP.NET forms.
Controls such as Button, DropDownList, BulletedList, CheckBoxList, etc., are the primary controls
that you use for designing server-side forms on ASP.NET 2.0 Web pages. Most of these standard
controls can be bound to a source of data, such as a column in a table of a database, for displaying

and using the data retrieved from it.

| For more on binding standard controls to data sources, see Chapter 16.

This section takes you through some exercises for using some of the controls available in the
Toolbox task pane to familiarize you with the SharePoint Designer interface for declaratively work-

ing with ASP.NET controls.
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Using the AdRotator control

The AdRotator control provides the ability to create banner ads on a Web page. The control is
designed to shows images one after the other in a cyclic format. You can use the AdRotator control
to create a banner on a Web page that switches images based on a frequency defined in an XML
file. The XML file stores the configuration for the advertisements and is specified by the
AdvertisementFile property of the control. A sample AdvertisementFile is displayed in
the following code:

<Advertisements>
<Ad>
<ImageUrl>images/Imagel6.jpg</ImageUrl>
<NavigateUrl>http://spdexplorer:8009/Pagel6.htm</NavigateUrl>
<Impressions>16</Impressions>
</Ad>
<Ad>
<ImageUrl>images/Image2l.jpg</ImageUrl>
<NavigateUrl>http://spdexplorer:8009/Page2l.htm</NavigateUrl>
<Impressions>21</Impressions>
</Ad>
</Advertisements>

In the previous XML structure, the <Ad> element is repeated for every advertisement that you
want to schedule in the AdRotator control. The ImageUr1l element specifies the image to be dis-
played for the advertisement, and the NavigateUrl can be used to set the URL the user is taken
to when the image is clicked on. Impressions allows you to define the frequency of the image in
the banner. This means that the higher the value of the Impressions element for an image, the
more it’s shown. As shown in Figure 10.7, the elements of the advertisement XML file are actually
properties of the AdRotator control.

Ensure that you have a valid XML file created by using the previous structure for use in the
AdRotator control. To set up and use the AdRotator control, follow these steps:

1. Insert the AdRotator control on an ASP.NET Web page by using the Toolbox
task pane.

2. Right-click on the AdRotator control in the Design view and then choose Properties
from the popup menu. The Tag Properties dialog box opens, with the properties of the
AdRotator control shown.

3. Select the AdvertisementFile property and then click the ellipsis (...) button.
The Select XML File dialog box opens, which you can use to specify the XML file to be
used by the AdRotator control.

Choose the XML file you want to use for the AdRotator control.
Save the Web page and then preview it in a browser.
Whenever you refresh the Web page in a browser, the image displayed in the banner changes.

How often the image is displayed is defined by how high the value of the Impressions property
is for the Advertisement.
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Properties for the AdRotator control in the Tag Properties task pane
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Using the ImageMap control

The ImageMap control allows you to create images with hotspots on them. As you already know,
hotspots are areas or regions on an image that have hyperlinks on them. You can choose whether a
user clicks on the hotspot region to navigate to another URL or incurs a postback. To create
hotspots on an image by using the ImageMap control in SharePoint Designer, follow these steps:

1. Using the Toolbox task pane, double-click the ImageMap control to insert it on a

Web page.

2. Right-click on the ImageMap control inserted on the Web page and then click the
Tag Properties menu option to open the Tag Properties task pane.

3. In the Appearance category of the ImageMap control properties, select the
ImageUrl property and then click the ellipsis (...) button. The Select Image dialog

box opens.

4. Using the Select Image dialog box, select the image that you want to use for the

image map.
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Click OK. Now that you have selected the image, you can create hotspots on the image.

Select the HotSpots collection by using the Tag Properties task pane and then click
the ellipsis (...) button. The HotSpot Collection Editor dialog box, as shown in Figure
10.8, opens. The Add button has an arrow indicating that it’s a dropdown menu.

Click the arrow to show three types of hotspots: CircleHotSpot, RectangleHotSpot,
and PolygonHotSpot. Based on the type of hotspot you select, the list of properties in
the Properties list in the HotSpot Collection Editor dialog box changes.

Choose CircleHotSpot to add a circular hotspot to the collection. The Properties list
is filled with the properties that you can set for this hotspot.

Specify the Radius, X, and Y properties for this hotspot. You can also specify the
AlternateText property, which is displayed when you hover over the hotspot.

FIGURE 10.8

The HotSpot Collection Editor dialog box
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10. Change the HotSpotMode property to Navigate. The following modes are available for

the hotspot:
NotSet: Indicates that the hotspot has not been set

PostBack: Specifies that clicking on the hotspot should postback the Web page for
processing

Navigate: Indicates that clicking on the hotspot should navigate to the URL specified
in the NavigateUrl property
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11. Click the ellipsis (...) button in the NavigateUrl property, and using the Select
URL dialog box, choose the URL that a browser should navigate to when a site visi-
tor clicks the hotspot. The complete hotspot settings are shown in Figure 10.9.

12. Repeat the previous steps to create multiple hotspots by using the HotSpot
Collection Editor dialog box.

13. Save the Web page and then preview it in a browser.

When you hover over the image containing the hotspots, the mouse pointer changes, and you can
click the specific portion to navigate or postback. Also, if you have set the AlternateText prop-
erty for a hotspot, a screen tip appears when you hover over that hotspot.

FIGURE 10.9

Creating a circular hotspot by using the HotSpot Collection Editor dialog box
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Using the Wizard control

The Wizard control is a very interesting tool in ASP.NET 2.0 and allows you to create screens or
multiple views for collection data from users. The control provides for implementing a step-based
approach for developing user forms and surveys. Rather than having a single large form, the com-
ponents of the form can be divided into steps (called WizardSteps). The user can go back and forth
from one step to another while filling out the form without losing any data already filled in.

R It’s important to note that while the Wizard control allows you to design

. 3t WSS the user interface for a seemingly multipage input form, it doesn’t provide
the implementation for actually saving the user data. The developer must implement the logic
for saving the data collected to a data source.
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In the next exercise, you use the Wizard control to create a multipage survey form’s user interface.
Follow these steps:

1. Using the Toolbox task pane, double-click the Wizard control to insert it on a Web
page in the Design view. This inserts the Wizard control on the Web page and displays
the Common Wizard Tasks menu, as shown in Figure 10.10. By default, two steps have
been created for you in the Wizard control.

FIGURE 10.10

Inserting a Wizard control on an ASP.NET Web page
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2. Click the Add/Remove WizardSteps link in the Common Wizard Tasks menu to
open the WizardStep Collection Editor dialog box. Use this dialog box to create new
steps in the wizard, as shown in Figure 10.11. The StepType property in the Behavior
category in the Step 2 properties list determines the buttons that are displayed in the step:

Start: The step having this StepType displays a Next button.
Step: The step having this StepType displays the Next and Previous buttons.
Finish: The step having this StepType displays a Finish button.

Complete: The step having this StepType displays no navigation buttons and hides
the navigation bar (called the SideBar) on the left if it’s displayed.

Auto: If selected, one of the previous StepTypes is chosen for the step based on
where the step is in the list of steps. For example, the first step is set to use the Start
StepType.

3. Click Add to add new steps to the Wizard control. As shown in Figure 10.12, each

step can correspond to a page in the survey form. You can use the Title property to
name the steps.
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Creating new steps in the Wizard control by using the WizardStep Collection Editor

dialog box
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FIGURE 10.12
Corresponding steps to pages in the survey form
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Click OK after you add the steps.

Click the arrow in the top-right corner of the control in the Design view to open the
Common Wizard Tasks menu.

Click the AutoFormat link to open the AutoFormat dialog box.
Choose the format you want to apply to the Wizard control and then click Apply.

Click OK. In the Design view, the wizard with the steps is created. If you preview the
Web page in a browser, the Wizard control lets you move from one step to another by
using the navigation buttons: Start, Previous, Next, and Finish.

Using the Design view, you can now insert other controls to complete your survey form. Place
the cursor in the main area of the wizard and then add the controls for user input, as shown in
Figure 10.13.

After you finish creating one step of the wizard, you can click the link for the next step in the
Design view to add controls and build the next step. When your wizard is complete and you pre-
view the Web page in a browser, when you move between steps, the values that you filled in for
the controls in each step are preserved.

FIGURE 10.13

Adding other form controls to a step in the Wizard control
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Understanding Expressions

A common property found in most ASP.NET 2.0 controls is Expressions. Displayed in the Data
section in the Tag Properties task pane for ASP.NET 2.0 controls, the Expressions property is a
mechanism to bind properties of an ASP.NET control with settings defined in the application con-
figuration file; that is, the web. config file of the ASP.NET Web application.
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| The web.config file is an XML configuration file stored in the root of the ASP.NET
¥ Web application. This file is used to store general settings for the Web application,
such as connection strings, authorization settings, application settings, etc.

You can create a web. config file for your ASP.NET Web site in SharePoint Designer. Follow
these steps:

1. Choose File=> New to open the New dialog box.

2. Select Web Configuration in the ASP.NET section of the Page tab, as shown in
Figure 10.14.

FIGURE 10.14

Creating a web . config file in SharePoint Designer
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3. Click OK. SharePoint Designer creates a web. config file for a Web site, with some sec-
tions by default. The following code is written by SharePoint Designer by default for the
web.config file it creates:

<?xml version="1.0"?>

<!--
A full list of settings and comments can be found in
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machine.config.comments usually located in
\Windows\Microsoft.Net\Framework\v2.x\Config

-
<configuration xmlns="http://schemas.microsoft.com/.

NetConfiguration/v2.0">

<appSettings/>

<connectionStrings/>

<system.web>

<!--
Set compilation debug="true" to insert debugging
symbols into the compiled page. Because this
affects performance, set this value to true only
during development.

-——>

<compilation debug="false"/>

<!--
The <authentication> section enables configuration
of the security authentication mode used by
ASP.NET to identify an incoming user.

-—>

<authentication mode="Windows" />

<!--
The <customErrors> section enables configuration
of what to do if/when an unhandled error occurs
during the execution of a request. Specifically,
it enables developers to configure html error pages
to be displayed in place of a error stack trace.

<customErrors mode="RemoteOnly" defaultRedirect="GenericEr
rorPage.htm">
<error statusCode="403" redirect="NoAccess.htm"/>
<error statusCode="404" redirect="FileNotFound.htm"/>
</customErrors>
-——>
</system.web>
</configuration>

The highlighted <appSettings/> and <connectionStrings/> section of the web.config
file can be used to store some general settings and connection strings that can be referenced later in
any ASP.NET Web page inside the Web site associated with the web. config file.

The Expressions property is used to bind the properties on an ASP.NET control to settings
defined in these sections of the web. config file. For example, you can define a general connection
string for a database in the web. config file and then use the Expressions property of the
ASP.NET control to bind the connection string to a property of the control. The following exercise
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illustrates this. Here, you define an application setting in the web . config file of the Web site and
then bind it to a property of an ASP.NET control by using Expressions. Follow these steps:

8.
9.

Create a web. config file for your Web site by using SharePoint Designer.

Open the web. config file in the Code view and then look for the <appSet-
tings/> code.

Replace the <appSettings/> code with the following code:

<appSettings>
<add key="category" value="hotels"/>
</appSettings>

You have just added an application setting named "category" in the application set-
tings section of the web. config file.

Save the web. config file in the root folder of your Web site.

Open a Web page in SharePoint Designer and then insert a Label ASP.NET control
by using the Toolbox task pane.

Using the Tag Properties task pane for the Label control, select the Expressions
property.

Click the ellipsis (...) button to open the Expressions dialog box for the Label con-
trol, as shown in Figure 10.15.

FIGURE 10.15

The Expressions dialog box
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In the Bindable properties list, select the Text property.

Select AppSettings in the Expressions type dropdown menu.
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10. In the Expression properties list, select the category application setting as the value
for AppSettings, as shown in Figure 10.16. That category is the AppSettings that
you defined in step 3. If you add more AppSettings in the web.config file, theyre
all listed here.

11. Click OK. The value of the category AppSetting is substituted as the value for the Text
property of the label control. Similarly, you can use the web.config AppSetting in
multiple controls. When you need to make a change to the AppSettings, you just
need to change the web. config file, and the changes are applied to all the controls
bound by using Expressions.

The Expressions property is especially useful in binding the connection strings stored in the
web. config file with the ASP.NET controls spread across a Web site. This way, you can keep the
connection strings at a single location and then reuse them.

FIGURE 10.16

Binding control properties by using the Expressions dialog box
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Editing ASP.NET control templates

While most of the ASP.NET 2.0 controls provide styling capabilities by using properties and styles
that you can access in SharePoint Designer via the Tag Properties task pane, some ASP.NET 2.0
controls offer granular control on the layout of the control at runtime by allowing you to modify
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the control’s look by using predefined templates. Templates essentially don’t provide for changing
the style or appearance of the control but allow you to add elements and controls to specific por-
tions of the ASP.NET control.

Templates can be used to hold HTML and ASP.NET server controls. When the control exposing
the template is rendered at runtime, the default HTML for the control is replaced with the contents
of the template. For example, if you want to change the navigation buttons in a particular step in
the Wizard control to LinkButton controls, you can do so by changing the templates associated
with various WizardSteps. The following exercise takes you through the steps to change the Next
button in the first step of the Wizard control to an ImageButton control. Follow these steps:

1. Using the Wizard control, create a wizard with two steps so that clicking the Next
button in the first step takes you to the second step.

2. In the Common Wizard Control Tasks menu, click the Edit Templates link, as
shown in Figure 10.17. In the Wizard control, the Next button that appears in the step
with the StepType property set to Start is templated by using the
StartNavigationTemplate.

3. Click the Edit Templates link to switch the Common Wizard Control Tasks menu
to the Template Editing Mode and then choose StartNavigationTemplate from the
Display dropdown menu, as shown in Figure 10.18.

4. Place the cursor in the StartNavigationTemplate and then double-click the
ImageButton control in the Toolbox task pane to insert an ImageButton control in
the template area.

5. Using the Tag Properties task pane, set the ImageUrl property of the ImageButton
control to the image you want to use for the button.

FIGURE 10.17

Editing the templates for the Wizard control
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FIGURE 10.18

Switching to the Template Editing mode in the Common Control Tasks menu
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6. Type MoveNext in the value column on the CommandName property for the
ImageButton control in the Tag Properties task pane, as shown in Figure 10.19.

7. Click the End Template Editing link. The Next button is replaced with the
ImageButton control.

8. Save the Web page and then preview it in a browser.

FIGURE 10.19

Setting the StartNavigationTemplate for the Wizard control
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When you click the ImageButton control in the first step, it takes you to the next step in the wiz-

ard. You can change the other templates for the wizard in a similar manner to customize the layout
of your Wizard control.

While using templates, it’s important to set the CommandName property of the

& controls you place in the templates. For example, if you want to customize the
left navigation bar by using the SideBarTemplate of the Wizard control, keep in mind that

the navigation bar is built up of a Datalist control (having the CommandName=SideBarList),
which has a Button control (with the CommandName=SideBarButton) in its [temTemplate
template. To customize, you have to place a custom Datalist control in the SideBarTemplate,
which has a Button control in its ItemTemplate template.
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Implementing Validation
by using ASP.NET Controls

ASP.NET 2.0 provides a number of Web controls that can be used to declaratively validate user
input on other ASP.NET controls. Simply put, associating a control with a validation control
enables you to perform a specific sort of validation operation on the input that’s made to the con-
trol. The Validation section of the Toolbox task pane lists the ASP.NET 2.0 validation controls. The
validation controls are capable of performing both client-side validation (if the browser supports
scripting) and server-side validation.

For increased security and suppressing malicious validation, the validation controls

OT]

> - are designed to always perform server-side validation even if the client-side
validation has already been performed.

Understanding ASP.NET validation controls

As discussed earlier, the process of validating user input to ASP.NET controls using validation con-
trols is by associating the validation control with the ASP.NET control. This is usually done by set-
ting the ControlTovValidate property of the validation control. ASP.NET 2.0 makes the
following validation controls available:

B  CompareValidator: This control is used to either compare the value of a control to a
static value or compare the values of two controls on the Web page. You can also specify
the operator for the comparison.

B CustomValidator: Allows you to write a custom piece of code that can be used to vali-
date user input to a control

B RangeValidator: Can be used to find out if the user input to a control matches within a
particular range of values

B RegularExpressionValidator: Allows you to find out if the user input matches a pattern
of characters defined by a regular expression syntax

B RequiredFieldValidator: Allows you to constrain a user from typing empty values in the
associated control

B ValidationSummary: Sums up the validation errors of all the validation controls on the
page in a single summary

The Causevalidation property of a control triggers the validation to be performed on the Web
page. For example, submitting a form containing validation controls associated with the form con-
trols by using an ASP.NET button control with the Causevalidation property set to true
causes the validation to occur during the postback.
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Using validation controls

The following exercise takes you through the steps you need to take to implement validation on a
number of form controls on form submit. You mandate user input on the controls by using the
RequiredFieldValidator control, compare the inputs using a CompareValidator control, and display
the error messages using a ValidationSummary control. Follow these steps:
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1.

Open an ASP.NET Web page in the Design view and then create a form with three
ASP.NET TextBox controls and a Button control. Change the Text property of the
Button control to Submit and then ensure that the CausevValidation property of this
control is set to true. The sample form is shown in Figure 10.20.

FIGURE 10.20

A sample form with three TextBox controls and a Button control
El <body =| | <formatforml = |<asp:button#ButtDn1>| El

Matne: J )
Start-Date:-I .

End-Date:-| L

asp:button#Butkonl
Submit

Using the Validation section of the Toolbox task pane, insert a ValidationSummary
control below the Button control inserted in step 1.

Insert three RequiredFieldValidator controls and a CompareValidator control at the
bottom of the form.

Select the first RequiredFieldValidator control and then set its
ControlToValidate property to the first TextBox control.

Set the ControlTovalidate property of the other two RequiredFieldValidator
controls to the corresponding TextBox controls.

Set the ErrorMessage property for all the RequiredFieldValidator controls appro-
priately. These should be the messages that display when user input isn’t a match.

Select the CompareValidator control and then set its ControlTovalidate and
ControlToCompare properties to the appropriate TextBox controls (Start Date
and End Date, respectively, for this exercise).

Set the Operator property of the CompareValidator control to Less Than and the
Type property to Date. Also, set the ErrorMessage property of this control appro-
priately, as shown in Figure 10.21.

Save the Web page and then preview it in a browser.
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Setting properties for the CompareValidator control

E <body > |<form#Form1 >| |<asp:comparevalidator#cumnare\falida. " >| El

Name‘-_l Marneshouldnot-beleft-empty J

Start-Date -l Start-Date-shouldnot-be-empty. J
End-Date‘-_I End-Date-should-not-be-empty

asp:comparevalidator#Comparevalida. ..

Start-Date-should-not-be-greater-than-end-date

Submit q

® Error message 1.
® Error message &

If you submit the form without filling in the text fields, the RequiredFieldValidator catches this
and reports an error. Also, if the Start Date is greater than the End Date, the CompareValidator
reports an error. The ValidationSummary control displays the summary of the errors.

Implementing Navigation
in ASP.NET Web Sites

While ASP.NET 2.0 provides a number of controls to implement site navigation, almost all of them
depend on a sitemap. A sitemap is simply an XML file (called web. sitemap) that stores the navi-
gational information about the site in a structured format. The ASP.NET navigation controls use this
XML file as a source of data to display the information contained in different graphical manners.

Creating sitemaps

SharePoint Designer provides a template file that allows you to start building a web. sitemap file
for your Web site. To create a web. sitemap file, choose Filem> New to display the New dialog
box. In the ASP.NET section of the Page tab is the Site Map option. The default sitemap file that
SharePoint Designer creates has the following code:

<?xml version="1.0" encoding="utf-8" ?>
<siteMap xmlns="http://schemas.microsoft.com/AspNet/SiteMap-File-1.0" >

<siteMapNode url="" title="" description="">
<siteMapNode url="" title="" description="" />
<siteMapNode url="" title="" description="" />
</siteMapNode>
</siteMap>
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The sitemap XML file needs the <siteMap> element as the root element for the XML structure.
Within the <siteMap> element, there needs to be at least one <siteMapNode> element that
describes the name, relative URL, and description of the link in the site navigation. Then, you have
a </siteMapNode> that helps define the nested navigation links. The following code is a sample
XML for the web. sitemap file:

<?xml version="1.0" encoding="utf-8" ?>
<siteMap xmlns="http://schemas.microsoft.com/AspNet/SiteMap-File-1.0" >
<siteMapNode url="~/default.htm" title="Home" description="Home
Page">
<siteMapNode url="~/InsertingWebComponents.htm" title="Web
Components" description="Inserting web components on web pages" />
<siteMapNode url="~/StandardControls.aspx" title="Standard
Controls" description="Inserting standard controls" />
</siteMapNode>
</siteMap>

The ASP.NET 2.0 controls can now use this web. sitemap file to display the stored navigation.
SharePoint Designer makes available the Menu, TreeView, and SiteMapPath controls for use on
Web pages.

Using ASP.NET navigation controls

In the next exercise, you use the TreeView control to display the navigation structure defined in
the web. sitemap file for the Web site. To enable the ASP.NET 2.0 controls on a Web page, you
need to follow these steps:

Create a web. sitemap file for your Web site.

2. Using the Data section of the Toolbox task pane, insert a SiteMapDataSource con-
trol on a Web page where you want to insert a navigation control. This control acts
as a data source and helps the navigation control retrieve data from the web. sitemap
file for display.

3. Insert the TreeView control on the Web page. The Common TreeView Tasks menu is
displayed in the Design view, as shown in Figure 10.22.

4. Using the Choose Data Source dropdown menu, select the SiteMapDataSource con-
trol you inserted on the Web page in step 2.

5. Click the AutoFormat link to open the AutoFormat dialog box and then choose a
style for the TreeView control. There are a number of interesting formats to choose
from in the AutoFormat dialog box for the TreeView control. You can format the tree to
look like a file structure, help file, mailbox, etc.

6. Save the Web page and then preview it in a browser.
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Choosing the data source for the TreeView control

|44 "web Site || NavigationControls.aspx® x
El <body = |<F0rm#Form1 = | I<asp:treeview#TreeView1 >| E|

F

iteMapDataSourcel

iteManDataSn g -
aspitreeviews TreeYisw 1

= Foot Common TreeYiew Tasks
] = Parent 1 AutoFormat. ..
Leaf 1 Choose Data Source: | {Mone) IT
Leaf 20 ;
F 2 Edit Nodes. . SiteMapDataSourcel
= 1P [T Show Lines <Mew data source. .. >

Leaf'1

Similarly, other navigation controls can also be bound to the SiteMapDataSource control to display
navigation stored in the web . sitemap file. It's recommended to place the navigation control on a
master page so that all the attached Web pages can inherit it.

= For more on master pages in ASP.NET 2.0, see Chapter 13.

Working with Login Controls

The ASP.NET 2.0 login controls allow Web designers to quickly develop template-based login
interfaces on Web pages for creating, updating, and deleting users as well as authenticating and
authorizing users. This form of authentication is called Form-Based Authentication and requires
additional setup for membership services, role provides, etc., in the web. config file and a data-
base to store the usernames and passwords. SharePoint Designer provides the following ASP.NET
2.0 login controls:

B ChangePassword: Allows you to create an interface for changing user passwords for a
Web site. The control verifies the old password provided as user input before changing
the password.

B CreateUserWizard: This control is derived from the Wizard control and allows you to
create a step approach for providing an interface for creating new users on a Web site.

B Login: This allows you to create a user interface on a Web page that logs a user into the
Web site.

B LoginName: Displays the currently logged-on user’s name on the Web page. The control
doesn’t display anything if you're logged on anonymously.
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B LoginStatus: This control determines whether a user is logged on to a Web site. If it
finds a user logged on, it displays a link to log out. Otherwise, it offers the user a link to
log in that redirects to a page containing the Login control.

B LoginView: This control determines the login status of a user and, based on his or her
authentication status, displays different content to the user. For example, this control
can be used to display different content to a user based on whether he or she is logged in
or not.

B PasswordRecovery: Includes the implementation of the user interface for recovering
passwords after confirming the user identity. It also combines the facility to change the
passwords.

All the Login controls use the ASP.NET membership provider/service defined in the
web.config file for the Web application for performing their operations.
Developers are responsible for appropriately configuring the application configuration settings
for the membership service before these controls can actually be actively used on a Web site.
Implementing the membership service also includes creating a back-end database that’s used to
store user information.

Enhancing Forms with ASP.NET Controls

By now, you have created the user interface for a number of forms by using both HTML and ASP.
NET controls. It’s very important for you to review Chapters 15-18 to be able to implement the
complete form functionality because most forms are intended to collect data from users and then
save it to a back-end data source for review, analysis and investigation, retrieval, etc.

Forms are a pivotal piece of Web site implementation. As a result, most of the ASP.NET 2.0 con-
trols concentrate on making form development easier and more declarative. Still, with so many
controls available, it’s important to pick the right ones based on your requirements. Here are some
considerations that you might find useful when developing form Web pages via SharePoint
Designer:

B Forms tend to become large when and as more information is required to be collected
from users. It’s a good practice to page such large forms into multiple steps. This helps
reduce user frustration in scrolling down Web pages while filling in forms. You can use
the Wizard control to implement a multipage form quite effortlessly.

B There are various formats and styles in which users may perceive date and time.
Therefore, it’s a bad idea to have users fill out the dates in a text field. It’s recommended
that you use the Calendar control instead. Still, if the form design mandates that you use
simpler controls, such as Textbox, ensure that you validate it properly by, for example,
using the RegularExpressionValidator control. While the ASP.NET controls are pretty
robust in this area, to ensure protection from malicious user input and avert attacks,
ensure that you properly validate user input before submission to the back-end data
source.
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Wherever applicable, you should use predefined or data-bound Dropdown controls or Listbox
controls to facilitate user input in the forms. Users like to make a choice from a list of options
rather than having to type in the values. Besides, this automatically reduces the chances of mali-
clous user input.

Exploring ASP.NET Web Part Controls

The Toolbox task pane in SharePoint Designer hosts another set of ASP.Net 2.0 controls called
Web part controls. These are generic controls that can be used to host custom Web part controls
and server controls developed programmatically. The primary hosting controls offered in ASP.NET
2.0 for Web patrts are:

B WebPartZone: This control acts as a placeholder control and hosts other server Web part
controls and ASP.NET 2.0 controls.

B CatalogZone: A catalog is basically a list of Web part controls. The CatalogZone allows
developers to create a list of Web parts that can be used to insert them on Web pages
dynamically at browse time.

B EditorZone: This control acts as a host for a number of editor Web parts, such as
AppearanceEditorPart, BehaviorEditorPart, LayoutEditorPart, and
PropertyGridEditorPart. The editor Web parts can be used to design the editing interface
of the Web part properties, which are displayed to the end user at browse time.

B ConnectionZone: The ASP.NET 2.0 ConnectionZone Web part allows developers to
enable connections between Web parts at browse time. This means that end users visiting
the Web sites can connect two or more Web parts together and then transfer data from
one Web part to another.

Web part controls are different from other ASP.NET controls in that ASP.NET 2.0 provides the
infrastructure to dynamically add, remove, and modify properties of Web part controls directly in
a browser. This means that developers can use these controls to program Web site interfaces in
such a way that the end user visiting a Web site can add or remove Web parts from a list of pre-
defined Web part controls. This way, developers can offer enhanced control of the Web site inter-
face to Web site users.

SharePoint extensively uses these Web part controls as well as controls inherited from these con-
trols to implement its Web part functionality. ASP.NET 2.0 also forms the basis for the ability to

add Web parts dynamically to Web pages at browse time, creating Web part connections, editing
Web part properties, etc.
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Summary

Although SharePoint Designer can’t be used to write code-behind files for writing custom code, it
provides Web designers with a visual experience to work with ASP.NET 2.0 controls and declara-
tively set properties without having to write any code. The Toolbox task pane in SharePoint
Designer allows you to insert and configure standard, data, navigation, login, and validation con-
trols on ASP.NET Web pages. It provides Web designers with a property grid-like interface for
modifying properties for these ASP.NET controls. It can be used to work with ASP.NET 2.0
expressions, layout control templates, and implement styles and formatting. SharePoint Designer
also installs a lightweight ASP.NET development server that it uses for enabling ASP.NET Web
page previewing on disk-based Web sites.
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arlier in this book, I introduced some basic concepts about

SharePoint sites. I talked about the interface and layout of a

SharePoint site as well as how to create SharePoint sites, site collec-
tions, and Web pages. 1 showed how you can use SharePoint Designer to
create Web pages for SharePoint sites. You were also given a quick overview
of what a SharePoint Web part is. Now that you have been exposed to
SharePoint Designer for creating non-SharePoint content, I want to revisit
SharePoint to offer more details about the components of a SharePoint site
and how they interact with SharePoint Designer.

In this chapter, I introduce you to some key concepts about SharePoint that
readily apply when you work with SharePoint Designer on SharePoint sites. 1
discuss concepts such as ghosting and un-ghosting of SharePoint content,
take you through the user interface provided by SharePoint and SharePoint
Designer for working with SharePoint Web parts and controls, and mention
the commonly used SharePoint Web parts and controls. I familiarize you
with SharePoint Web part galleries and discuss how you can add Web parts
to these galleries for use in SharePoint sites. You also become familiar with
the concept of Web part zones and how you can use SharePoint Designer to
insert Web part zones on custom pages to facilitate easier interaction with
Web parts on SharePoint sites.

To start, you must know that every SharePoint site or site collection is based
on a site definition. At creation, based on the site template chosen for the
site, SharePoint reads the site definition files from its file system location and
uses it to define the look and feel, features, and functionality that are applied
and made available for the site being created. As with most SharePoint files,
you can create new site definitions or modify existing ones to define how the
site should behave and what features should be made available to it. Site def-
initions are installed on the machine running SharePoint at installation time
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and are stored at C: \Program Files\Common Files\Microsoft Shared\Web Server
Extensions\12\TEMPLATE\SiteTemplates. In fact, the TEMPLATE folder hosts most of
the SharePoint definition files, templates, layouts, CSS and JavaScript files, themes, etc.

Every SharePoint Web application has virtual directories created in it that point to various folders
in the TEMPLATE folder. For example, the layouts virtual directory created at Web application
creation points to the C: \Program Files\Common Files\Microsoft Shared\Web
Server Extensions\12\TEMPLATE\LAYOUTS folder and hosts most of the SharePoint set-
tings for Web pages, master pages, JavaScript files, images, etc.

When a SharePoint Web page is requested for display in a browser, SharePoint combines the file
system copy of the Web page and the data retrieved from the SharePoint databases to show the
final Web page to the user. The file system copy may be common to multiple SharePoint pages.
This ghosted approach used for displaying Web pages is the default behavior followed by
SharePoint to render all pages inside the Web site. However, this approach changes after the Web
page has been modified and saved by SharePoint Designer.

After you modify a Web page using SharePoint Designer, the Web page becomes completely stored
in the SharePoint database. The process that un-ghosts the Web page is important for SharePoint
Designer to be able to make persistent changes and allow for remote authoring of the Web pages.
When the Web page is un-ghosted, the file system copy is no longer used, and the page is directly
retrieved from the database for display.

While previous versions of SharePoint didn’t allow for an option to re-ghost the Web pages so that
they fall back to the default behavior, WSS v3 and MOSS sites allow you to re-ghost the Web pages
by using a process called Reset to Site Definition. When you edit and save a SharePoint Web page,

such as default.aspx, in SharePoint Designer, a warning pops up, as shown in Figure 11.1.

FIGURE 11.1
Un-ghosting Web pages by using SharePoint Designer

Site Definition Page Warning d |

/AN

Saving your changes will customize a page from the site
definition. Are you sure you want o do this?

About SharePoint site definitions
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After you click Yes in the Site Definition Page Warning dialog box, a blue icon appears next to the
modified page in the SharePoint Designer Folder List task pane, as shown in Figure 11.2. If you
hover over the Web page in the Folder List task pane, a screen tip shows that the page has been
customized.
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The Folder List task pane displays a blue icon next to a modified Web page.
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When you right-click in the Web page, the popup menu shows a Reset to Site Definition option.
This allows you to reset the Web page back to the default SharePoint behavior of ghosting by using
the site definition files.

Resetting a Web page back to site definition means that you lose all customizations
% that you made to the Web page via SharePoint Designer. SharePoint falls back to
the default ghosting behavior.

If you have a large number of SharePoint Web pages that have been customized by using
SharePoint Designer, you can use the master Reset to site definition link on the SharePoint Site
Settings Web page, as shown in Figure 11.3.
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Clicking on the link opens the layouts/reghost.aspx Web page, which allows you to either
specify a URL of the Web page that you want to re-ghost or reset all pages in the site-to-site
definition.

Web pages created from scratch by using SharePoint Designer are always stored in the SharePoint
database and can’t be ghosted. So, you won't find the Reset to site definition link on such Web

pages.

FIGURE 11.3

Use the Reset to site definition link on the Site Settings Web page to reset all customized pages to the
default site definition.

SPD Explorer = Site Setkings

Site Settings

Site Information

Site URL: htkps ) fwinZ003kwo: B6E7]
Mabile Site URL: httpe j fwin20n3two: G687 fmf
Wersion: 12.0.0.631%
Users and Permissions Look and Feel Galleries Site Administration Site Collection Administration
@ People and groups @ Title, description, and icon 8 Master pages 8 Regional settings a Search settings
@ Site collection o Tree view B Site content bypes 8 Site libraries and lists a Search scopes
admiristrators @ Site theme 8 Site columns B Sike usage reparts a Search keywords
8 Advanced permissions 8 Top link bar B Site templates B User alerts a Recycle bin
& Quick Launch @ List templates 8 R55 a Site directory settings
@ Save site as kemplate o YWeb Parts 8 Search visibility a Sike colleckion usage reports
o Reset ko site definition B YWorkFlows B Sites and workspaces a Sike collection Features
B Site Features a Sike hierarchy
8 Delete this site @ Portal site connection
© Related Links scope a Sike colleckion audit settings
settings

a audit lag reparts

a Sike collection policies

Understanding SharePoint Web Parts

SharePoint Web parts are mostly just special types of Web controls that provide a specific set of
features and abilities for a SharePoint site. For example, the Image Web part allows you to display
pictures on a SharePoint Web site. By default, SharePoint provides a large number of Web parts
that are either used by the sites themselves or can be inserted on the Web pages by using the
SharePoint interface. Before discussing more about Web parts, I want to briefly talk about the vari-
ous galleries that are available in SharePoint sites.
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If you go to the Site Settings page of a SharePoint site by choosing Site Actionst Site

Settings=> Modify All Site Settings, there are a number of galleries in the section called Galleries.
These galleries are basically libraries that hold special types of documents and files. You can expect
to see the following galleries on a SharePoint site:

B Master pages: This gallery holds the default master pages and page layouts that are avail-
able for a SharePoint site. Page layouts are available only for MOSS Web sites.

W Site content types: This holds the default and user-created site content types available
for use on a Web site.

B Site columns: Holds the default and user-created site columns available for use on a Web
site. Think of site columns as independent site-level columns that can be added to a list
or content types.

B Site templates: SharePoint allows you to save a site as template that can later be used to
create a new site. The Site template gallery allows you to upload site template files for use
in SharePoint.

B List templates: Similar to site templates, lists can be stored as templates for reuse. The
List template holds the list templates for a site.

B Web Parts: The Web parts gallery contains the Web parts that have been activated for a
SharePoint site. There’s a list of . dwp or .Webpart files in this gallery. To be able to use
a Web part on a SharePoint site, you need to add the Web part to the Web part gallery.

B Workflows: Shows the list of workflows activated for a site.

As shown in Figure 11.4, if you open a SharePoint site in SharePoint Designer and then expand the
_catalogs folder by using the Folder List task pane, a number of libraries appear in SharePoint
Designer.

While you use the master page gallery listed here for working with SharePoint master pages and
page layouts in SharePoint Designer, other galleries aren’t used in SharePoint Designer.

Web patrts, like most other applications, need to be deployed on a SharePoint server before they
can be used on a Web site. Once they’re properly deployed, the Web parts are available for upload
to a Web part gallery. As shown in Figure 11.5, Web parts that are properly deployed on a
SharePoint server are available for addition to the Web part gallery in the New Web Parts page.

You can access the New Web Parts page by clicking the New action button in the Web Part
Gallery. Just select the Web parts you want to include in your Web part gallery and then click
Populate Gallery. From here on, the Web part is available for use for a Web site.
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FIG

1.4

The SharePoint galleries in SharePoint Designer

Folder List A =

[C5) htkpe ffwinz 003w BEE7 =
= ) _catalags
[ Custam workflow process
3] fpdatasources
(3] Ik {List Template Gallery)
=] [E3] masterpage (Master Page Gallery)
|5 Forms
LEa] Preview Images
@’J AdvancedSearchLayout, aspx
] default.master
Defaultl ayout. aspe

MewsHomeLayout, aspx
PeoplesearchResults, aspx
RepartCenterLayout, aspx
SearchMain, aspx
SearchResuls, aspx
TabViewPageLayaout, aspx
welcomelayout?, aspx

(] users {User Information List)

3] wp {Web Part Gallery)

3] wit (Site Template Gallery)
(=

I _private
53| Form3erver Templates (Form Templates)
|5 images
53] IwConwvertedForms (Converted Forms)
) Lists
=m

ft LD Fi

E
E
E
E
E
E
E
E

Taroclatk

FIG 11.5

The New Web Parts page in Site Settings

SPD Explorer > Web Part Gallery > New Web Parts

Web Part Gallery: New Web Parts

Populate Gallery

T Gverwrite if file already exists?
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This list displays all available Web Parts for this gallery, Select each Wieb Part you want to add, and then cick Populate Gallery.

Fils Name
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Microsaft,Office Excel
Wersion=12,0,0.0, Cul
PublickeyToken=71e9

Microsoft.Office Excel,
Wersion=12,0,0.0, Cul
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PublickeyToken=71e9
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Inserting Web Parts and Web Part Zones

You insert Web parts on Web pages by using the Add Web Part Web dialog box, which is available
in the Edit mode of a SharePoint Web page. To open a Web page in Edit mode, choose Site
Actions=> Edit Page in the SharePoint Web page. By default, SharePoint Web pages contain Web
part zones that allow management of Web parts by using the SharePoint user interface. Each Web
part zone has the Add Web Part bar at the top, which allows users to access the Add Web Part dia-
log box for adding Web patrts to the zone. Figure 11.6 shows two Web part zones — Left and
Right — that have two Web parts each. The Left zone has the Announcements and Calendar Web
parts, and the Right zone has the Image and Links Web parts.

FIGURE 11.6

Examples of Web part zones on a SharePoint Web page

Left Right

5, add a Web Part 5L, Add a Web Part
Announcements edit | % Site Image edit~ | X
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Windows
Calendar edit ~ | % SharePoint Services

There are currently no Upcoming everts. To add a new event, click"add new event” below,

Add new event Links edit |x
There are currently no Favorite links to
display. To add a new link, dlick "Add
niew Ink” below,

Add new link

To add a Web part to a zone, simply click the Add Web Part bar to open the Add Web Part dialog
box, which shows the list of available Web parts. Simply select the Web parts that you want to
insert in a zone and then click Add. The selected Web parts are added to the applicable zone.

Notice the Advanced Web Part gallery and options link at the bottom on the Add Web Part dialog
box. As shown in Figure 11.7, clicking on this link opens the Add Web Parts pane on the right
side of the Web page.

You can use this pane to add Web parts to the zone selected by using the Add to dropdown menu
at the bottom of the pane.

Using the Web Parts task pane

In SharePoint Designer, open a Web page in a SharePoint site and then choose Task Panes= Web
Parts. The Web Parts task pane, as shown in Figure 11.8, opens.
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FIGURE 11.7

The Add Web Parts pane for a SharePoint Web site
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FIGURE 11.8

You can insert Web parts by using the Web Parts task pane.
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The Web Parts task pane shows that both SharePoint and SharePoint Designer have similar user
interfaces for inserting Web parts. As in the case of the SharePoint user interface, simply click the
Web part you want to insert on a Web page and then click Insert Selected Web Part at the bottom

of the task pane.
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You can also access the Web Parts task pane by choosing Insert = SharePoint Controls=> Web Part.
This menu also allows you to insert a new Web Part Zone on the Web page. Because you can’t
have a zone inside a zone, the Web Part Zone menu option is grayed out until you place the cursor
outside an existing Web part zone.

Commonly used SharePoint Web parts

In this section, I single out some of the interesting Web parts that are very commonly used by site
designers for SharePoint sites. While there are a number of specific Web parts providing function-
ality for Outlook, Business data, Dashboard, Search, etc., available in SharePoint and viewable
from the Add Web Part dialog box, the following Web parts allow for generic display of data and
Web pages:

B Content Editor: This Web part provides users with a rich text editor that can be used to
create content with detailed formatting and graphics. You can also type HTML content
for display by using this Web part.

B Current User Filter: This Web part, along with other ones in the Filter category, allows
users to filter data in a target Web part by using Web part connections. This Web part
provides the information of the currently logged-on user as a value to the connected
Web part.

B Page Viewer: Allows you to specify a URL for a Web page to be displayed inside a Web
part. The Web page could either be a SharePoint Web page internal to the site or a Web
page on an external site.

B RSS Viewer: Allows you to connect to and view an RSS feed either on a SharePoint or
external site

B XML: Allows you to display XML data transformed by using an XSL style on the
SharePoint site. You can either type XML data and XSL style by using the Web part prop-
erties or specify an XML file to be used as a data source and an XSL file to transform the
date for display by using the Web part.

Besides the out-of-the-box SharePoint Web parts, a large number of custom Web parts are avail-
able. SharePoint exposes a robust object model that allows Web developers to develop and deploy
custom Web parts to facilitate special requirements and functions.

Modifying Web part properties
SharePoint allows users to modify the Web part properties in a browser. If you have the proper
SharePoint permissions, you can just click the arrow on the right corner of the Web part to change
the Web part properties. As shown in Figure 11.9, you have the following menu options:

B Minimize: Allows you to minimize the Web part

B Close: Allows you to close the Web part on the page. This means that while the Web part
still exists on the Web page, it’s not rendered.
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B Delete: Available only when the page is in Edit mode, this option allows you to delete a
Web part from a Web page.

B Modify Shared Web Part: Opens the Web Part Properties pane, which allows you to
modify the properties for the Web part

B Connections: Available when the page is in Edit mode, this option allows you to create
Web part connections.

FIGURE 11.9

Editing Web part properties for the SharePoint site interface
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As previously mentioned, clicking the Modify Shared Web Part menu option opens the Properties
pane on the right side of the Web page. As shown in Figure 11.10, besides having some specific
Web part properties, the Properties pane shows properties that are generic to all Web parts.

The SharePoint Designer interface to modify a Web part’s properties is exactly similar to the
SharePoint site user interface. To modify properties of a Web part by using SharePoint Designer,
simply right-click on the Web part and then choose Web Part Properties from the popup menu. A
Web Part Properties pane very similar to the one available in the SharePoint site interface opens.

If you believe that a Web part on your SharePoint Web page is causing problems in successfully
rendering a page in a browser, a good troubleshooting mechanism is to browse to the Web page
with the contents query string enabled. To do this, just type ?contents=1 at the end of the Web
page URL in the browser address bar. A Web part maintenance Web page, as shown in Figure
11.11, is displayed and allows you to delete problematic Web parts from a Web page, thereby
salvaging the Web page for display.

The problematic Web parts might show with the text Error in the column Open on Page?. You can
also use this page to close or delete selected Web parts from the associated Web page.
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FIGURE 11.10

The Properties pane for modifying Web part properties in a browser
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FIGURE 11.11

The Web Part Page Maintenance page for troubleshooting Web part rendering issues
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Exploiting SharePoint Controls

SharePoint Web sites use a number of Web controls on out-of-the-box Web pages. These controls,
unlike Web parts, can't be directly inserted on the Web pages by using the SharePoint site user
interface. SharePoint Designer provides many of these server controls in the Toolbox task pane for
use on Web pages inside SharePoint sites. This section introduces you to the server controls avail-
able for use on SharePoint sites.
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Working with SharePoint server controls

If you choose Insert = SharePoint Controls= More SharePoint Controls, you're taken to the
SharePoint Controls section in the Toolbox task pane, as shown in Figure 11.12. There are four
types of controls available: Data View Controls, Server Controls, Page Fields, and Content Fields.

While you may question the usability of many of the SharePoint server controls listed in the
SharePoint controls section of the Toolbox task pane, you can use some of these controls in really
intuitive ways. For example, just by inserting the CSSLink server control on a new Web page, you
can associate it with the default CSS file being used for a SharePoint Web site.

FIGURE 11.12

SharePoint Controls in the Toolbox task pane
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To use the SharePoint server control AspMenu to gain data from the PortalSiteMapDataSource,
follow these steps:

1. Create a new Web page in your SharePoint Web site and then open it in the
Design view.

2. Using the SharePoint Controls section in the Toolbox task pane, insert the
PortalSiteMapDataSource and the AspMenu controls on the Web page.

3. Select the AspMenu control on the Web page, and using the Tag Properties task
pane, locate the DataSourceID property.

4. In the Tag Properties task pane, select the ID of the PortalSiteMapDataSource
as a value for the DataSourceID property of the AspMenu control.

5. Save the Web page and then preview it in a browser. The AspMenu displays the navi-
gation structure of the SharePoint site.

Using page fields

You can use the Page and Content fields only if you're working with Page Layouts in a SharePoint
site based on the Publishing site template. The Publishing site template is available only with
MOSS installations of SharePoint.

1E‘F For more on master pages and page layouts, see Chapter 13.
e

i

While working with page layouts in SharePoint Designer, you can insert page and content fields on
the page layouts from the Toolbar task pane, as shown in Figure 11.13. The page fields display the
columns defined in the content type associated with the page layout. If you have defined any cus-
tom columns in the content type associated with the page layout, those also appear in the Toolbox
task pane.

[ Content Types, introduced in WSS v3 and MOSS, define the nature and behavior of
RIS the content that can be stored in items. For example, the Document content type
allows for creation of items that can store documents and related metadata. If you have multiple
content types associated with a SharePoint list, you can create items based on these content
types and then store them in a SharePoint list.

When these page fields are inserted in the page layout, they can be used on the publishing pages
created by using the page layouts.

Using content fields

Content fields, like page fields, are columns that are defined in the content type associated with the
page layout being modified in SharePoint Designer. While designing the page layout, SharePoint
Designer allows you to insert these content fields at the location of choice. As in the case of page
fields, the content fields, once inserted in a page layout, are available for use in the publishing
pages created based on the page layouts for a SharePoint site.
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Page and Content Fields in the Toolbar task pane
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Summary

In this chapter, you learned how to insert Web parts and Web part zones on SharePoint Web
pages. You also learned how to insert and use SharePoint controls available in SharePoint Designer.

Web parts provide the user interface used to perform operations on a SharePoint site. They act as
placeholders on the Web page and interact with the internal data sources to present information to
users. For example, the ListViewWebPart provides the interface to view items in a list.

Most of the Web part configuration can be performed by using the SharePoint site user interface
itself. However, SharePoint Designer provides an interface similar to SharePoint for inserting Web
parts and working with Web part properties. It does so to avoid randomization for site designers.
Thus, they don’t need to switch from the design surface to insert and modify Web parts.
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ascading Style Sheets (CSS) is a World Wide Web Consortium

(W3C) standardized design mechanism for implementing format-

ting, fonts, and positioning on elements in Web pages. CSS has been
available for quite a while now, and the current version, CSS 2.1, along with
inheriting most of the features of previous versions, fixes some problems and
provides enhanced capabilities for presenting Web pages.

CSS provides a segregated approach to apply formatting and present struc-
tured documents, such as HTML Web pages, XML documents, etc., for dis-
play in a browser. In simple terms, instead of applying a font directly to an
HTML element on a Web page, you create a style by using CSS that can live
either on the Web page itself or in a separate file in your Web site. At render
time, a browser applies the styles specified in the CSS file to the HTML ele-
ments for display to the user.

By segregating the style implementation from the document, designers can
enhance their productivity and output. For example, instead of having to
apply the same formatting on every Web page inside a Web site, a Web
designer can separate the formatting into a separate CSS file and then link
this file to the Web pages for reference.

Now, whenever a change needs to be made to the formatting, the designer
needs to modify only the CSS file. The change automatically trickles down to
all the Web pages linked to the CSS file. The CSS file discussed previously

is called a style sheet. The reference to the style sheet on the Web pages is
called a style sheet link.

SharePoint Designer provides a rich user interface to create, modify, and apply
style sheets to Web pages on SharePoint and non-SharePoint sites. It also offers
mechanisms to run reports that allow you to check the CSS implementation
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and determine usage of CSS elements on the Web pages. This chapter discusses how you can use
SharePoint Designer’s CSS tools to implement style sheets on your Web sites.

I start by discussing the structure and composition of CSS styles and then explain the use of CSS-
related task panes and toolbars in SharePoint Designer for creating style sheets. As you may know,
SharePoint sites implement extensive CSS-based formatting. Later in this chapter, I also familiarize you
with SharePoint CSS implementation and introduce you to the important SharePoint CSS styles. This
should help you build on your understanding of how you can brand SharePoint sites by using CSS.

Introducing Cascading Style Sheets

CSS styles define the formatting for the elements they apply to. In HTML, for example, every tag is
an element, and you can use styles to modify the way the tag looks and behaves. As previously
mentioned, styles provide a centralized framework for implementing formatting on a large number
of pages.

For example, if you want to have all tables in your Web site formatted in a similar manner, you can
create a style for the table, and whenever you create a table for your Web site, you can associate that
style with the table. That way, all tables inside your Web site use the same style. Now, whenever
you want to change the formatting applied to the tables, you just need to modify the style. By virtue
of the style association with the tables, the formatting is automatically picked up by all tables. In this
manner, styles help you maintain uniformity in your Web sites and thus reduce design hours.

Understanding CSS classes and rules

Before detailing CSS implementation by using SharePoint Designer, I want to quickly touch upon
some of the CSS basics and familiarize you with a couple of important concepts in CSS terminology.

CSS rules

To understand how CSS applies to Web pages, follow these steps to create a simple style and then
associate it with an element on a HTML page:

1. Using SharePoint Designer, create a new HTML Web page inside your Web site and
then open it in the Design view.
Choose Insert= HTML &> Span to insert a <span> tag on the Web page.

Type some text inside the <span> tag. In this exercise, apply formatting to the text in
the <span> tag by using a simple style.

4. Choose Format= CSS Styles= Apply Styles to open the Apply Styles task pane, as
shown in Figure 12.1.

5. Click the New Style link in the Apply Styles task pane to open the New Style dialog
box, as shown in Figure 12.2. Use this dialog box to create a new style.

6. In the Selector dropdown menu, select the <span> tag. Keep the Current page option
in the Define in dropdown menu.
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FIGURE 12.1

Creating a simple style in SharePoint Designer
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FIGURE 12.2

The New Style dialog box
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7. In the Font category, specify the font-size, font-weight, and color. The configured

style is shown in Figure 12.3. The preview and description of the style are displayed at
the bottom of the dialog box.

8. Click OK. The newly created style has been applied to the <span> tag, and the text
shows as formatted in the Design view in SharePoint Designer.

If you switch to the Code view of the Web page, the following code appears inside the HEAD tags.
This code defines the style that has been implemented on this Web page by
using steps in the previous exercise:

<style type="text/css">

span

{
color: #COCOCO;
font-weight: bolder;
font-size: medium;

}

</style>

What you see is a CSS rule that defines the behavior for the <span> tag on this Web page. A CSS
rule has two parts: a selector that associates the rule to an element on the Web page and a declaration
that defines the formatting aspects that the rule carries. In this code, you created a CSS rule with the
span selector and a number of declarations. A declaration, in turn, has two portions: a property and
a value. For example, in this code, the color property has been given the value #C0C0CO.

By the virtue of this CSS rule, all the <span> tags on the Web page have the formatting specified
in the declarations in the rule. As shown in the following example, CSS allows you to group selec-
tors so that multiple selectors can be associated with the same declarations:

span, p, tr

{
color: #CO0COCO;
font-weight: bolder;
font-size: medium;

}

Besides associating the CSS rule to the tags or elements by name, as shown in this code, you can

also associate the style by using the id attribute. For example, the following CSS rule applies to all
tags that have the 14 attribute set to the value right_col.

#right_col
{
width: 200px;
position: absolute;
top: Opx;
right: Opx;
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FIGURE 12.3

An example of a style created by using the New Style dialog box
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CSS shorthand properties

While the previous examples showed how you can create a declaration by using a

property:value pair, CSS allows you to combine a number of similar properties into a short-
hand property, thereby allowing you to define your formatting more concisely.

Shorthand properties let you declare many similar properties in a single declaration. For example,
you can combine multiple font properties and then declare them in a single shorthand property:

span
{
font: #CO0COCO bolder medium;
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CSS classes

The next exercise takes you through a set of steps to discuss another important CSS concept called

CSS classes:

1. Open a Web page in the Design view, and using the Apply Styles task pane, click
the New Style link to open the New Style dialog box.

2. In the Selector dropdown menu, type .myclass. Keep the Current page option in the
Define in dropdown menu.

3. In the Font category, specify a font-size, font-weight, and color. This is illustrated in

Figure 12.4.

4. Click OK and then click the Code view tab.

FIGURE 12.4

Creating a new CSS class by using the New Style dialog box
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Using the previous steps, you created the following code in the <style> tag of your Web page:

.myclass
{
font-size: large;
font-weight: normal;
color: #000080;
}

As shown in this code, the selector is now a custom name that you specified in the New Style dia-
log box. This custom name, called a CSS class, unlike the CSS rule, isn’t associated with an ele-
ment on the Web page by default. However, using the class attribute of the element, you can
associate the class with the element. For example, the following code associates the above CSS class
with the <span> tag;

<span class="myclass">I am learning CSS</span>

By providing the ability to create classes, CSS allows you to classify chosen elements to have format-
ting different than the one specified in a CSS rule. By virtue of the CSS class being associated with the
<span> tag, the CSS rule specified by the span selector in the previous exercise is overridden.

Understanding CSS implementation hierarchy

Before discussing CSS hierarchy, I want to mention that you can apply CSS styles on a Web page
in three ways:

B In-line styles: These styles refer to the formatting that you can apply directly to an ele-
ment, such as an HTML tag as an attribute value. All HTML tags have a style attribute
that can be used to specify declarations for the tag. As shown in the following example,
the style is applied directly in-line with the HTML tag:

<span style="font-size:medium; font-weight:bolder; color:gray">I am
learning CSS</span>

W In-page styles: These styles refer to the declarations that you make in a common
<style> tag for the entire Web page. The <style> tag is usually placed in the <head>
section of the Web page:

<style type="text/css">

span {color: #C0CO0CO;
font-weight: bolder;
font-size: medium;

}

.myclass {
font-size: large;
font-weight: normal;
color: #000080;

}

</style>
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B External styles: These style declarations refer to the most styles that are defined in a sep-
arate style sheet document (with the extension .css). The CSS document is then linked
to the Web page by using a style sheet link:

<link rel="stylesheet" type="text/css" href="myCSS.css" />

One important concept to understand regarding CSS is that multiple styles are cascaded to form a
single style set before the styles are applied to the elements on associated Web pages. That means
that if you add in-line, in-page, and external styles to your Web page, when a browser interprets
the CSS for implementation, it combines all these styles to form a master style set for the elements
before application.

The rule for precedence for CSS style implementation is that whichever style is

“ closest to the element wins. This means that the styles defined in-line with the ele-
ment always take precedence over the in-page or external styles. For example, if you specify the
same font property by using both in-line and in-page styles, the value of the property for the in-
line style is applied to the element.

A
<N
v

Working with Styles

SharePoint Designer provides you with a new, intuitive user interface to create, modify, and apply
CSS on Web pages. The new interface includes a number of task panes that can be used to authori-
tatively implement advanced style sheets on Web sites. In this section, I help you understand how
to use SharePoint Designer to apply and manage styles for your Web sites. While the New Dialog
box allows you to choose from a list of CSS templates on which to base your CSS files, I show you
how you can create styles in new style sheets from scratch.

However, before discussing the SharePoint Designer interface to create and modify styles, I want to
take you through some general settings for CSS in SharePoint Designer. The Page Editor Options
dialog box, available by choosing Tools=>Page Editor Options, allows you to set some specifics
that you want SharePoint Designer to follow while working with CSS on Web sites.

As shown in Figure 12.5, the Authoring tab in the Page Editor Options dialog box allows you to set
the CSS schema that SharePoint Designer should follow when providing you with suggestions related
to CSS properties and attributes in the Code view. While SharePoint Designer chose the CSS 2.1
schema, you might want to set this to the preferred schema for your Web site’s CSS implementation.

As shown in Figure 12.6, the CSS tab in the Page Editor Options dialog box allows you to specify
defaults for how styles should be applied for various property categories. For example, by default,
the Page properties on the <body> tag are set to CSS (inline styles). This means that the page
properties are applied by default as in-line styles inside the <body> tag.
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FIGURE 12.5

Choose CSS schema by using the Page Editing Options dialog box.
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So, if you right-click in a Web page and then choose Page Properties from the popup menu to
open the Page Properties dialog box and make changes in the Formatting tab, the changes are
implemented by using in-line styles in the <body> tag of the Web page:

<body style="background-color: #FFOOFF">

However, if you want to change this behavior of SharePoint Designer, you can do so by using the
CSS tab in the Page Editor Options dialog box. This allows you to have flexibility for how the CSS
styles should be generated by SharePoint Designer user interface tools.
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Selecting style applications by using the Page Editor Options dialog box

Page Editor Options i |

Autharing I Picture I Code Snippets I Ruler and Grid I IntelliSense | Faont Families
General I AutoThurnbnail I Default Fonts I Code Formatting €55 |COI0r Coding
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Font and kext: ICSS (Classes) j
Background: ICSS {classes) j
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Padding and margins: IcsS {classes) j
Sizing, positioning, and floating: ICSS {inline styles) j
Bullets and numbering: IcSS {classes) j
™ orily reuse classes with the prefix "style"
¥ Use width and height attributes For images instead of €55

Reset Defaults |

K I Cancel |

Creating, modifying, and deleting styles

The three main access points to the SharePoint Designer user interface for working with styles are
the Apply Styles, Manage Styles, and CSS Properties task panes. Available through the Task Panes
menu, these panes combine most of the SharePoint Designer features to work with styles. Besides
these task panes, you can also use the Styles and Styles Application toolbars for implementing
styles on Web pages. Figure 12.7 shows the SharePoint Designer interface for working with style
sheets.

On the right are the Manage Styles and Apply Styles task panes, which are used to create and man-
age styles on Web pages. The CSS Properties task pane on the left provides a Visual Studio-like
interface to modify CSS declarations.

Creating styles

You create new styles in SharePoint Designer by using the New Style dialog box. The New Style
dialog box is accessible by using the Apply Styles and Manage Styles task panes, choosing
Format=> New Style, or clicking the New Style button on the Style toolbar.
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FIGURE 12.7

The various style task panes in SharePoint Designer
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As shown in Figure 12.8, key specifics of the New Style dialog box include:

B Selector: Allows you to choose the tag you want to use as the selector for the CSS rule.
Alternatively, you can type the name of the CSS class you want to create. Remember that
a CSS class syntactically begins with a dot. Or you could choose the in-line style option if
you want to create an in-line style. The Apply new style to document selection check box
is used to indicate whether you want to apply the newly created style to the selected ele-
ment or content in the document.

B Define in: Allows you to choose whether you want to create the new style in the cur-
rently opened document, a new style sheet, or an existing style sheet. When you select
the Existing style sheet option in this dropdown menu, the URL text field is highlighted
and allows you to specify the location of the CSS file.

B Category: This section provides a graphical list of available CSS properties, which are
categorized into various areas of formatting. The categories for which the properties have
been set are highlighted in bold.
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B Preview: This section shows you a short preview of how the style appears when imple-

mented on the content.

B Description: This box specifies the actual code of the style that you created with the New
Style dialog box. As you proceed with the creation of the style, this box is updated to

show the code for the style.

FIGURE 12.8

The New Style dialog box
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To create a new CSS class in a new style sheet and then apply it to the selection in a Web page,

follow these steps:

1.
to apply the newly created style.

Choose Format= New Style to open

Open a Web page in the Design view and then select the content on which you want

the New Style dialog box.

In the Selector dropdown menu, type the name of the CSS class you want to create.

Ensure that the Apply new style to document selection check box is selected.
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4. In the Define in dropdown menu, choose New Stylesheet.

5. Using the Category list, choose the CSS properties that you want to use for the style
and then set the values for these properties.

6. Review the style in the Preview box before clicking OK.

7. Click Yes when the message shown in Figure 12.9 appears.
The newly created style is applied to the selection you made in step 1 of the previous exercise.
Also, a new CSS file is created, which holds the definition of the new style. You should save this

file and the Web page.

If you review the code of the Web page, the style sheet link is automatically added to your Web
page to attach the newly created style sheet to the Web page:

<link rel="stylesheet" type="text/css" href="myCSS.css" />

FIGURE 12.9

Attaching a style sheet to the document
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Modifying styles
You can view and modify the styles associated with the content of your Web page or CSS by using
the Manage Styles, Apply Styles, and CSS Properties task panes. When you select the content on

the Web page where the style has been applied, the CSS Properties task pane highlights in blue the
properties of the style associated with the selection.

Also, as shown in Figure 12.10, the Manage Styles and Apply Styles task panes show and highlight
the style applied to the selection.

To modify a style using these panes, simply right-click on a style and then choose Modify Style
from the popup menu. The Modify Style dialog box opens, allowing you to change the properties
associated with the style. The user interface for the Modify Style dialog box is similar to the New
Style dialog box.

FIGURE 12.10

Modifying styles by using SharePoint Designer
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Deleting styles

You can delete a style by using the Manage Styles and Apply Styles task panes simply by right-
clicking on a style and then choosing Delete from the popup menu, as shown in Figure 12.11.

When you confirm that you want to delete a style, the style is removed from the location (for
example, a style sheet) where it was defined. After deleting a style, you need to save the file where
the style was stored. SharePoint Designer automatically opens the associated file so that you can
save it.

Using the Apply Styles task pane

In this section, I use the SharePoint core style sheet called core.css to illustrate the use of the
Apply Styles task pane.

FIGURE 12.11

Deleting styles by using SharePoint Designer
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While there are a number of style sheets that help you completely implement for-
matting and styles for SharePoint Web sites, the core.css stores most of the styles
that define the look and feel of SharePoint Web pages.

To view the styles applied to a SharePoint Web page, open the Web page in SharePoint Designer.
When you open the Apply Styles task pane, a number of styles appear in the Select CSS style to
apply list, as shown in Figure 12.12.

The Apply Styles task pane lists the CSS styles that are applied to the Web page that’s active in
SharePoint Designer. The CSS styles from the style sheets attached to the active Web page are
listed along with the styles that have been applied in-line or in-page. The Apply Styles task pane
also shows a preview of the style in the Select CSS style to apply list. If you hover over a style, the
code for the style is displayed in a screen tip.

The Apply Styles user interface uses the following icons to differentiate among the various styles:

B Green Dot: Indicates that the style is a CSS class either defined in-line on the Web page
or in a separate style sheet

B Encircled Green Dot: Indicates that the style is a CSS class being used on the current page

B Blue Dot: Indicates that the style is a CSS rule either defined in-line on the Web page or
in a separate style sheet

B Encircled Blue Dot: Indicates that the style is a CSS rule being used in the current page
B Red Dot: Indicates that the style is a CSS rule, which matches using the id attribute of a tag

B Encircled Red Dot: Indicates that the style is a CSS rule based on matching id and is
being used in the current page

Depending on the number of in-page style tags on a Web page, the Current Page
i S% header repeats in the Apply Styles task pane list of styles. For example, as shown in
Figure 12.13, the currently opened Web page has two style tags. This becomes more
understandable when you collapse the headers in the list. Because the core.css is the main
style sheet file for SharePoint Web sites, you almost always see styles from this file listed in the
Apply Styles task pane when working with SharePoint Web pages.

The Options dropdown menu in the top-right corner of the Apply Styles task pane allows you to
categorize the styles being shown in the Select CSS style to apply list in the following ways:

B Categorize By Order: Selected by default, categorizes the styles in the order they’re
encountered in the associated file

B Categorize By Type: Categorizes the styles based on the type. For example, with this
option selected, the CSS classes are grouped together.
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Show All Styles: Selected by default, shows all the styles that are available either in-line,
in-page, or in an external style sheet linked to the Web page active in SharePoint
Designer

Show Styles Used In Current Page: Shows styles that are being used on the current
page only. Selecting this option ensures that you only see the encircled green or blue
styles in the list.

Show Style Used On Selection: Shows the styles being used on the currently selected
item in the active Web page

Preview Background Color: Allows you to change the background color used when
showing the style in the Select CSS style to apply list

FIGURE 12.12

The Apply Styles task pane showing the styles in the core.css style sheet
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FIGURE 12.13

The collapsed view of the list of styles in the Apply Styles task pane
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The Select CSS style to apply list shows the Clear Styles option at the top of the list. This option
can be used to clear the styles from the selection made in the currently active Web page.

When you right-click on a style that shows up in the Select CSS style to apply list, a popup menu
appears with the following options:

Apply Style: Applies the style to the selection made in the document

Go to Code: Takes you to the location on the Web page or the style sheet where the style
is defined

Select All Instances: Highlights all instances where the style is being used on the cur-
rently active Web page

New Style: Allows you to create a new style by using the New Style dialog box
New Style Copy: Allows you to create a new style based on the selected style
Modify Style: Allows you to modify the style by using the Modify Style dialog box
Rename Class: Allows you to change the name of the CSS class

Delete: Deletes the CSS style

Remove Link: Enabled when the header in the Select CSS style to apply list is right-
clicked on, this option allows you to remove the link to the style sheet from the
document.

Attach Stylesheet: Allows you to attach a style sheet to the active Web page by using the
Attach Stylesheet dialog box

Manage Stylesheet Links: If you have multiple style sheets associated with the active
document, you can use this option to manage style sheet links.

Remove Class: Removes the CSS class from the selection in the active Web page
Remove ID: Removes the CSS IDs from the selection in the active Web page

Remove Inline Style: Removes in-line styles from the selection in the active Web page
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The Apply Styles task pane also allows you to attach new style sheets to the currently active docu-
ment by using the Attach Style Sheet link. As shown in Figure 12.14, the Attach Style Sheet dialog
box that opens when you click the Attach Style Sheet link allows you to specify the URL of the
external style sheet.

FIGURE 12.14

The Attach Style Sheet dialog box
URL: ImyCSS.css| Browse. .. |

Attach to: % AIHTML pages  Attachas: & Link
£ Selected page(s) ' Impart
 Currert page

Ok I Caneel |

You can choose if you want to add the style sheet link only to the current page, selected pages, or
all HTML pages inside a Web site. If you choose to attach as a link, a style sheet link is inserted
into the Web page. Choosing to import the style sheet copies all the styles from the style sheet into
the Web page as in-page styles.

Using the CSS Properties task pane

The CSS Properties task pane is useful primarily if you're used to working with a Visual Studio—
like interface for setting properties. This task pane shows a contextual view of the properties asso-
ciated with the selection made in the active Web page. When you make a selection on a Web page
in the Design or Code view, the CSS Properties task pane shows the associated properties in a cate-
gorized manner. By default, the properties that have been set by using styles are displayed on top
of the list of properties in a given category.

One of the really cool features of the CSS Properties task pane is that it shows a hierarchical view
of the CSS rules implementation on the current selection on a Web page. As illustrated in Figure
12.15, the Applied Rules section in the CSS Properties task pane shows the CSS implementation
on the HTML tags from the topmost to the currently selected tag.

As you can see, the topmost <body> tag matches two CSS rules: body, form, and body. The
next child tag, <form>, only matches one CSS rule body: form. This hierarchy continues until
you reach the container of the currently selected tag.

If you hover over a CSS rule, a screen tip shows the code associated with that CSS rule. When you
right-click on a rule, a popup menu very similar to the Select CSS style to apply list opens, allow-
ing you to create and modify styles. Also, on the top-right corner of the CSS Properties task pane,
the link to the style sheet where the CSS rule has been defined is shown.
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The applied rules in the CSS Properties task pane
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Working in the Manage Styles task pane

While the Apply Styles task pane is oriented toward Web pages where the styles need to be applied
and shows the styles that are active on an HTML selection, the Manage Styles task pane allows you
to work on the CSS styles directly. When you open a CSS by using SharePoint Designer, the
Manage Styles task pane lists all the CSS rules and classes defined in the style sheet. Similarly,
opening a Web page in SharePoint Designer allows the Manage Styles task pane to list in-line, in-
page, and external styles associated with a Web page.

Figure 12.16 shows the Manage Styles task pane for a SharePoint Web page. Like the Apply Styles
task pane, the user interface represents the CSS rules, elements, and classes by using the same indi-
cators. For example, the styles that are being used on the Web page are encircled.

However, while the Apply Styles task pane mostly showed CSS classes, the Manage Styles task pane
allows you to also work with CSS rules and elements. You can simply select the CSS style in the code
of the Web page or the CSS file, and the style is highlighted in the Manage Styles task pane.
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Then, you can use the task pane to modify the style by using the familiar tools for styles creation and
modification. As in the case of the Apply Styles task pane, the Manage Styles task pane also shows a
quick preview of the style by using the Preview pane at the bottom of the task pane.

FIGURE 12.16

The Manage Styles task pane
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Creating and Using CSS Layouts

CSS layouts is a mechanism of laying out Web pages by using formatting applied via CSS. When
you create a CSS layout, you're basically creating a CSS and then applying a style sheet to a Web
page for layout formatting. So, instead of using a table to lay out your Web page, for example, you
can choose to create a layout based on a CSS. By default, SharePoint Designer provides a number
of templates for creating CSS layouts. These are available in the New dialog box in the CSS Layouts
section.
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To create a new Web page using CSS layouts, follow these steps:

1. Choose Filew> New to open the New dialog box and then click the CSS Layouts sec-
tion in the Page tab, as shown in Figure 12.17.

Choose the layout that best suits the layout of the page you want to create.

Click OK. SharePoint Designer creates a Web page and a CSS for you. By default, the
CSS is linked to the newly created Web page. By default, the page just has some <div>
tags with 14 attributes that match CSS rules. But when you type some text in the <div>
tags, the layout formatting applied by using the CSS layout takes affect, and the content is
placed according to the CSS formatting defined in the rules, as shown in Figure 12.18.

FIGURE 12.17

Creating CSS layouts by using the default templates provided with SharePoint Designer
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The CSS rules in this case are being matched by using the id attribute of the tags. As mentioned
previously in this chapter, the CSS rule created in such a manner applies to all tags that have a
matching id attribute. Because you would usually want to keep the id attributes unique for the
tags, this method of applying rules ensures that the CSS rules only apply when the id matches.
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The next step is to modify the CSS rules to apply the formatting you want to add to the CSS layout.
You can easily do this by modifying the CSS style by either using the Apply Styles or Modify Styles
task panes. For example, if you want the page header to have a background color, simply modify
the #header CSS rule by using the Modify Style menu option in the Apply Styles task pane and
then specify the background color in the background category.

FIGURE 12.18

The Split view of a page created by using a CSS layout
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Using CSS Reporting Features

SharePoint Designer provides a set of reporting tools for CSS that are pretty useful for checking the
CSS implementation of a Web site and then comparing it with the Web standards for errors, prob-
lems, mismatches, or usage. You can run reports on selected pages or across an entire Web site and
then determine whether the CSS styles are being used efficiently. CSS Errors and CSS Usage are the
two main CSS-related reports that you can run on your Web site:

B CSS Errors: Allows you to find CSS styles that exist but aren’t being used, CSS classes
that are associated with elements but haven’t been defined, and mismatched cases when
associating styles with elements

B CSS Usage: Allows you to determine usage of the various CSS rules and classes
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To run the CSS reports, choose Tools=> CSS Reports to open the CSS Reports dialog box, as shown
in Figure 12.19. The Errors tab allows you run reports to check for CSS errors, and the Usage tab

allows you to run reports on usages of various CSS classes and rules. To run a CSS Error report
across an entire Web site, follow these steps:

1.

2.

In the CSS Reports dialog box, click the All Pages radio button and then click the appro-
priate check boxes for the issues you want to identify in the CSS implementation.

Click Check. This opens the CSS Reports task pane, as shown in Figure 12.20. You use
the CSS Reports task pane to view the errors encountered in the CSS implementation on

the selected Web pages.

3. After you identify the CSS issue and then qualify it as a valid problem, you can
right-click on the error in the Reports task pane to navigate to the Web page and
then take corrective measures to fix the issue.

FIGURE 12.19

Running CSS reports on a Web site by using SharePoint Designer
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FIGURE 12.20

Using the CSS Reports task pane to find CSS errors
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Exploiting Cascading Style Sheets and Themes m

You can also access the CSS Reports dialog box by clicking the Play button in the CSS Reports task
pane. If you run the CSS usage reports on an entire Web site, you should see an output similar to
the one shown in Figure 12.21.

SharePoint Designer lists the CSS classes and rules that have been applied to the selected pages,
indicates the location where the CSS style has been defined, and denotes the line number where
the CSS style association exists on a Web page. You can use this report to quickly jump to the CSS
style you want to modify in a CSS implementation on a large Web site.

AT When you run CSS reports on SharePoint sites with the All Pages radio button
OIE. .

S=UISE selected, the report actually runs only on the selected pages. This has been
designed to avoid introducing an overhead on the SharePoint site if multiple users run CSS
reports simultaneously.

FIGURE 12.21

Running CSS Usage reports for a Web page
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Summary

CSS is one of the primary tools for Web designers to implement standardized styling across Web
sites, helping to reduce redundancy and improve productivity. This chapter discussed some con-
cepts about CSS to familiarize you with the CSS terminology. Then, I showed you how you can use
the SharePoint Designer user interface to create and manage styles on Web pages. I took you
through a number of exercises to familiarize you with the Apply Styles, Manage Styles, and CSS
Properties task panes. You also learned about creating a CSS layout and using the CSS reporting
features.



esigning Web sites entails that you consider a number of techniques

to ensure uniformity and consistency in the formatting and brand-

ing of the Web pages. It’s important to ascertain that users browsing
through the Web pages of a Web site feel a sense of standardization while
navigating between various Web pages. You might not want to have Web
pages inside a Web site presenting content in a manner that’s totally oblivi-
ous of the presentation style of the entire Web site. For example, you may
want to always have the navigation links and bars at the same location on the
Web pages of the Web site so that when the user navigates around pages, he
or she doesn't feel confused.

While CSS is a key technology that helps you maintain a consistent look and
feel for your Web site, it applies mostly to styling, fonts, and formatting.
SharePoint Designer allows you to make use of a number of other technolo-
gies, such as dynamic Web templates (DWTs), master pages, and page lay-
outs to help you maintain a standard branding and layout across all the Web

pages.

Although the implementation of the aforementioned technologies might be
different, the concept behind them is similar. You mostly follow these steps
to create Web site content by using these technologies:

B You create a template Web page that suits the requirements of your
Web site’s design. In this template page, you define a uniform blue-
print that’s implemented for the entire Web site or a set of pages
inside the Web site. Usually, this is the time when you decide
where to place common elements, such as branding images, navi-
gation components and link bars, headers and footers, etc.
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B After you place the common elements, you create unique areas in the template page to
hold content that’s unique to the Web pages based on the template.

B You then create new Web pages based on the template page. These Web pages inherit the
common elements of the template page and allow editing of the unique areas only.

While designing Web pages in this fashion, the concept described previously is enforced by the
editing tool, which in this context is SharePoint Designer. SharePoint Designer allows you to create
template pages by using dynamic Web templates (DWTs), master pages, and page layouts. You can
define the design, formatting, and common elements on the template pages by using the available
tools. Then, you can either create new Web pages based on the template pages or attach the tem-
plate pages to existing Web pages.

After attaching the Web page to the template page, it inherits the formatting and layout of the tem-
plate page. The Design view in SharePoint Designer doesn’t allow you to modify the common ele-
ments that the Web page inherits from the template page. You can only make modifications to the
unique areas you defined in the template page. This ensures that all the common elements from
the template page are and stay enforced on the attached Web pages.

To modify the common elements, you need to modify the template page. When you save the tem-
plate page after modifications, the attached Web pages are automatically updated to inherit the
modifications. So, rather than having to make modifications to every page, you modify only one
template page and then the changes are applied to all attached Web pages. In this way, this con-
cept reduces redundancy and provides you with an efficient way to maintain your Web pages.

Working with Dynamic Web Templates

Dynamic Web templates (DWTs) is an HTML-based SharePoint Designer feature that allows you to
create templates and then use them on Web pages of your Web site. As mentioned earlier, you
design the template in a DWT template file (having the extension .dwt) and then place unique
areas called editable regions at the required locations in the template file. After you create th